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Harga Rp. 4.800,- (Pulau Jawa), Rp. 5.300,- (Luar Jawa)
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PCplus
TABLOID KOMPUTER

EDITORIAL ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Membuat Yang Rumit Jadi Sederhana

Tulisan yang paling baik, sesungguhnya adalah tulisan yang
sederhana, tulisan yang membuat pembacanya tidak berkerut dahi, tulisan
yang langsung membuka cakrawala pikiran pembacanya setelah mereka
menyelesaikan kata terakhir sebuah tulisan.

Itulah tantangan yang ingin kami hadapi. Bacaan yang tengah Anda
genggam ini, sejak pertama kali diterbitkan dikenal luas oleh masyarakat
luas maupun masyarakat pers adalah media dengan tema khusus yang
mengulas tema yang sulit dan rumit dengan bahasa tutur yang sederhana,
mudah dimengerti, mudah dipahami.

Tapi seiring dengan peningkatan ilmu di bidang komputer dalam diri
para redaksi punggawa PCplus, rupanya masalah membahasakan secara
sederhana itu menjadi perkara yang makin rumit dan menimbulkan
problem tersendiri. Kami kadangkala merasa bahwa bahasa yang kami
gunakan sudah cukup mudah, tetapi ternyata bagi orang-orang yang
memang benar-benar awam di bidang komputer, apa yang kami tulis
masih terlampau teknis, terlampau sulit, terlampau sukar dipahami.

Oleh karenanya, kami merasa perlu untuk berbenah, mencari
panduan dan masukan dari sana sini. Di minggu-minggu ini, kami sudah
memulainya dan mudah-mudahan, Anda akan segera bisa merasakan
manfaat dari apa yang kami lakukan, yakni membuat PCplus semakin
mudah dibaca dan dicerna.

Masih terkait dari perkara mengubah yang rumit jadi sederhana,
artikel plusFokus edisi kali ini tentang PDA (personal digital assistant)
mudah-mudahan membuat Anda jadi gamblang, bahwa PDA benar-benar
bisa membuat urusan-urusan rumit jadi sederhana. Tentu saja bila Anda
bisa memanfaatkannya dengan sebaik-baiknya, memilih yang sesuai
dengan kebutuhan Anda, dan menggunakannya semaksimal mungkin.

Yang tak kalah menarik dari PCplus edisi ini adalah artikel tentang kiat
membasmi virus MyHeart, yang ternyata menjadi virus yang paling
menimbulkan masalah di kalangan pengguna komputer tanah air. Banyak
e-mail dan telepon yang masuk ke meja Redaksi, dan setelah kami pelajari,
kami mencari pihak yang paling kompeten menjawab dan memberikan
penjelasan soal virus ini.

Lain dari itu, minggu ini sebenarnya kami kedatangan seperangkat
sistem PC berbasis prosesor Intel Pentium-4 Extreme Edition. Nah, proses
pengujian sedang kami jalankan di edisi ini, sehingga mudah-mudahan
di edisi mendatang, kami bisa menyajikan prosesor terbaru unggulan
Intel tersebut ke hadapan Anda.

Itu saja. Daripada berumit-rumit, sederhanakan saja dengan
mulai membuka halaman demi halaman sajian kami.

Salam hangat dari Palmerah
Redaksi

BAHAS MESIN CETAK FOTO
DIGITAL

Salam kenal. Saya sudah
setahun kenal PCplus. Lewat
tabloid ini saya banyak sekali
belajar tentang komputer secara
umum: hardware dan software,
tips dan trik, dan lain-lain. Saya
ada usul, gimana kalau pada suatu
saat PCplus juga mengulas
tentang mesin cetak foto digital
yang konon katanya mahal
itu? Harganya, jenisnya, tintanya,
kertasnya, bentuknya (besar/kecil),
dan lain-lain!
Apa kelebihannya dari printer
laser biasa dengan teknologi
terkini? Tanggapi, please...

Pepen Salvatore
pepen_ggp2@yahoo.co.uk

Red: Mesin cetak foto digital yang
berukuran besar memang mahal,
tetapi perlu Anda tahu, printer-printer
foto dari berbagai merek saat ini
sudah memiliki kemampuan
mencetak foto yang luar biasa bagus,
tajam, tahan sampai puluhan tahun,
dan harganya  pun tidak terlalu mahal.
Mengenai pembahasannya, dalam

waktu dekat kami akan mengulasnya
untuk Anda dan juga pembaca mulia
yang lainnya.

BAHAN TENTANG BLOG
Dear Redaksi PC Plus, nama

gw Cicka n skr gw sedang di
semester 7 n lagi persiapan buat
skripsi. Stlh lama ngubek2, gw
nyaris mutusin untuk ngambil
tema tentang blog. Yg gw liat dari
PCplus, ada dua edisi (kalo ngga
salah!), yg ngebahas tentang blog
ini. Gw butuh banget bantuan PC
Plus untuk ngasih referensi
tentang blog ini, n mungkin
punya ide sbg tambahan? Sejauh
ini sih baru sekitar sejarah blog n
perkembangannya serta teknik2
membuat blog. Hope u can give
me some advice n suggestion! Thx
a lot n i'm looking forward 4 ur
reply!

Siska Purnama
saschya@yahoo.com

Red: Anda bisa menghubungi e-mail
berikut ini: alex@e-pcplus.com atau
fbi@e-pcplus.com untuk informasi
dan diskusi lebih lanjut.

USUL TABLOID BARU DAN
KRITIK ARTIKEL

Salam sejahtera! Saya mau
memberikan beberapa usulan
untuk PC+:
1. Melihat perkembangan dunia

teknologi ponsel yang semakin
maju dan hal tersebut juga
sangat berhubungan dengan
dunia komputer seperti
koneksi Internet PC via modem
hape, upgrade software hape
lewat PC, dan masih banyak
lagi hal-hal yang berhubungan
dengan hape tolong dong PC+
membuat satu bagian
mungkin namanya
"PlusComsel" (Computer &
Seluler) yang membahas secara
mendalam tentang comsel itu,
walaupun di tiap edisi PC+
membahas tentang hape tapi
dirasakan kurang. Saat ini
yang saya tahu tidak ada
majalah atau tabloid khusus
yang membahas tentang
dunia yang satu ini . Mungkin
PC+ bisa membuat gebrakan
baru dengan membuat
Tabloid PC++ yang khusus
terbit untuk membahas
komputer dan selular secara
mendalam.

2. Kritik untuk PC+, tampilan
tabloidnya tidak perlu tulisan
dan gambarnya besar-besar,
kalau lebih kecilkan masih ada
tempat untuk membahas lebih
dalam lagi artikel-artikel yang
ada yang selama ini saya rasa
pembahasannya kurang
begitu mendalam. Contohnya
artikel yang berjudul
"lompatan teknologi di dunia
komponen", isinya cuma
sekilas info. Begitu juga
artikel-artikel lain yang tidak
pernah membahas secara
tuntas. Kalo mau bahas
tentang prosesor 64-bit bahas
sampai habis, mungkin
dibahas bagaimana kelanjutan
teknologi tersebut? Vendor
mana saja yang telah siap
memakai produk itu, dan lain-
lain. Jujur saja setelah saya
membaca artikel-artikel seperti
itu saya jadi kurang damai
sejahtera karena rasa
keingintahuan saya tidak
terpenuhi, malah setelah baca
artikel terebut, rasa ingin tahu
saya jadi lebih banyak.

Mungkin itu dulu dari saya,
terima kasih.

Nico Samuel
nico241178@yahoo.com

Red: Terima kasih atas saran dan
masukannya. Usulan untuk membuat
tabloid komputer dan selular itu
menarik juga. Tapi bukankah
sekarang sudah banyak tabloid yang
mengulas khusus mengenai hape dan
selular? Kritikan Anda akan kami
pertimbangkan dan kami akan
mencoba membuat formulasi
sehingga lebih memberikan kepuasan
kepada pembaca sekalian.

BUKU DAN ARTIKEL LINUX
Dear PCplus, salam kenal dari

saya. Dari awal saya diperkenalkan
oleh teman saya, saya sangat
tertarik dengan Tabloid mingguan
PCplus. Saya mulai berlangganan
ketika saya masuk ke tingkat dua di
salah satu perguruan tinggi negeri
pada jurusan komputasi. Langsung
saja, terus terang saya adalah orang
yang masih awam tentang
komputer. Tapi akhir-akhir ini saya
tertarik dengan yang namanya
Linux.

Saya pertama kali mengenal
Linux ketika teman saya menulis
skripsi tentang Linux yang
berjudul Pembangunan File Server
dan Diskless Xternal berbasis Linux
di laboratorium komputer di
kampus saya. Walaupun saya
teramat sangat tidak mengerti
dengan apa yang dia tulis, tetapi
saya mulai mengenal Linux,
seperti beberapa distronya, siapa
pendirinya, dan di komputer
sayapun sudah ada aplikasi Linux
Mandrake 9.1 dan itupun di-install
oleh teman saya.

Sebenarnya banyak yang
ingin saya ketahui, namun karena
keterbatasan pengetahuan yang
saya ketahui, saya belum dapat
mengembangkan keingintahuan
saya. Membuat partisi saya saja
belum bisa secara praktek,
padahal saya punya CD Partition
Magic 8.1 dan secara teori saya
sudah cukup memahaminya.

Yang ingin saya tanyakan
adalah, adakah buku atau
panduan yang mengupas Linux
secara mendasar sampai ke detail-
detail yang tidak dimengerti oleh
orang seperti saya. Buku-buku
atau majalah tentang Linux yang
sudah banyak beredar sekarang
memang bagus dan isinya sangat
membantu saya, namun adalah
buku yang mengupas secara
mendasar dan lebih teoretis
seperti penjelasan mengenai
istilah-istilah khusus di Linux,
perbedaan mencolok dari
beberapa distro Linux yang ada
saat ini, perkembangan
perusahaannya, dan lain-lain.
Tidaklah menjadi masalah apabila
informasi saya inginkan tidak
terdapat dalam satu buku
sekaligus, yang penting saya
mendapat referensi untuk
memudahkan saya.

Demikian surat dari saya,
besar harapan saya PCplus dapat
membantu dan menjawab
keingintahuan saya yang besar ini.
Terima kasih. Hormat saya

Kristin Oktanita
ktin_maniez@plasa.com

Red: Anda bisa mengunjungi TB
Gramedia terdekat di kota Anda dan
mencari banyak referensi tentang Linux
di sana. Mudah-mudahan dalam waktu
dekat rencana PCplus menerbitkan
buku tentang Linux bisa segera
terealisasi. Salut untuk keinginan yang
besar untuk belajar yang Anda miliki.

TAMPILAN TERGANGGU
Dear PCplus. Langsung saja,

saya memiliki komputer dengan
Windows XP di dalamnya.
Beberapa bulan yang lalu saya
sering bertukar harddisk dengan
teman saya karena beberapa
kebutuhan. Tapi sejak itu,
computer saya sering bergaris-
garis berwarna, garisnya terputus-
putus apalagi bila saya sedang
menjalankan beberapa program
sekaligus. Walaupun tidak
berpengaruh terhadap hasil print
tapi itu tetap mengganggu saya
karena tidak biasanya monitor
saya seperti itu.

Pernah juga terjadi kerusakan
gambar deskstop-nya tidak
kelihatan, keadaan gambarnya
seperti TV yang contrast-nya
terlalu besar. Sudah diperbaiki dan
kembali normal walaupun garis-
garis itu masih ada, seperti kalau
saya baru mengklik [start]>[all
program]. Nah pada option-
option-nya itu terdapat garis
putus-putus. Yang paling kelihatan
adalah kalau saya sedang bermain
Need for Speed Hot Pursuit 2, di
jalannya, di awannya, di
pepohonannya, dan itu jelas
sangat mengganggu saya ketika
bermain.

Yang ingin saya tanyakan
adalah adakah alasan lain yang
menyebabkan tampilan monitor
saya menjadi seperti itu, dan
bagaimana cara memperbaikinya?

Demikian dari saya, harap
pertanyaan saya dijawab. Terima
kasih.

Rani Mardani
wlily86@plasa.com

Red: Kemungkinan driver VGA card
Anda mengalami gangguan. Cobalah
periksa driver-nya, usahakan
mendapatkan driver terbaru. Apabila
mengalami kesulitan, lebih baik Anda
buang driver lama dan pasang driver
yang baru.

TERBIT LEBIH AWAL?
Dear Redaksi PCplus,

langsung aja, saya ingin
mengucapkan terima kasih atas
terbitnya kembali PCplus di kota
saya. Sudah 2 bulan ini PCplus
tidak terbit di kota saya, yang
menyebabkan saya ketinggalan
berita-berita IT yang hot dan
terbaru. Saya sempat merasa
kecewa dengan PCplus, sebab
yang janjinya "Terbit Lebih Awal"
malah tidak terbit sama sekali.

Untuk selanjutnya saya harap
PCplus dapat terbit sesuai dengan
jadwal, sehingga tidak
mengecewakan penggemarmu di
sini.

Obe
Singaraja, Bali

Red: Terima kasih atas saran dan
masukannya. Yang jelas, kami
mencoba memperbaiki jaringan
distribusi kami, terutama di luar Pulau
Jawa.



Awas, Muncul Kegiatan Spam yang Meresahkan! Dalam
beberapa bulan terakhir, APJII (Asosiasi Penyelenggara Jasa Internet Indonesia) memperoleh banyak
informasi dari komunitas Internet Indonesia akan meluasnya bentuk spam berbahasa Indonesia yang
isinya menghujat agama, mengadu domba antarumat beragama, memfitnah orang lain dan pornografi
melalui kata-kata (tanpa gambar). Spam-spam semacam itu biasanya disebut spam fitnah atau
harrasment.

Kesimpulan sementara yang dibuat APJII berdasarkan laporan yang diterima oleh Incident Response
Team – APJII sejak 15 Desember 2003 menyebutkan bahwa target yang diincar oleh pelakunya adalah
milis Indonesia yang ada di Yahoogroups. Spam ini mulai terdeteksi sejak Juni 2003, mulai memanas di
bulan Ramadhan 1424 (November 2003) dan masih berlanjut hingga saat ini.

Ancaman spam ini sudah dikategorikan sebagai suatu bentuk aksi teror. Sebagai langkah proaktif,
APJII, berkoordinasi dengan berbagai berbagai pihak, akan mengusut tuntas motivasi pelakunya. Sudah
ada tanggapan positif dari pihak Aus-Cert untuk membantu pengusutan kasus ini. APJII juga
menghimbau para pengguna Internet untuk memberi laporan melalui e-mail ke alamat
abuse@apjii.or.id, lengkap dengan isinya, bila menemukan atau menerima e-mail sejenis.
Pemberitahuan itu nantinya akan disebarluaskan ke publik dan akan digunakan untuk kepentingan
hukum dan proses pelacakan pelaku. Untuk memerangi aksi spam ini, APJII berencana untuk membuat
pernyataan global di Forum APRICOT2004. (raa)

Akhirnya, IIX-JKT3 Resmi Beroperasi. Masih sibuk melobi pihak
Telkom untuk mengubah keputusannya mengenai pemindahan IIX-JKT1, APJII, bekerja sama dengan PT
NAP Info Lintas Nusa, akhirnya merampungkan pembangunan node IIX-JKT3. Dengan adanya peresmian
node tersebut, tanggal 15 Januari 2004, APJII berhasil membentuk sebuah triangle network antar ketiga
IIX yang ada di Jakarta.

Dalam peresmian ini, APJII menyatakan dukungannya terhadap e-Government Indonesia yang
dikoordinasi oleh Tim Koordinasi Telematika Indonesia (TKTI). Sebagai wujud kontribusinya, komunitas
Penyelenggara Jasa Internet (PJI atau ISP) memberikan tarif khusus untuk akses Internet bagi lembaga
pemerintah yang menyelenggarakan e-Government.

Empat hari kemudian, tanggal 19 Januari 2004, APJII membentuk korwil (koordinator wilayah)
untuk daerah Jogjakarta. Pembentukan Korwil ini dipimpin oleh Heru Nugroho selaku Sekjen APJII, dan
dihadiri oleh 13 PJI yang ada di Jogjakarta. Dua orang yang ditunjuk sebagai pengurus adalah Valens
Riyadi dari Citra.net (Koordinator 1) dan Linus Roymond dari LC.net (Koordinator 2). Fokus program awal
Korwil Jogjakarta adalah pada pembangunan node Jogjakarta Internet eXchange dan penciptaan iklim
industri Internet di Jogjakarta. (raa)

Padang Pariaman, Buka Matamu untuk Teknologi
Informasi. Kota kecil di pantai barat pulau Sumatera dengan jumlah penduduk sebesar 72.066
ini bisa tersenyum. Kini mereka memiliki sebuah pusat pelatihan dan pembelajaran yang disebut Pusat
Teknologi Informasi Masyarakat (PTIM) Padang Pariaman. PTIM ini, dikelola oleh Koalisi Perempuan
Indonesia (KPI) Sumatera Barat dan berlokasi di Panti Asuhan Aisyiyah, dilengkapi dengan 5 unit PC dan 1
printer serta peralatan lainnya – seperti layaknya sebuah ruang kelas komputer.

PTIM Padang Pariaman merupakan salah satu bentuk realisasi program bakti sosial Microsoft di
Indonesia yang bertajuk Unlimited Potential (UP). Program UP yang pertama kali diluncurkan di Indone-
sia tanggal 23 Oktober 2003 ini mengikutsertakan 2 organisasi nirlaba – KPI dan Asia Foundation. KPI
bertanggung jawab untuk mengelola sentra di 5 lokasi – Padang Pariaman, Bengkulu, Jambi, Sukabumi
dan Mataram. Sedangkan Asia Foundation bertanggung jawab untuk mengelola 3 sentra - di Medan,
Pontianak dan Surabaya. (raa)

LIH m-Citibank, Peningkatan Kualitas Layanan
Perbankan Pribadi. Layanan ini, hadir mulai tanggal 15 Januari lalu dan merupakan
pengembangan fasilitas SMS Banking yang telah disediakan khusus bagi nasabah Citibank untuk
mendapatkan fasilitas perbankannya. LIH m-Citibank bisa diakses oleh semua pengguna kartu proXL,
baik pengguna layanan prabayar maupun pascabayar, yang telah menggunakan kartu Life In Hand (LIH).
Struktur menu LIH m-Citibank terdiri dari m-Info, m-Transfer, m-Payment, m-Commerce, dan m-Admin.
Transaksi yang bisa dilakukan oleh nasabah antara lain adalah transaksi cek saldo dan pengisian pulsa
permohonan PIN.

Para pemegang kartu kredit Citibank (Visa, Master, Clear Card dan Platinum), Citibank Ready Cash
dan pemilik rekening Tabungan, Giro dan Deposito Citibank bisa melakukan registrasi melalui CitiPhone
Banking 24 jam di nomor 69999 melalui ponselnya dan men-download menu m-Citibank melalui Create
Menu. Menu m-Citibank akan berada di kategori proXL Banking Life In Hand atau New Services.

Ketika melakukan registrasi melalui CitiPhone Banking, nasabah perlu mendaftarkan rekening kartu
kredit dan rekening perbankan yang akan diakses melalui layanan m-Banking. Ia akan diminta
menentukan account code (kode rekening) untuk masing-masing rekening kartu kredit. Account code
akan digunakan sebagai pilihan rekening yang akan diakses melalui layanan m-Citibank.

Jika pemegang Kartu Kredit Citibank sebelumnya sudah melakukan registrasi untuk layanan SMS
Credit Card, maka yang bersangkutan tidak perlu lagi melakukan registrasi untuk layanan m-Citibank ke
CitiPhone Banking. Isi ulang elektronik e-Reload-Citi yang sebelumnya berada di menu proXL Banking
Life In Hand akan berada di kategori menu m-Commerce m-Citibank. Tarif yang ditarik untuk layanan ini
adalah Rp 500 per akses atau transaksi. Khusus untuk proses e-Reload, tak ada tarif yang dibebankan
pada pengguna. (raa)

IBM Raih Jumlah Hak Paten Terbanyak. Jumlah hak paten yang di-
peroleh IBM dari Kantor Merk Dagang dan Hak Paten AS di tahun 2003 tercatat sebanyak 3.415. Dengan
begitu, IBM berhasil  memecahkan rekor perolehan jumlah paten terbanyak dalam satu tahun. Selama 11
tahun terakhir, IBM telah menghasilkan lebih dari 25.000 paten AS dari inovasi-inovasinya, hampir 3 kali
jumlah yang diperoleh perusahaan TI lainnya. IBM juga berhasil mengungguli seluruh jumlah paten yang
diraih Hewlett-Packard, Dell, Microsoft, Sun, Oracle, Intel, Apple, EMC, Accenture, dan EDS.

IBM menerapkan ribuan paten barunya untuk mempercepat proses adopsi komputasi on demand
dan memperluas kepemimpinannya di bidang layanan dan konsultasi TI. Beberapa contoh paten yang
telah diperoleh IBM di tahun 2003 antara lain adalah pemulihan error pada sistem komputer dan
pengisolasian kesalahan (IBM eSrver xSeries), pengaplikasian otomatisasi dan prosedur pemulihan beban
kerja komputer berkecepatan tinggi (IBM eServer zSeries), desain kartu kredit yang dilengkapi keypad
dan komponen elektronik yang tertanam untuk mencegah penggunaan tanpa ijin atau pemalsuan
identitas. (raa)

HP Luncurkan Produk Baru yang
Terjangkau UKM. Beberapa produk baru yang
telah diluncurkan di antaranya termasuk HP Business Inkjet
Seri 2300, HP Color LaserJet 3500, HP Color LaserJet 3700
dan HP Web JetAdmin 7.5. HP Business Inkjet seri 2300 dibuat
untuk memenuhi kebutuhan pencetakan untuk kelompok kerja
kecil yang perlu meningkatkan kualitas warna dan hasil cetakan.
Kualitas kecepatannya sampai dengan 9 halaman per menit (ppm)
untuk cetakan hitam dan 5 ppm untuk cetakan berwarna. HP
Business Inkjet seri 2300 juga dilengkapi dengan teknologi
Jetdirect untuk kebutuhan jaringan dan HP Embedded Web
Server (EWS) yang memudahkan penguna dari kalangan bisnis
dan profesional TI untuk mengatur penggunaan printer tersebut
dari jauh.

HP Color LaserJet seri 3500 dan HP Color LaserJet seri 3700
dibuat secara khusus untuk unit usaha yang lebih kecil. Kedua
printer tersebut menawarkan fitur HP’s ImageREt 2400 printing
dan HP instant - dengan teknologi fusi, proses electro-photo-
graphic yang lebih baik. Seri printer ini menawarkan kecepatan
12ppm untuk cetakan berwarna dan hitam putih, yang juga cocok
untuk lingkungan Windows dan Mac.

HP Color LaserJet seri 3700 meningkatkan kecepatan
pencetakan hinga 16ppm. Dengan adanya fungsi Page Descrip-
tion Language (PDL), produk ini juga cocok untuk semua sistem
operasi. HP Web JetAdmin merupakan solusi pengelolaan
piranti lunak yang sederhana untuk meng-install, membentuk,
dan mengatur berbagai jenis jaringan HP dan non-HP yang
hanya menggunakan  standar browser Web. Dengan adanya
arstitektur HP Web JetAdmin plug-in, berbagai peralatan baru
dan aplikasi dapat ditambahkan setiap saat tanpa harus meng-
install software. (raa)

Paket Kartu Perdana Murah dari
Fren, Menjaring Persahabatan
dengan Fren. Paket kartu perdana seharga Rp 50.000
ini merupakan salah satu upaya Mobile-8 untuk membuktikan
komitmennya terhadap layanan komunikasi bergerak. Kartu ini
sudah termasuk
total pulsa senilai
Rp 38.000,-, dan
tarif yang
berlaku sama
dengan tarif Fren
Launch Edition.
Untuk paket
kartu perdana
Fren, akses data
akan dikenai
biaya sebesar Rp
5,-/KB. Kartu
perdana ini akan
segera tersedia di
pusat-pusat
penjualan ponsel
dan Mobile-8
Center di seluruh
Pulau Jawa.

Mobile-8
akan
mengadakan
special promo-
nya mulai
tanggal 8 Januari hingga 30 April 2004. Special promo ini berlaku
untuk tarif SMS antar pengguna Fren serta telpon lokal dan non
lokal. Biaya yang ditarik untuk telpon lokal antar pengguna Fren
adalah Rp 275,- (biasanya Rp 400,-) dan  untuk telpon non lokal
antar pengguna Fren adalah Rp 500,- (biasanya Rp 750,-).
Sedangkan tarif yang dipasang untuk SMS antar pengguna Fren
adalah Rp 250,- (biasanya Rp 350,-). (raa)

Intel Akan Luncurkan Chip Wire-
less 802.11g untuk Notebook. Chip
tersebut, Intel Pro/Wireless 2200BG, memungkinkan user untuk
konek ke jaringan nirkabel, baik itu jaringan 802.11b atau
jaringan 802.11g. Notebook tersebut, rencananya,  akan
diluncurkan pada pertengahan tahun ini. Sebelumnya, package
Centrino dengan kemampuan akses jaringan 802.11b yang terdiri
atas prosesor Pentium M, chipset mobile, serta chip Intel Pro/
Wireless 2100BG telah diluncurkan pada bulan Maret 2003.
Standar 802.11b, yang besar bandwidth-nya 4-5mbps, merupakan
salah satu yang paling banyak digunakan untuk koneksi wireless
LAN, padahal standar 802.11g dan 802.11a menawarkan band-
width yang lebih besar (sekitar 20 hingga 25mbps). Vendor chip
WLAN lain, seperti Atheros Communications dan Broadcom,
memang telah lebih dulu memroduksi chip dual-band, tetapi
pasar access point 802.11g baru akan dimulai sekarang. (raa)

plusAktual V • 27 Januari - 02 Februari 2004
PCplus 160

| 3

ISTIMEWA



plusAktual V • 27 Januari - 02 Februari 2004
PCplus 160

4 |

Hati-hati, Penipuan Lewat E-mail. Seperti biasa, virus-virus
memanfaatkan kelemahan yang ada pada Microsoft Internet Explorer. Penipuan yang baru saja
dilaporkan oleh Panda Software ini menggunakan situs online banking palsu dan e-mail untuk menipu
user agar membuka data rahasia. Belakangan ini, banyak user telah menerima e-mail yang mengatakan
tentang adanya masalah teknis, dan user untuk mengakses web page untuk mensyahkan rekening di
bank masing-masing secara mendetil.

Salah satu contoh e-mail yang disebarkan paling sering ditujukan kepada client dari CITIBANK
dengan judul “Waspadai penggelapan uang dari Citibank”. Pesan ini mengatakan tentang adanya
rangkaian operasi yang bertujuan untuk mendeteksi aktivitas bank yang ilegal, user harus mengecek
apakah data mereka sudah benar dengan cara mengunjungi situs Web tertentu.

Semua e-mail ini adalah tipuan, dan bertujuan untuk menipu user agar membuka data-data
rahasianya,  seperti nomor rekening, nama nasabah, password yang digunakan atau kode-kode dan
nomor rahasia lainnya. Untuk melakukan tipuan semacam ini, biasanya cracker telah memformat
pesan-pesan dalam bentuk HTML agar lebih mirip dengan pesan asli yang dikirim oleh layanan online
banking. Hal inilah yang menyebabkan para nasabah mudah tertipu.

E-mail tipuan ini dirancang untuk memanfaatkan kelemahan URLSpoof pada Microsoft Internet
Explorer. Kerusakan yang ditimbulkan memungkinkan cracker menipu user supaya berpikir bahwa
halaman Web yang mereka masuki – yang diperoleh dari link pada e-mail – memang berisi pesan dari
bank. User tak sadar bahwa situs Web tersebut adalah tiruan dari situs aslinya. Jika user memasukkan
data-data mereka, user akan masuk ke situs si cracker.

Panda Software memberi peringatan kepada semua user untuk lebih berhati-hati menghadapi e-
mail dari bank-bank yang meminta informasi, karena kemungkinan besar ini merupakan salah satu
bentuk penipuan. Sebelum membocorkan informasi rahasianya, user harus mengonfirmasikan terlebih
dahulu kebenaran  pesan yang didapat sebelum menanyakannya kepada pihak bank. Berkenaan
dengan banyaknya sirkulasi e-mail tipuan tersebut, maka Panda Software meluncurkan update untuk
produknya. Tool untuk mendeteksi bentuk usaha yang memanfaatkan kelemahan Internet Explorer ini
bisa di-download di alamat http://www.pandasoftware.com. (raa)

Verizon Tunjuk Nortel Networks
untuk Percepat Pembangunan
Jaringan Berteknologi VoIP. Ini
merupakan pembangunan jaringan converged packet switched
wireline terbesar di Amerika Serikat, yang menggunakan teknologi
VoIP (Voice Over Internet Protocol). Verizon Communications
merupakan penyedia layanan komunikasi terbesar di AS yang
mulai mengganti central office switches tradisional menjadi packet
switches. Untuk alasan itulah, Verizon menunjuk Nortel Networks
sebagai penyedia perangkat VoIP-nya.Verizon berencana untuk
menawarkan layanan VoIP dan multimedia terlengkap bagi  para
konsumen dan bisnis di Amerika Serikat – berupa kemampuan
berkomunikasi yang dapat meningkatkan fungsi, mobilitas, dan
produktivitas. Harapan Verizon, semoga jaringan generasi
mendatang mereka akan menjadi jaringan konvergensi terbesar di
AS yang bisa menerima transmisi voice, data dan video secara
bersamaan.

Nortel Networks dan Verizon telah menandatangani Letter of
Agreement (LOA) yang meliputi persyaratan awal perjanjian.
Kedua belah pihak akan mengganti LOA ini dengan perjanjian
lima tahun dalam beberapa bulan mendatang. Satu hal penting
yang terdapat pada perjanjian antara keduanya adalah mengenai
penggantian sejumlah traditional local switches milik Verizon
dengan Nortel Networks softswitches (istilah di industri untuk VoIP
packet switches) dan VoIP gateways untuk memperluas jaringan
sambungan langsung jarak jauh. Nortel Networks akan menjadi
penyedia eksklusif dari VoIP switches long distance Class 4 (tan-
dem) dan Class 5 (lokal) milik Verizon di kantor-kantor barunya
untuk 18 bulan mendatang.

Untuk konsumen bisnis di Amerika Serikat, Verizon
merencanakan untuk menawarkan gabungan voice lokal dan
sambungan langsung jarak jauh, data dan produktivitas baru yang
meningkatkan layanan multimedia dan aplikasi. Konsumen
enterprise akan mampu meningkatkan layanan dial-tone dengan
layanan IP yang lebih fleksibel seperti instant video calling, unified
messaging, web-based call screening dan routing serta address
book integration.

Sedangkan, untuk konsumen residensial, Verizon akan
menawarkan layanan yang lengkap dan terjangkau, termasuk
layanan VoIP lokal dan sambungan langsung jarak jauh, seperti
akses Internet di seluruh koneksi broadband tunggal. Traffic dari
konsumen residensial dan enterprise akan berbagi common packet
network dari Verizon. Ketika dikombinasikan dengan proyek Fiber
to the Premises (FTTP) dari Verizon yang diumumkan sebelumnya,
konsumen akan dapat menggunakan bandwidth dan kualitas
layanan yang lebih tinggi untuk layanan voice, multimedia dan
video yang sempurna dan simultan.

Pengoperasian awal layanan Verizon dijadwalkan pada
pertengahan 2004 dan diharapkan akan meliputi layanan hosted
VoIP dan multimedia untuk bisnis dan konsumen. (raa)
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Bisa Sedemikian Kecil?

M

Kawan, juga lawan.
Demikianlah julukan
yang kira-kira cocok

untuk MP3.Kawan
bagi sebagian besar

penikmat musik yang
menggunakan PC,
namun lawan bagi
pemusik. Mengapa

MP3 bisa sedemikian
populer dan juga bisa
memadatkan ukuran
file sedemikian kecil,

tanpa terlalu
mengganggu telinga

normal kita? Inilah
jawabannya.

P3 termasuk
bagian dari
sistem kompresi Moving
Picture Experts Group

(MPEG). MPEG sendiri terdiri dari
beberapa bagian, yaitu MPEG-1,
MPEG-2, dan MPEG-4. MPEG-1
menawarkan video beresolusi
352x240 dengan frame rate 30fps.
MPEG-2 juga menyediakan video,
namun dengan resolusi yang lebih
tinggi, yaitu 720x480 dan
1280x720 pada 60fps. MPEG-4
adalah kompresi untuk grafik dan
video. Ukuran hasil MPEG-4
biasanya lebih kecil dibandingkan
dengan lainnya. Nah, MP3
termasuk dalam MPEG-1 audio
Layer-3.

Kompresi MP3 adalah kompresi
yang “bandel”. Bereksperimenlah
seperti berikut ini. Masukkan CD
audio ke CD-ROM, kemudian buka
Windows Explorer. Lihat salah satu
ukuran file lagu di dalam CD itu.
Biasanya puluhan mega. Lalu, coba
convert lagu itu menjadi MP3
dengan menggunakan ripper,
software untuk menghasilkan MP3
dari CD audio. Hasilnya bisa

mencapai kira-kira 90% lebih kecil.
Contohnya, lagu di CD audio, yang
tadinya berukuran 35MB, bisa
menjadi file MP3 berukuran 3MB.

Tidak hanya pengurangan
ukuran yang mengagumkan. Coba
dengarkan file MP3 yang tadi.
Bandingkan kualitasnya dengan
lagu yang sama di CD audio. Orang
berkuping awam dunia audio akan
berkata, “Nggak ada bedanya tuh.”

KOMPRESINYA
Apakah MP3 termasuk hasil

dari kompresi lossless? Bukan.
MP3 adalah buah kompresi lossy.
Namun mengapa kualitasnya
sama? Berikut ini penjelasannya.

Pada umumnya CD audio
dibuat dengan mengambil sample
(bahasa awamnya, menjiplak)
data dari pita sebanyak 44.100 kali
setiap detik. Satu sample memiliki

panjang 2byte alias 16 bit (ingat, 1
byte= 9 bit). Karena CD audio
biasanya stereo, sample diambil
untuk speaker kiri dan kanan.
Dengan demikian, dalam satu
detik CD audio memiliki data
sebesar 44.100sample/detik x
16bit/sample x 2 atau sama
dengan 1.411.200bit. Dengan
demikian, lagu sepanjang 3 menit
memiliki file berukuran kurang

lebih 35MB.
File audio yang ada di dalam

CD itu mengandung suara yang
sangat kompleks. Nah, Ada fakta
yang berhubungan dengan
telinga manusia dalam
mendengar. Yang pertama,
telinga manusia tidak dapat
mendengar semua suara. Yang ke
dua, telinga manusia dapat
mendengar sebuah suara lebih
baik dari pada suara lain. Yang ke
tiga, kalau ada dua suara yang
berbunyi bersamaan, telinga
manusia mendengar bunyi yang
lebih keras. Nah, fakta-fakta
seperti ini digunakan oleh
kompresi MP3.

Ripper memiliki suatu
algoritma untuk menghilangkan
bunyi-bunyi pada frekuensi
tertentu, yang tidak dapat
didengar telinga manusia. Di
samping itu, ia akan mencari
bunyi yang sangat keras dan
menyimpannya. Bunyi-bunyi lain
yang tertutup oleh bunyi itu akan
dibuang. Makanya, sebenarnya
kualitas MP3  tidak sebaik kualitas
CD audio. Hanya saja, di telinga
awam dunia audio, bunyi
terdengar sama. Para ahli di

bidang audio, apalagi yang high-
end, akan berpendapat berbeda.

SEBAGAI KAWAN, SEBAGAI
LAWAN

Contoh yang sebelumnya
menyebutkan bahwa file di dalam
CD audio berukuran 35MB.
Dengan koneksi berkecepatan
56Kbps, file itu dapat di-download
dengan waktu kurang lebih 2 jam.
Dengan MP3 yang berukuran
3MB, dalam hitungan menit saja
proses download sudah selesai.
Makanya, MP3 menjadi idola para
netter dalam barter lagu.

Kemudahan penyebaran
MP3, kualitas yang tidak jauh
berbeda, tidak boros kapasitas
karena ukurannya yang kecil,
ditambah lagi dengan mudahnya
membuat MP3 dengan
menggunakanripper,
menyebabkan kebanyakan orang
lebih memilih MP3 daripada
membeli CD audio. Belum lagi,
MP3 dapat kembali ditransfer
menjadi CD audio. Tentu saja ini
membuat para pembuat album
kalang kabut. Bisa-bisa album
mereka tidak laku lagi.

Gitu Mas, Mbak! PC+

MP3 adalah file audio yang kualitasnya dekat dengan CD audio namun
dengan ukuran file yang sangat kecil.
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Tambahan Gizi
Untuk PDA Anda

“Buat apa beli PDA?
Terlalu mahal. Lebih
baik beli notes kecil
seharga seribuan di
depan stasiun. Toh

fungsinya sama saja.”
Begitu kata-kata sinis
seseorang mengenai

si PDA (Personal Digi-
tal Assistant).

Meskipun demikian,
bagi sebagian pelaku

dunia TI, PDA sudah
berubah kelas dari

barang mewah
menjadi sebuah

kebutuhan dan gaya
hidup.

ungsinya pun
sudah jauh
berkembang dari
sekedar pengingat

jadwal dan contact, menjadi
semacam komputer mini yang
sangat mobile. Mungkin salah
satu faktor pendorong
perkembangan ini adalah
adanya saingan dari dunia
mobile phone yang juga sudah
berkembang mendekati fungsi
PDA. Dengan beragam fungsi
baru yang ditambahkan ini,
tidak mungkin lagi
menggantikan sebuah PDA
dengan buku notes, bukan?

DUA RAJA BESAR
Selayaknya komputer,

ternyata kita bisa
menambahkan sendiri berbagai
software untuk memperkaya
PDA. Salah satu sumber di mana

kita bisa mendapatkan beragam
software tersebut tentu saja dari
Internet.

Tetapi sebelum mulai
berburu software, pastikan dulu
dari kubu manakah PDA Anda
berasal? Karena saat ini ada dua
kekuatan besar yang merajai
dunia PDA. Palm dengan Palm
OS-nya dan Microsoft dengan
Pocket PC-nya.

Selain dua raksasa di atas,
ada juga yang namanya Symbian
yang biasanya digunakan untuk
sistem smart
mobile phone.
Dan tidak
ketinggalan si Mr.
Pinguin Linux, dan
beberapa sistem
lain yang
semuanya belum
cukup besar untuk
bisa menyaingi
dua raja di atas.

Pastikan
software yang
Anda pilih
kompatibel
dengan sistem

operasi PDA Anda.

MENCARI DI MANA?
Ada beberapa alternatif cara

untuk mendapatkan software
PDA. Di antaranya adalah melalui

program yang memanfaatkan
peer to peer sharing network
seperti Kazaa, eDonkey, dan
WinMX. Gunakan fasilitas
Search, pilih batasan hasil
pencarian untuk menampilkan
hanya tipe “file”, dan gunakan
kata kunci “PDA”.

Cara lain adalah
menggunakan chatting client
seperti mIRC. Di sini diperlukan
usaha yang lebih tekun. Pertama-
tama Anda harus mengetahui
dulu channel mana yang banyak

membahas mengenai PDA.
Gunakan IRC search engine dari
alamat ini: http://irc.netsplit.de/
channels/ untuk mencarinya.
Setelah masuk ke channel yang
dimaksud, gunakan perintah
@find [nama file]. Hasil
pencarian akan dimunculkan
pada beberapa jendela baru.

Kemudian ada juga
pencarian lewat FTP dan
Newsgroup, tetapi agak
merepotkan dan tidak akan
dibahas di sini.

Kita langsung saja masuk ke
tipe pencarian yang paling
mudah yaitu lewat WWW (World
Wide Web).

MENCARI DI 3W
Ada begitu banyak situs

download di dunia maya yang
menyediakan berbagai software
untuk berbagai jenis sistem
operasi. Biasanya mereka juga
menyediakan software untuk
PDA. Sebagai tempat
memulainya, mari kita datangi
situs-situs download yang paling
populer.

CNet Downloads.com yang
beralamat di
www.downloads.com
sepertinya merupakan salah satu
situs download terpopuler. Untuk
mencari software khusus PDA
(mereka menyebutnya mobile
device) setelah masuk ke
halaman utamanya, kliklah link
Mobile, dan Anda akan dibawa
ke halaman yang khusus
menyediakan software PDA. Ada
dua kategori besar di sini yaitu
Palm dan Pocket PC. Selain itu
mereka juga mengategorikan
berdasarkan yang terpopuler dan
yang paling banyak dibicarakan.

Tucows.com juga

Menginstal
Software PDA
Tidak semudah menginstal software pada PC, tetapi
tidak terlalu sulit juga. Kita membutuhkan bantuan komputer
untuk menambatkan software PDA ke PDAnya. Selain itu
diperlukan juga cara mengoneksikan PDA dengan komputer
pribadi Anda. Bisa melalui kabel ataupun koneksi wireless dengan
WiFi ataupun Bluetooth. Anda akan mendapatkan banyak
bantuan dari manual yang datang beserta perangkat genggam
Anda.

Yang harus diingat adalah bahwa tidak semua software yang
tersedia adalah gratisan. Kebanyakan bisa digunakan dengan
harga tertentu. Tetapi, jika anda sudah sanggup membeli PDA,
membayar beberapa dolar untuk software tambahannya
sepertinya tidak terlalu membebani.

Sementara ini, selamat berburu software. Semoga PDA Anda
dapat menjadi lebih sehat dan bergizi dengan tambahan software
baru. PC+

merupakan situs
download
terpopuler
lainnya. Di sini
ada pilihan yang
lebih luas untuk
kategori PDA.
Ada tersedia
format Epoc,
Newton, dan
RIM, selain dua
format yang
paling populer
yaitu Palm dan
Pocket PC.
Mereka tersedia
pada link
Mobile/PDA di
bagian atas situs.

Selain situs-
situs download
umum, bisa juga
kita mencari
pada situs-situs
yang khusus
menyediakan
download untuk
PDA. Beberapa
contohnya
adalah
PalmGear
(www.
palmgear.com).
Pada situs yang
dikhususkan
untuk PDA ini
ada lebih banyak
pilihan daripada
sekedar soft-
ware. Di
antaranya
adalah eBook.
Selain itu, Anda
juga bisa
mencari
berbagai jenis
PDA,
aksesorisnya,
bantuan dari
komunitas
pengguna PDA
dan knowledge
base mereka.

Contoh situs
lain untuk men-
download
software khusus
PDA adalah
Handmark.
Meskipun format
yang didukung
memang hanya
Palm dan Pocket
PC, tetapi situs
ini mendukung
software untuk
Smartphone
juga. Selain itu
kita juga bisa
mencari soft-
ware
berdasarkan
merek PDA yang kita miliki. Ada
juga link untuk mencari ekspansi
dari SD dan MMC Card, juga
software CD ROM.

Banyak link lain yang bisa
ditemukan dengan bantuan
Google. Untuk mereka yang

Pencarian software dengan Kazaa Lite.

Jendela mIRC.

Downloads.com

belum tahu Google, itu adalah
search engine terbaik dan
terpopuler saat ini. Gunakan
kata kunci Software+PDA+
Download. Hasil pencarian
akan ditampilkan di jendela
berikutnya. PC+

PalmGear

Handmark

Google

Tucows.com
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Indonesia Internet Exchange:
Agar Traffic (dan Devisa)

tak Lari ke Mana

Tanggal 15 Januari,
masyarakat ibu kota

menanti kabar
TransJakarta yang

mulai hari itu
dioperasikan. Jalur

khusus bus yang
menghubungkan Blok

M dengan Kota itu
diharapkan menjadi

titik tolak pemecahan
kemacetan di Jakarta.

Pada hari yang sama
di Hotel Shangri-La

Jakarta, juga ada
peluncuran sesuatu

yang mampu
mengatasi masalah

lalu lintas, namun
bukan lalu lintas jalan

raya, melainkan lalu
lintas Internet.

esuatu itu
adalah Indonesia
Internet Exchange
(IIX) yang ke tiga di

Jakarta. Nama untuk IIX baru ini
adalah IIX-JKT3. Ia menyusul 2
kakaknya yang sudah
beroperasi, IIX-JKT1 dan IIX-
JKT2.

IIX-JKT3 bersama saudara-
saudaranya membentuk suatu
jaringan segitiga. Sementara ini,
hubungan antara IIX-JKT1 ke
IIX-JKT2 terhubung dengan
leased circuit 2Mbps, IIX-JKT2 ke
IIX-JKT3 terhubung sampai
dengan 1Gbps. Hubungan
antara IIX-JKT1 dengan IIX-JKT3
masih dikerjakan.

Dengan hubungan segitiga
ini, antara IIX yang satu dengan
IIX yang lain akan saling
menopang. Artinya, apabila
salah satu IIX mengalami
gangguan, maka IIX yang lain
akan menggantikannya sampai
IIX yang terganggu itu sembuh
kembali.

LATAR BELAKANG
TERBENTUKNYA IIX

Indonesia memiliki PJI
(Penyelenggara Jasa Internet,
sering juga disebut Internet
Service Provider atau ISP)
pertama kali pada tahun 1994,
yaitu Indonet. PJI itu terhubung
ke TELNET dan IRC, yang
menyediakan layanan gratis, di
Singapura melalui International
Direct Dialing (IDD) dengan
menggunakan modem dial-up
berkecepatan 96000bps.

Mulai tahun 1995, setelah
pemerintah melalui
Departemen Pos dan
Telekomunikasi membuat

regulasi khusus untuk
penyelenggaraan Internet di
Indonesia, PJI-PJI mulai tumbuh-
kembang di Indonesia. Pada saat
itu sebagian besar PJI tidak lagi
menggunakan koneksi IDD.
Mereka menggunakan koneksi
dedicated international connec-
tion melalui kabel bawah laut
milik Indosat ke Sprint di Amerika
Serikat dan SingTel di Singapura.
Biaya yang mereka keluarkan
adalah untuk membayar Indosat
dan Sprint atau SingTel.

Satu tahun kemudian, PJI-PJI
membentuk komunitas bernama
Asosiasi Penyelenggara Jasa
Internet Indonesia (APJII) yang
bekerja sama dengan pemerintah
mengatur tarif Internet untuk
end-user.

Sebagian besar PJI yang
tergabung di APJI menggunakan
koneksi internasional meskipun
mereka hendak mengakses
sesamanya di dalam negeri. Solusi
untuk memotong biaya dan
waktu akses yang terbuang
akibat koneksi internasional yang
berlebihan pun diperlukan.

Sebenarnya pemerintah
mengenalkan program bertajuk

Nusantara 21 dan Telematika,
namun hanya benar-benar
sekadar mengenalkan.
Pemerintah tidak benar-benar
menjalankan program sehingga
tidak ada efek bagi dunia
Internet di Indonesia. APJII pun
tak sabar menanti dan mereka
pun mencetuskan IIX-JKT1 tanpa
bantuan pemerintah yang mulai
beroperasi bulan Agustus 1997.
“(IIX) dibangun atas inisiatif ISP-
ISP pada waktu itu. Perangkat
router disponsori oleh CISCO,
karena core dari operasional IIX
adalah router. Sedangkan
infrastruktur menuju ke IIX, ISP
provide masing-masing. Untuk
konfigurasi routing dikerjakan
bersama-sama oleh para teknisi
ISP yang menjadi volunteer pada
waktu itu,” kata Fery D. Prasetyo,
Member Relations Manager APJII.
Selain CISCO, beberapa vendor
seperti Hewlett Packard, Bay,
Microsoft, RAD, dan Digital turut
membantu menyediakan
berbagai keperluan seperti
switch, server, hub, dan software.

Pada akhir tahun 2000,
traffic IIX-JKT1 mencapai titik
jenuh. Kapasitasnya yang 2Mbps

IIX di Masa
Depan
Ada kabar yang menyebutkan bahwa IIX-JKT1 yang
terletak di gedung Telkom akan dipindah karena Telkom
akan menggunakan tempat bercokolnya IIX-JKT1. Tentu saja
ini akan mempengaruhi rencana APJII membangun jaringan
segitiga IIX. “Memang belum ada kabar yang pasti lagi.
Telkom udah ngajak ketemuan, tapi belum ada kata
sepakat,” tutur Heru Nugroho, Sekjen APJII. Andai memang
Telkom akan melaksanakan niatnya, APJII harus
memindahkan IIX keluaran pertama itu.

Mencari lokasi untuk IIX tidak mudah. Lokasinya harus
berdekatan dengan lokasi PJI-PJI yang ada untuk
mengurangi biaya yang dikeluarkan PJI agar dapat
terhubung dengan IIX. Selama ini IIX terletak di gedung
yang sama dengan banyak PJI. PJI-PJI di luar gedung,
dihubungkan dengan salah satu IIX terdekat.

Sampai saat ini IIX hanya berlokasi di Jakarta. “Dari
100% trafik Internet di Indonesia, di Jakarta lah yang 70%,”
ungkap Heru. Namun demikian, ia menambahkan bahwa
akan ada IIX di luar Jakarta yaitu di Surabaya, Jogjakarta,
dan Bandung. Surabaya Internet Exchange akan diluncurkan
pada Maret 2004, kalau tidak ada halangan.  PC+

sudah dirasa tidak mencukupi
kebutuhan. Hal ini mendorong
pembangunan IIX-JKT2 dengan
kapasitas 100Mbps. Pada akhir
tahun 2003, IIX-JKT2 mencapai
titik jenuh, sehingga dibuatlah
IIX-JKT3.

MANFAAT IIX
Misalnya ada sebuah PJI

bernama ABCnet yang menyewa
bandwidth sebesar 2Mbps dari
MCI di Amerika Serikat agar dapat
melayani penyediaan Internet. Di
PJI itu, sebuah situs beralamat
www.apalahnamanya.com di-
hosting. Pada saat itu diakses dari
Indonesia, data harus berjalan-
jalan dulu dari Indonesia ke MCI di
Amerika Serikat, baru kemudian
kembali ke Indonesia. Ini buang-
buang waktu namanya. Belum
lagi biaya bandwidth MCI yang
berkisar USD3,072.00 -
USD8,192.00 per bulan harus
dibayar.

Padahal, buat apa data jauh-
jauh berkelana ke luar negeri
untuk mengakses situs lokal.
Dengan membagi sebagian traffic-
nya ke IIX, sebuah PJI dapat
menyewa bandwidth yang lebih
kecil dan, tentu saja, dengan tarif
yang lebih kecil pula. Misalnya,
2Mbps yang disewa ABCnet dari
MCI dikurangi menjadi 1Mbps
dengan biaya setengah dari biaya
sebelumnya. 1Mbps lagi
menggunakan IIX untuk traffic
lokal dengan biaya, yang menurut
Fery, di bawah USD1.000 per
bulan. Untuk PJI yang
menggunakan koneksi wireless
ada aturan biaya lain. “Apabila ISP

tersebut menggunakan wireless,
hanya kena (biaya) pada
investasi awal saja. Bulanannya
gratis karena telah diakomodasi
oleh IIX,” tutur Fery.

Penghematan waktu jelas
terlihat. Data tidak perlu
dilewati pada lalu lintas yang
lebih dulu berputar jauh ke luar
negeri untuk mengakses sesuatu
di dalam negeri.

Akhir Desember lalu CBN
melaporkan kepada
pelanggannya bahwa ada
gangguan kabel serat optik
bawah laut yang
mengakibatkan gangguan
koneksi ke luar negeri. Pada
saat itu, situs-situs yang di-
hosting di luar Indonesia sulit
diakses, bahkan sama sekali
tidak dapat diakses. Namun,
pada saat situs yang di-hosting
secara lokal, tetap bisa diakses
dengan lancar. Andai saja CBN
tidak terhubung ke IIX, situs
lokal pun tidak bisa dibuka
karena seluruh traffic harus
melalui kabel serat optik yang
sedang terganggu itu.

IIX jelas dapat membantu
perkembangan Internet murah
di Indonesia. Dengan
berkurangnya biaya yang
dikeluarkan PJI, otomatis tarif
PJI yang dikenakan ke
pelanggan pun bisa ditekan.
Dengan demikian, bisa jadi
pengguna Internet di Indonesia
menjadi bertambah. Tapi,
mengapa pemerintah masih
bergeming dengan sikapnya
yang tidak mau membantu
perkembangan IIX? PC+

Sebelum IIX beroperasi, kondisi Internet di Indonesia bisa digambarkan
seperti ini. Seluruh traffic PJI harus dilewati pada berbagai penyedia
layanan Internet di luar negeri.

Setelah IIX beroperasi, traffic lokal tidak perlu lagi berkelana ke luar
negeri. Sebagian traffic menggunakan bandwidth IIX, sebagian lagi
tetap menggunakan bandwidth dari luar negeri.
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hanya kelas ponsel-PDA yang
diberi space layar yang seluas
pulau Kalimantan itu
(hiperbolik!), namun ponsel
“biasa” pun tak luput. Lihat saja
Nokia 6600 yang hampir seluruh
tubuhnya dipenuhi layar.

Mengapa ponsel begitu jor-
joran menyuguhkan layar seperti
hendak bersaing dengan televisi
saja? Semua karena desakan dari
teknologi multimedia pada
ponsel. Layar yang kaya warna,
cerah dan lebar sangat afdol
untuk menampilkan hasil
pemotretan kamera yang mulai
banyak ditanamkan pada ponsel.
Layar seperti itu juga sangat
favorable untuk mendukung
layanan pesan multimedia MMS
yang sudah digelar oleh semua
operator nasional. Dan
perkembangan terbaru teknologi
video streaming melalui jaringan
seluler juga membutuhkan
ponsel dengan layar yang lega
seperti yang ditawarkan oleh
Nokia 6600, misalnya.

MEMORI
Mungkin faktor memori ini

jarang sekali diperhatikan

Beberapa kartu memori atau flash card banyak digunakan oleh ponsel-
ponsel dan PDA yang cerdas. Sayangnya, masing-masing vendor punya
preferensi sendiri akan jenis memori yang digunakan, yang umumnya
berbeda secara fisik dan tidak bisa dipertukarkan. Berikut ini jenis-jenis
kartu memori secara umum yang populer digunakan pada PC, PDA, ponsel,
atau kamera digital:

COMPACT FLASH (CF CARD)
Ini adalah jenis yang paling populer. Ada dua tipe: Type I merupakan

jenis orijinalnya yang lebih tebal dibanding Type II. Peranti dengan slot Type
I tidak dapat dimasuki CF Type II. Namun peranti dengan Type II bisa
menggunakan kedua jenis CF tersebut. CF terkini bisa menampung 8MB
sampai 1GB data.

SMART MEDIA (SM)
Ukurannya relatif kecil dan tipis, karena controller-nya terdapat pada

equipment, bukan pada kartu memorinya. Sekarang ini kapasitasnya sudah
mencapai 128MB, namun kemungkinan besar peranti SM lama tidak
kompatibel dengan SM baru yang berkapasitas 64MB dan 128MB.

MEMORY STICK (MS)
Berbentuk pipih seperti stik es krim. Saat ini sanggup menyimpan data

128MB. Versi lebih kecilnya lagi adalah Memory Stick Duo yang menampung
data sampai 16MB dan bisa dipasang ke slot MS jika diberi sebuah adapter.
Sedang jenis yang paling berkapasitas terbesar, yaitu 1GB, adalah Memory
Stick Pro. Namun MS Pro ini tidak kompatibel dengan kedua versi MS
sebelumnya.

SECURE DIGITAL CARD (SD)
& MULTIMEDIA CARD (MMC)

Keduanya digabungkan karena mempunyai bentuk fisik yang sama.
Namun secara teknis memang terdapat perbedaan. SD Card dapat
menyimpan dan memroteksi data yang copyrighted, sedang MMC tidak
bisa. Beberapa peranti mempunyai kemampuan untuk mengenali keduanya.
Kapasitas yang bisa diusung oleh keduanya adalah sampai 256MB. PC+

JENIS-JENIS KARTU MEMORI
ATAU FLASH CARD

konsumen. Atau malah bisa jadi
pengguna ponsel tidak tahu
kalau ponselnya punya memori
untuk menyimpan data dan
aplikasi. Atau kalau pun peduli,
pedagangnya juga mungkin
tidak terlalu paham.

Kalau kita butuh tempat
untuk menyimpan data,
seperti phonebook dan SMS,
yang butuh banyak ruang
maka kapasitas memori yang
tersedia secara onboard
seharusnya menjadi perhatian
utama. Akan sangat
menjengkelkan jika tiba-tiba
kita kehabisan tempat untuk
menyimpan nomor telepon
atau SMS dan harus
menghapus salah satu yang
sudah ada.

Makin banyak fitur yang
ditawarkan pada sebuah
peranti ponsel, maka
seharusnya makin banyak pula
memori yang disediakan. Pada
golongan smart phone, malah
sudah menjadi keharusan
untuk menyediakan memori
tambahan dalam bentuk
removable disk atau flash
memory. Bentuknya
bermacam-macam, ada yang
berupa Multimedia Card
(MMC) seperti pada Nokia
3650, atau Memori Stick Duo
seperti pada Sony Ericsson
P800 dan P900. Dengan
memori tambahan yang luwes
ini kemampuan menyimpan
data menjadi lebih besar
karena peranti removable disk
itu mempunyai besaran 16MB
sampai 256MB.

Harap diperhatikan
bahwa SIM Card juga
mempunyai memori sendiri
yang saat ini sudah mencapai
64KB. Jadi manajemen memori
dan data antara yang ada
dalam ponsel dengan yang ada
pada SIM Card juga harus
diperhatikan. PC+Suasana sebuah toko di ITC Roxy Mas di suatu hari di tahun 2003,

persaingan harga demikian ketat

Alat yang bernama
ponsel ini makin mirip

komputer. Atau
setidaknya PDA (Per-

sonal Digital Assis-
tant). Apa yang bisa

membuatnya begitu?

oba simak
beberapa faktor untuk
pertimbangan belanja
berikut ini. Ketiga

faktor ini sangat berperan
dalam menjadikan ponsel
sebagai peranti cerdas. Dan tak
ada salahnya untuk mempunyai
ponsel yang cerdas dan
serbabisa. Tentu saja kita harus
juga lebih cerdas memilih!

KONEKTIVITAS
Bagi sementara orang,

aspek konektivitas dan
eskpandabilitas merupakan
syarat utama bagi ponselnya.
Mereka ini umumnya mencintai

dunia wireless dan Internet.
Mereka butuh agar ponselnya
bisa berhubungan dengan
peranti lain dan berfungsi
sebagai modem dial up atau
sekadar agar bisa
menyinkronisasikan data-data
ponsel ke komputer atau PDA.
Dengan berhubungan dengan
peranti lain, ponsel menjadi
“kian cerdas” dan
“dandanable”, bisa didandani
sesuai keinginan. Sederhananya,
coba simak bagaimana orang
menciptakan berbagai ringtone
atau logo operator atau game
untuk bisa dikirim ke ponsel.

Ponsel-ponsel kelas
menengah ke atas umumnya
disertai dengan kemampuan
untuk mengoneksikannya ke
peranti lain melalui setidaknya
tiga cara: kabel data, infrared,
dan bluetooth.

Teknologi koneksi yang pa-
ling lumrah terdapat pada pon-
sel tak ayal lagi adalah inframe-
rah. Teknologi inframerah stan-
dar terbaru mampu mengusung
data pada kecepatan 9,6Kbps
sampai 4Mbps. Kelemahan
inframerah yang paling
menonjol adalah keharusan
untuk saling mengarahkan

antarmuka inframerah kedua
peranti tepat berhadap-hadapan.

Namun sayangnya, banyak
juga ponsel kelas menengah ke
atas yang tidak dilengkapi de-
ngan inframerah. Menyedihkan.
Lebih menyedihkan lagi, banyak
prinsipal ponsel sengaja
menghilangkan salah satu alat

konektivitas dengan maksud
untuk memangkas harga.

Teknologi yang juga umum
terdapat pada ponsel adalah
koneksi dengan kabel data.
Koneksi yang umum dilakukan
melalui port serial dengan kabel
RS 232 ini mampu mengantarkan
data dengan kecepatan 115Kbps,
sedang melalui USB bisa sampai
1,5Mbps. Sayang juga bahwa saat
ini susah sekali untuk beroleh
kabel data dikemas menjadi satu
dengan ponsel saat membelinya.
Padahal dulu Siemens rajin
membekali ponselnya dengan
kabel data, sekarang tidak lagi.

Teknologi paling canggih
dalam soal koneksi ini adalah
Bluetooth. Dengan Bluetooth,
jarak jangkau antarperantinya
bisa sampai 100 meter, dan tidak
perlu saling menghadapkannya
secara line of sight (langsung
berhadapan) seperti pada
inframerah. Bluetooth juga
mendukung kecepatan kirim data
sampai  4,8 dan 12Mbps
(Bluetooth 2.0) serta 2 sampai 3
Mbps (Bluetooth 1.2).

LAYAR
Layar ponsel makin crispy, itu

benar. Antarmukanya juga sudah

padat grafis, bukan lagi teks.
Artinya, ikon dan wallpaper ala
komputer sekarang dengan
akrabnya mejeng pada layar pon-
sel. Bahkan, kita akan tersenyum
simpul jika melihat skin ala
komputer PC atau Mac tampil
sebagai antarmuka ponsel, selain
tentu saja foto diri si empunya.

Display ponsel
mutakhir sudah bertabur
warna, bahkan untuk
kelas menengah ke
bawah. Kalau dulu ponsel
warna pertama tampil
dengan hanya 256 warna,
maka kini sudah jamak
kalau kita mendapati
tampilan yang
mengandung 65 ribuan
warna (tepatnya 65.536
warna). Tampilan “kelas”
4096 warna juga masih
meramaikan pasar bukan
hanya ponsel kelas
menengah ke bawah,
melainkan juga ponsel-
ponsel kelas atas.
Contohnya: Nokia 3650
masih mengadopsi layar
4096 sebelum “bertobat”
dan meningkatkannya
menjadi 65 ribuan warna
pada versi upgrade 3660-

nya. Samsung merupakan vendor
yang menjadi pelopor di layar 65
ribu warna.

Sedang dari jenis teknologi
layarnya, ponsel yang ada saat ini
mengadopsi satu dari beberapa
teknologi berikut:
• STN (Super Twisted Nematic).

Meski bisa menampilkan 256,
4096, dan 65 ribu warna,
namun layar LCD yang ini
tidak terlalu bagus untuk
menampilkan video. Banyak
digunakan untuk ponsel kelas
low end.

• TFT (Thin Film Transistor).
Sama seperti yang digunakan
pada layar monitor notebook
atau monitor LCD buat PC.
Bisa menampilkan warna
sebanyak 4096, 65.000,
sampai 260.000. Konsumsi
dayanya tinggi namun bisa
menampilkan gambar
bergerak dengan mantap.

• TFD (Thin Film Diode). Mirip
dengan TFT, dengan
keunggulan utama pada
konsumsi daya yang relatif
lebih kecil. Digunakan untuk
menampilkan 65 ribu warna.
Seakan belum puas, layar

ponsel juga “dijembreng” agar
makin lebar dan lega. Bukan
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Zaman telah berubah.
Menikmati alunan

suara nan merdu
jernih mendayu kini

bukanlah perkara sulit
dan jauh dari rumit.

Menonton televisi
yang sesuai dengan

warna aslinya pun
setali tiga uang.

Benarkah demikian?
Bagaimana dengan

harganya? Seperti apa
teknologi terbarunya?

ayangan
televisi dengan
teknologi terbaru,
bahkan menampilkan

warna-warni gambar lebih
indah dari warna aslinya. High
definition television (HDTV)
misalnya, membuat tampilan
terasa lebih istimewa karena
tiada lagi bayang-bayang yang
mengekor di dalam gambar.
Asyiknya lagi, peranti elektronik
dan komputer dijanjikan akan
makin berkolaborasi satu sama
lain.

Dalam event International
Consumer Electronics Show di
Las Vegas, AS, 14 Januari lalu,
Chief Operation Officer (COO)
Intel Corporation Paul Otellini
menegaskan janji itu. Akan ada
upaya memanfaatkan kekuatan
teknologi komputasi di dalam
dunia perangkat consumer
electronics. “Tujuannya adalah
menciptakan produk-produk
yang dapat bekerja bersama-
sama secara sederhana dan
mudah, memberikan
fleksibilitas lebih besar, serta
menawarkan kekuatan dan
kegunaan lebih tinggi bagi
konsumen,” papar Otellini.
Ditambahkan oleh Otellini,
tatkala peranti elektronik dan
konten bergeser dari standar
analog ke digital, semakin besar
peluang untuk mempercepat
peningkatan peranti elektronik
tadi pada sisi kinerja, harga, dan
integrasi fitur-fitur.

Salah satunya terlihat dari
langkah para produsen
perangkat elektronik dunia
dalam mengemas teknologi
high-end pada produk entry-
level mereka. JVC (Japan Victor
Company) misalnya. Perusahaan
elektronika global yang
didirikan di Yokohama, Jepang,
13 September 1927 ini,
menambahkan fitur
pengoptimalan gambar pada
televisi yang digunakan untuk
memutar gambar dari DVD
player. Fitur yang disebut DVD
Component Input ini membuat
kualitas tampilan gambar di
televisi pada saat dipakai untuk
menonton DVD jauh lebih baik
dibandingkan dengan televisi
yang tidak memiliki fitur ini.
Mengapa? Karena JVC membagi
jalur perkabelan khusus menjadi
tiga (red, green, blue) melalui
colokan di sisi belakang televisi.
Pada televisi yang tidak
memiliki fitur ini, kabel input
untuk video biasanya hanya
terdiri satu kabel berwarna

kuning. Nah, kalau dahulu fitur
ini hanya bisa diperoleh pada
televisi berukuran besar,
sekarang ini bahkan televisi JVC
yang berukuran kecilpun sudah
dilengkapi dengan fasilitas ini.

Begitu juga fitur lain seperti
picture in picture (PIP). Kalau
dahulu kita hanya menemukan

fasilitas PIP ini pada televisi
berukuran 29 inci ke atas,
sekarang ini televisi JVC
berukuran 21 inci misalnya, sudah
dilengkapi dengan fasilitas ini.
Dus, fasilitas yang tadinya hanya
ditemukan di peranti-peranti
high-end, kini sudah mulai
dibenamkan pada perangkat
kelas entry level sekalipun,
dengan harga jual yang semakin
terjangkau konsumen.

Kolaborasi antara
perangkat elektronik dengan
komputer tampaknya akan kian
menjadi-jadi lantaran
perusahaan semacam Intel pun
semakin mengimplementasikan
keahliannya dalam bidang
nirkabel dan kemampuannya
sebagai inovator dalam dunia
berbasis silikon untuk
mengembangkan teknologi-
teknologi baru dalam rangka
mengonsumsi dan mengelola
konten digital. Sementara di sisi
lain perusahaan elektronika
terkemuka dunia semacam
Sony, Philips, Panasonic, JVC,
Samsung, Sharp juga kian
mengintegrasikan produk
mereka bersenyawa dengan
semua peralatan digital. Itu
masih ditambah keberadaan
konsorsium berbagai
perusahaan elektronika dan
komputer dunia sejak Juni 2003
lalu ketika membentuk
kelompok kerja yang dinamai
Digital Home Working Group
(DHWG), yang bertugas
mempercepat dan

menyempurnakan kolaborasi
antara PC dan alat-alat
elektronik.

Yang sudah ada
prototipenya adalah apa yang
diupayakan Intel dalam
mengembangkan sebuah peranti
bernama Entertainment PC –
sebuah PC ramping yang

terhubung ke layar televisi.
Televisi? Tentu saja.
Bagaimanapun, hingga saat ini
televisi adalah perangkat
elektronik paling populer di
seluruh kolong jagad ini.
Sementara di sisi lain, televisi
sekarang ini sudah menjadi
makin cerdas, serta dilengkapi

dengan fasilitas yang membuat
penikmatnya merasakan suasana
yang sama sekali lain
dibandingkan dengan menikmati
televisi di tahun 1970-an atau
1980-an. Sebagai sebuah medium
informasi dan hiburan, televisi
belum tergantikan oleh media
jenis lain sehingga mengeks-
plorasi konten maupun teknologi
televisi sendiri tetap relevan bagi
setiap produsen televisi.

Televisi yang diproduksi oleh
JVC misalnya, sekarang ini sudah
dilengkapi dengan ecosensor,
suatu teknologi yang dapat
menyesuaikan antara intensitas
cahaya atau tingkat kecerahan
di layar televisi dengan kondisi
cahaya ruangan. Apa
keuntungannya? “Teknologi
semacam ini membuat mata
penonton televisi lebih nyaman
dan sekaligus memperpanjang
umur tabung televisi,” ujar
Hindrata Lengkey, General
Manager JVC Indonesia. Dari sisi
teknologi, televisi merek tadi
juga dilengkapi dengan fitur
cinema surround, suatu
teknologi suara yang dapat
menghasilkan suara lebih asli
dan seolah-olah kita berada
pada situasi yang sebenarnya.
Sementara, dari sisi audio pun
banyak hal yang bisa dicapai
oleh JVC seperti fasilitas sound
turbo atau rocket start
(teknologi pembacaan CD dalam
waktu kurang lebih 4 detik)

Sebagai gambaran, produk
Entertainment PC, yang juga
menjadi akses poin jaringan
nirkabel, diharapkan akan
tersedia mulai pertengahan
tahun ini, dan diproduksi oleh
para pemanufaktur dan dijual
dengan harga kurang dari
US$800. Teknologi inovatif
lainnya seputar layar display
adalah teknologi kristal cair pada
silikon (Liquid Crystal on Silicon –

LCOS) yang dikembangkan Intel,
di mana ia dirancang untuk
memperbaiki tampilan layar lebar
secara dramatis dengan harga
yang lebih terjangkau. Bernama
sandi Cayley, teknologi ini
diharapkan akan tersedia pada
layar lebar tahun ini juga.
Dengan teknologi ini, produk ini
diharapkan akan turun hingga di
bawah 2000 US$ pada tahun
depan.

Sementara itu bagi
korporasi seperti halnya JVC,
perusahaan di mana Kenjiro
Takanayagi membuat tabung
televisi pertama di dunia,
menurut Indra Bagas Sukma,
Marketing Senior Officer JVC
Indonesia, juga tidak hanya
mengembangkan teknologi
televisi tetapi juga menggeluti
produk lain untuk membuat
kolaborasi digital semakin
mudah. Di tahun 1976 misalnya,
JVC mengeluarkan produk
berseri HR-3300, yang tak lain
merupakan video recorder
berformat VHS pertama di
dunia. Setelah itu, beragam
peranti seperti audio system,
headphones, home theater set,
hingga digital camcorder,
diproduksi oleh JVC membanjiri
pasar di seluruh dunia dan
mencatatkannya sebagai
sebuah brand image global,
sementara di Indonesia produk-
produk tersebut didistribusikan
oleh JVC Indonesia sejak 2 Juni
2000 lalu.

Salah satu yang menarik
dari jajaran produk tersebut
adalah kemampuan DVD Player
JVC dalam membaca kepingan
CD atau DVD yang tergores
atau rusak, yang dinamakan
dragon pick. Di saat player lain
sudah tidak mampu
membacanya, Bagas menjamin
bahwa player JVC masih
mungkin membacanya. Bahkan,
lanjut Bagas, “Di Malaysia, JVC
menawarkan program, apabila
ada konsumen membeli DVD
Player JVC lalu alat itu tidak bisa
membaca suatu CD/DVD
sedangkan di player lain bisa,
JVC akan memberikan DVD
Player tersebut secara cuma-
cuma.” Dan terbukti, promo
semacam ini mendongkrak
penjualan produk secara drastis.
Sayangnya, karena terbentur
ketidakjelasan peraturan di
Indonesia, program tersebut
belum bisa dilaksanakan.

Apabila penetrasi teknologi
terbaru ke dalam produk
berkategori entry level yang
harganya sangat terjangkau
sudah makin jamak, kolaborasi
antara komputer dengan berba-
gai peranti elektronik tersebut
otomatis juga kian intens.
Intensitas tersebut mau tidak
mau membuat persaingan untuk
menawarkan produk yang berku-
alitas dengan harga yang
kompetitif menjadi kian terbuka.

Jadi, berbahagialah para
konsumen dan bersiap-siaplah
belanja barang elektronika
yang akan menemani komputer
Anda di rumah! PC+
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Digital Camcorder menjadi salah satu tulang punggung kolaborasi
digital. Fiturnya kian lengkap, harganya makin oke.

Penjualan perangkat digital makin agresif. Konsumen dituntut jeli
dalam memilih.
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Outlook Express:
Menghapus Arsip di ‘Sent

Items’ secara Otomatis

Mempercepat
ShutDown Windows

Mengidentifikasi Cell yang Berisi Formula
dengan Conditional Formatting

Sebuah survei yang
diadakan oleh suatu media
menyebutkan bahwa Microsoft
Outlook Express merupakan e-
mail client terfavorit yang
paling banyak digunakan oleh
pengguna komputer.
Popularitas ini didukung oleh
tampilan yang begitu sederhana
dan mudah untuk digunakan.
Karena kemudahan dalam
penggunaannya, jadi tak ada
salahnya jika Anda pun ikut
menggunakannya.

Jika Anda telah terbiasa
menggunakan Outlook Express,
tentunya Anda sudah familiar

dengan folder Sent Items yang
terdapat di masing-masing e-mail
account Anda. Folder tersebut
berfungsi untuk menyimpan
berbagai e-mail yang pernah
Anda kirimkan. Selain itu folder
ini juga bisa berfungsi sebagai
arsip Anda, sehingga apabila e-
mail yang Anda kirimkan gagal
terkirim Anda tidak perlu
mengetik ulang e-mail yang
sama. Cukup cari di Sent Items,
kemudian kirimkan kembali.

Dibalik segi positifnya, fitur
ini juga mempunyai sisi negatif.
Apakah itu? Ya, Anda benar,
masalah disk space. Semakin

banyak Anda mengirim e-mail,
tentu semakin banyak juga space
yang dibutuhkan. Apabila Anda
tidak membutuhkan arsip
semacam ini, nonaktifkan opsi
untuk menyimpan e-mail yang
terkirim! Inilah caranya:
1. Klik [Start]>[All

Programs]>[Outlook Ex-
press] untuk menjalankan
program.

2. Setelah window Outlook
Express terbuka, klik menu
[Tools]>[Options…].

3. Pada kotak Options yang
muncul kliklah tab [Send].

4. Carilah checkbox Save copy

of sent messages in the
‘Sent Items’ folder yang
berada di baris pertama di
bagian Sending, kemudian
hilangkan tanda cek di
depannya.

5. Klik [OK] untuk menutup
jendela Options.
Setelah mengikuti langkah di

atas, tidak akan ada lagi
penyimpanan e-mail di Sent
Items dan Anda tidak akan
menemui lagi “jejak” e-mail
yang pernah Anda kirim di
harddisk. Selamat mencoba.

Steven Andy Pascal
steven@e-pcplus.com

Anggap saat ini
Anda membuka banyak
aplikasi sekaligus di Windows.
Kemudian karena suatu hal
Anda ingin men-shutdown
komputer. Tentu tidak praktis
rasanya jika Anda harus
mematikan program-program
yang sedang aktif satu per satu
secara manual baru kemudian
melakukan shutdown. Sebagai
jalan pintas, mungkin Anda
akan langsung mengklik
[Start]>[Turn Off Computer]
untuk mematikan komputer.

Cara di atas memang tidak
salah, tapi “kemalasan” Anda
tadi harus dibayar dengan

waktu shutdown yang lebih
lama. Hal ini disebabkan karena
Windows harus mematikan
semua program yang Anda buka
terlebih dahulu, baru kemudian
melakukan shutdown.

Nah, agar proses shutdown
dengan cara ini bisa berlangsung
lebih cepat, Anda dapat sedikit
mengutak-atik registry. Caranya
adalah sebagai berikut:
1. Klik [Start]>[Run…]

kemudian ketik regedit pada
kolom Open.

2. Masuklah ke subkey My
Computer\HKEY_LOCAL_
MACHINE\System\ Control
Set001\Control.

3. Klik dua kali String Value
bernama
WaitToKillServiceTimeOut
yang berada di bagian kanan
window.

4. Ubah Value Data yang
default-nya bernilai 20000
dengan nilai 100. Angka ini
adalah batas timeout dalam
satuan milidetik. Artinya, jika
dalam waktu 100 milidetik
tidak ada respon, maka
program akan dimatikan
secara “paksa”.

5. Sampai di sini program dapat
diakhiri lebih cepat, tapi
masih ada satu masalah lagi.
Jika program melampaui

batas timeout-nya, biasanya
akan muncul hambatan
berupa kotak dialog yang
“memaksa” Anda mengklik
tombol [End Task]. Untuk itu
Anda dapat mengatasinya
dengan masuk ke subkey My
Computer\HKEY_ CURRENT_
USER\Control
Panel\Desktop\.

6. Pada bagian kanan window-
nya Anda akan menemukan
AutoEndTask. Pastikan
value data Srting Value
tersebut bernilai 1.

7. Tutup Registry Editor
kemudian restart Windows.

Steven Andy Pascal
steven@e-pcplus.com

Pecinta PCplus yang
suka mengolah data dengan
Excel mungkin sering merasa
kerepotan ketika suatu saat
dengan tidak sengaja
menghapus atau menimpa
suatu cell yang didalam
terdapat rumus (formula),
apalagi Anda langsung
menyimpan Workbook
tersebut. Terlambat! Anda
terpaksa harus kembali
mengentri formula pada cell
tersebut. Oke, nggak masalah
kalau formula-nya sederhana,
tapi bagaimana kalau formula
itu terdiri dari fungsi rumit,
misalnya fungsi logika yang
begitu banyak pencabangannya
ditambah dengan fungsi

lainnya, ini akan terasa
memusingkan apalagi Anda
tergolong “cut and paste mania”.

Lalu bagaimana solusinya?
Mudah saja, salah satu cara untuk
mengatasi hal di atas adalah
dengan mengaktifkan proteksi
pada cell yang berisi formula itu,
tapi cara ini akan bermasalah
ketika Anda harus kembali
menyunting ulang formula pada
cell yang bersangkutan Anda
harus kembali menonaktifkan
proteksi cell solusi lainnya yaitu
dengan memberi tanda khusus
pada setiap cell yang
mengandung formula. Caranya?
Ikuti langkah berikut:
1. Dalam worksheet, klik

[Insert]>[Name]>[Define].

2. Dalam kotak dialog Define
Name, ketik pada kotak
Names in Workbook.
Sel_Punya_Rumus  (ini
dapat diubah sesuai
keinginan)

3. Masukkan rumus berikut
kotak Refers to: =GET.CELL
(48;INDIRECT(“rc”,FALSE))

4. Klik [Add]>[OK].
5. Kemudian blok seluruh sel

dalam range kerja Anda,
kemudian klik
[Format]>[Conditional
Formatting].

6. Dalam kotak Conditional
Formatting, pilih Formula Is
yang terletak di bawah
Condition 1, lalu masukkan
rumus berikut di sebelahnya:

=Sel_Punya_Rumus
7. Lalu klik [Format] dan

sesuaikan format sel yang
berisi rumus sesuai dengan
keinginan Anda, misalnya klik
[Pattern] pilih warna hijau

muda lalu klik [OK] dan
[OK] sekali lagi (perubahan
dapat diterapkan pada,
border dan warna latar sel).
Jika Anda benar dalam
mengikuti semua langkah di
atas, maka setiap sel yang
berisi rumus akan ditandai
dengan warna hijau muda.
Selamat mencoba.

Budiman
ibnu_78@yahoo.com
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Kalau Data Harddisk Hilang:
Recovery Data dengan Active@ Partition

Recovery
Kehilangan data
mungkin merupakan
malapetaka terbesar pengguna
komputer. Pekerjaan yang telah
dilakukan berhari-hari (bahkan
berbulan-bulan) dapat hilang
begitu saja dalam sepersekian
detik. Pada harddisk (HD), data
dapat hilang oleh sebab
pengguna yang tidak sengaja
menghapus partisi, aktivitas
virus, dan struktur logikal HD
rusak (corrupt).

Active@ Partition Recov-
ery (APR), adalah salah satu
software yang mampu me-

recovery data yang hilang
tersebut. Spesifikasi komputer
minimal untuk menjalankannya
sangat sederhana, yaitu prosessor
286, memori 640 KB, disk-drive,
monitor EGA resolusi 640 x 480,
disket booting MS-DOS beserta
aplikasi APR di dalamnya, dan
tentu saja HD yang akan
diperbaiki. Sementara
kemampuannya mencakup partisi
FAT dan NTFS.

APR bekerja dalam mode
DOS, dan beroperasi melalui
disket. Untuk menggunakannya,
pertama-tama buat disket

booting MS-DOS (pada MS-DOS
atau Command-Prompt Windows
9X, ketik format a: /s)  dan copy-
kan APR (download melalui
http://www.partition-
recovery.com) pada disket
tersebut. Serta booting komputer
melalui disket tersebut.
Kemudian:

1. Ketikan PR.EXE pada DOS-
prompt, hingga APR-window
muncul.
Bagian kiri window adalah
daftar HD pada komputer dan
disebelah kanan informasi

mengenainya. Gunakan
panah atas dan bawah untuk
berpindah antar-item di
window kiri (kursor-sorot
berpindah). Jika pada HD
yang akan diperbaiki terdapat
tulisan Unknown berarti
partisi rusak (biasanya akibat
virus). Ulangi langkah satu
dan ketikan PR.EXE -
ignoreMBR=80h maka akan
muncul tulisan Unallocated.

2. Untuk mencari data yang
hilang, gerakan kursor-sorot
(dengan panah) pada kata
Unallocated dan tekan

[Enter], APR akan
melakukan scanning
(Gambar 1) dan jika partisi
ditemukan akan terlihat
laporan (Gambar 2).

3. Tekan [Y].
4. Letakkan kursor-sorot pada

partisi yang baru ditemukan
dan tekan [Enter] (Gambar
3).

5. Tekan [Esc] hingga muncul
konfirmasi (Gambar 4)
kemudian tekan [Y] untuk
menyimpan data tersebut.

6. Jika pada HD tidak terdapat
partisi aktif, maka akan
muncul pilihan untuk
menjadikan salah satu partisi
sebagai partisi aktif
(Gambar 5) pilih salah satu
dan tekan [Enter].

7. Muncul pertanyaan untuk
mem-back-up MBR, tekan [Y]
jika ingin mem-back-up dan
tekan [N] jika tidak.

8. Recovery selesai dan press
any key to restart...

Syarafuddin
syarafuddin@yahoo.com

Gambar 1

Gambar 2

Gambar 3

Gambar 4

Menyembunyikan Pesan
Status Logoff dan Shutdown

Pada Windows XP
ketika kita logoff ataupun
shut-down, kita akan melihat
suatu pesan status apakah kita
sedang logoff ataupun
shutdown. Bila Anda merasa
terganggu dengan pesan
status ini, cobalah
menyembunyikannya dengan
manipulasi registry berikut ini.
1. Jalankan Registry Editor

yaitu dengan mengetikkan
regedit pada [Start]>[Run].

2. Masuklah ke key
HKEY_LOCAL_MACHINE\
SOFTWAR E\Microsoft\

Windows\ CurrentVersion\
policies\system.

3. Buatlah data DWORD dengan
nama
DisableStatusMessages.

4. Klik ganda data tersebut kemu-
dian isikan nilainya dengan 1.
Restart Windows untuk

melihat hasilnya. Untuk
mengembalikan ke semula, Anda
cukup menggantikan nilainya
dari 1 menjadi 0 atau menghapus
data DWORD tersebut.

Rizki Kurniawan
rizki.kurniawan.132@students.itb.ac.id
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Kiat Membasmi
My Heart dan Hallo.Roro

Alfons Tanujaya
alfons@vaksin.com

A

Tak hanya flu burung
yang sedang

meresahkan kita.
Virus lama pun

ternyata masih bikin
reseh. Nah, dari

sekian program virus
removal, program apa

yang paling banyak
diminta oleh netter

Indonesia sepanjang
bulan Januari 2004?
Apakah Bagle yang

baru muncul, Blaster,
atau varian Redlof?

nda akan
terkejut
mendengar
jawabannya bahwa

bukan virus Top 10 yang dicari
tools-nya, melainkan satu virus
lokal yang penyebarannya
ternyata sampai ke seluruh
pelosok Nusantara, Pesin. Virus
Pesin yang menciptakan file
Myheart.exe di komputer
korbannya ternyata masih sa-
ngat sulit diberantas. Salah satu
sebabnya adalah karena ke-
mampuannya untuk mengunci
keyboard dan mouse setiap kali
komputer korbannya menjalan-
kan regedit. (Gambar 1)

Salah satunya adalah Joni
(nama sebenarnya) di
joni**@telkom.net, yang
bersama dengan temannya
rame-rame menjadi korban dua
virus lokal sekaligus, Pesin dan
Redro. Trojan Redro akan
menampilkan tulisan Hallo Roro
setiap kali komputernya
digunakan dan setiap jam 10.00

malam komputer akan otomatis
dimatikan. Sedangkan Pesin akan
memblok akses registri untuk
mencederai keyboard dan mouse
setiap kali komputer menjalan-
kan Registry Editor (regedit).

Sebenarnya Redro
mengandung aksi yang cukup
jahat untuk menghapus
direktori Program Files dan
direktori Windows, namun
karena adanya bug dalam kode
tersebut aksi tersebut tidak
dijalankan oleh virus.
Sebenarnya cukup mudah
mengatasi Redro, yakni dengan

menghapus file “systask.exe”
pada c:\windows\system32
(Windows XP) dan “sysmng.exe”
(Windows 98). Sedangkan
menghadapi Pesin secara manual
cukup merepotkan karena seperti
diutarakan di atas, Pesin
melakukan aksi memblok akses ke
registry editor sehingga setiap kali
kita menjalankan regedit, semua
aktivitas keyboard dan mouse
menjadi lumpuh.

MENYEBAR LEWAT
JARINGAN

Satu hal yang cukup menarik
adalah worm Pesin yang berhasil
menginfeksi komputer yang
terhubung pada jaringan akan
“berusaha” untuk menyebarkan
dirinya ke jaringan dengan cara
mengopikan dirinya ke semua
drive yang di-share pada jaringan
dengan nama: My Love.exe,
Kenangan.exe, Hallo.exe, Puisi
Cinta.exe, My Heart.exe, Jangan
Dibuka.exe, Mistery.exe.

Tidak seperti Funlove yang
akan mengusahakan dirinya
berjalan secara otomatis pada
komputer jaringan dengan
menginfeksi file PE (Portable
Executable) sehingga dijalankan
oleh sistem Windows atau Redlof
yang akan berjalan secara
otomatis karena memanfaatkan

celah keamanan MS Virtual
Machine. Pesin bersifat pasif dan
selama user komputer korban di
jaringan tidak “gatal” mengklik
file yang baru dikopikan terse-
but, Pesin tidak akan menginfeksi
komputernya sehingga
kemampuan infeksi Pesin pada
komputer jaringan tidak perlu
terlalu dikhawatirkan. Hal ini
terlihat dari statistik yang kami
dapatkan pada seluruh infeksi
Pesin yang dilaporkan, di mana
100 % infeksi yang terjadi adalah
pada file di disket dan bukan di
komputer jaringan. (Gambar 2)

Fakta menunjukkan bahwa My Heart betul-betul membuat kelabakan para
pengguna komputer di seluruh negeri.

Semua infeksi virus terjadi melalui disket dan
bukan jaringan.

Program aplikasi AntiMyHeart
yang dibuat oleh mahasiswa salah
satu sekolah tinggi komputer.
Cukup efektif!

fscommand/
norman_virus_control_eng.exe
dan bersihkan semua file yang
terdeteksi sebagai
Worm:Pesin.A.

Bersihkan registri yang
dirubah oleh Pesin dengan cara
(jangan lupa back up dahulu
registri Anda, segala kesalahan
dalam mengubah registri yang

menyebabkan
kerusakan OS
menjadi tanggung
jawab Anda.
• Jalankan

registry editor
dengan cara
[Start][Run]
ketik Regedit
dan tekan
[Enter] Anda
akan
mendapatkan
menu Registry
Editor.

• Masuk ke
registri:
HKEY_LOCAL_
MACHINE\

Software\
Microsoft\Windows\
Current Version\
Run dan pada
kolom kanan hapus
registri "LoadS
ervice"="%System%

\ SysTask.exe /
run" dengan cara
klik kanan dan pilih

delete.
• Simpan kembali registri

Anda dan restart komputer.

TOOLS PESIN DAN RORO
Jika Anda kesulitan untuk

melakukan hal tersebut di atas,
ada satu tool yang tersedia di
Internet dengan nama
“AntiMyHeart” yang dapat di-
download di http://igm.ac.id/
files/AntiMyHeart.zip atau
ftp://ftp.cbn.net.id/Vaksin/fix-
tools/MyHeart/
anti_myheart.zip. (Gambar
3). Tools ini diklaim oleh pem-
buatnya dapat membasmi
semua versi Pesin dan Roro dan
menurut pengetesan yang di-
lakukan oleh korban Pesin yang
melaporkan ke Vaksincom, tools
ini cukup efektif dan mudah
digunakan dalam membasmi
Pesin, di mana semua proses
seperti penghapusan file dan
perubahan registri akan dilaku-
kan secara otomatis oleh tools
ini. Satu catatan yang perlu di-
ketahui jika Anda menggunakan
AntiMyHeart adalah tools ini
akan mengubah registri Anda
dengan menambahkan pada:
[HKEY_LOCAL_MACHINE\SOFTWARE
\Microsoft\Windows\CurrentVersion]
"RegisteredOrganization"="Junior
Software"
"RegisteredOwner"="STMIK
IGM" PC+

RECOVER FILE YANG
HILANG KARENA PESIN

Salah satu informasi
tambahan yang kami dapatkan
dari para korban Pesin adalah
sebagai berikut:

Selain dalam format Word,
Pesin dengan cerdik memalsukan
dirinya sesuai dengan file asli
milik kita (contoh: "Laporan
Akhir") sehingga kita
terjebak untuk membuka
file virus tersebut,
sedangkan file asli milik
kita yang berisi data-data
direname menjadi
"~Temp45". Nama file
asli selalu terganti seperti
itu dan untuk orang
awam tentu mengira
bahwa itu adalah file
temporary word dan
biasanya dihapus.
Walhasil semua hasil
kerja jadi hilang, kalau
tidak hati-hati semua file
bisa lenyap seketika
karena virus tersebut
(akibat tidak langsung).

Sebelum saya
menemukan antivirus
yang bisa melenyapkan
virus menyebalkan itu,
satu-satunya cara
mendeteksi hanyalah
ketika akan membuka

file di
window
explorer,
setting view files
saya set Details agar
terlihat jelas format
file serta besarnya
kapasitas file. Virus
Pesin ini selalu mun-
cul dalam bentuk
Application dan be-
sarnya selalu 256Kb.
Kalau file virus
dihapus, dia akan
muncul lagi bahkan
"berkembang biak".

Cara lain untuk
me-recover file yang
dihapus oleh Pesin
adalah
menggunakan
software Data
Recovery seperti
Get Back atau
Ontrack Easy

Recovery.

CARA MANUAL
REMOVE PESIN

Salah satu cara yang
sangat efektif untuk
menghadapi keyboard dan
mouse yang dikunci oleh Pesin
adalah dengan menghentikan
proses Pesin di komputer
Anda. Tekan [Ctrl] [Shift]
[Esc] (Win NT / 2000 / XP) dan
matikan proses “SysTask.exe”
setelah itu baru masuk ke regedit
untuk menghapus registri yang
ditambahkan oleh Pesin.

Untuk Win 98, tidak ada
akses untuk memonitor proses
sehingga memerlukan tools/
software khusus Process Explorer
dari Sysinternal yang dapat di-
download secara gratis di
http://www.sysinternals.com/
ntw2k/freeware/
procexp.shtml. Jika Anda tidak
memiliki Process Explorer,

alternatif lain yang dapat
digunakan adalah mengakses
Windows melalui Safe Mode di
mana pada mode ini proses Pesin
di latar belakang tidak akan
dijalankan oleh Windows
sehingga Anda dapat men-
jalankan regedit. Cara mengakses
Safe Mode dari pada windows 98
adalah menekan tombol [F5]
berulang-ulang pada saat menya-
lakan komputer pertama kali.

Setelah menghentikan
proses Pesin, scan komputer
dengan program antivirus yang
ter-update dan telah dapat

mengenali Pesin, kami
menggunakan Norman Virus
Control yang dapat di download
di ftp://ftp.cbn.net.id/Vaksin/
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Azies Ardiansyah
azies@telkom.com

D

Saat ini, rata-rata
ukuran harddisk yang

digunakan
pada komputer-
komputer baru

adalah 20GB ke atas.
Tetapi umumnya,

belum sepenuhnya
kapasitas harddisk

yang tersedia
digunakan oleh user

untuk menyimpan
file.

i sisi lain, saat
ini banyak aplikasi
(terutama game) yang
membutuhkan CD

instalasinya tetap berada dalam
drive optik agar dapat berjalan.
Untuk menghemat life-time
drive optik, kita dapat me-
manfaatkan sebagian kapasitas
harddisk yang tidak terpakai tadi
untuk sebuah virtual drive.

Lebih luasnya, virtual drive
yang dimaksud dalam hal ini
adalah memanfaatkan drive let-
ter (misalnya D:\ sampai Z:\) atau
yang tidak terpakai untuk di aso-
siasikan ke suatu alamat folder
(path) dalam harddisk, floppy
disk bahkan CD-ROM drive (jika
sistem operasi yang digunakan
adalah bagian dari keluarga
Windows NT, seperti Windows
2000 dan Windows XP).

Jadi, letak folder tersebut
secara fisik tidak diubah tetapi
hanya dibuat aliasnya saja.
Mirip dengan shortcut. Cara ini
sangat bermanfaat bila kita
mempunyai suatu folder yang
berisi file atau folder yang
sering kita gunakan, tetapi
letaknya jauh di dalam sub-sub
folder.

BAGAIMANA
MEMBUATNYA?

Ada dua cara pembuatan
virtual drive. Dengan
menggunakan perintah bawaan
sejak jaman DOS yaitu SUBST
ataupun menggunakan software
third party seperti Virtual Drive
Creator.

Cara pembuatan virtual drive
dengan menggunakan perintah
bawaan DOS yaitu SUBST File-nya
terdapat di folder
C:\Windows\Command untuk
windows 9x dan di folder
C:\Windows\system32 untuk
windows NT/2000/Xp, dengan
nama SUBST.EXE.

Adapun parameternya
sebagai berikut :

SUBST [drive1: [drive2:]path]
SUBST drive1: /D

drive1 : Virtual drive yang
akan diasosiasikan ke
suatu path.

[drive2:]
path : Physical drive dan

path yang akan
diasosiasikan ke `
sebuah virtual drive.

/D : Menghapus virtual
drive.

Jika Anda ingin melihat
daftar virtual drive yang aktif
pada harddisk, ketik SUBST
tanpa parameter.

Contoh :
Membuat virtual drive:
SUBST Z:
C:\Dataku\Files\Document\
Penting\Penting Sekali\Zip

Menghapus virtual drive:
SUBST Z: /D

Bila Anda merasa langkah
tersebut cukup menyita waktu
karena harus mengetik
perintah di atas berulang-ulang
setiap kali Anda akan membuat
virtual drive, Anda bisa
memasukkan perintah-perintah
tersebut dalam suatu file batch.

Caranya, buka Notepad atau
editor teks favorit Anda
lainnya.

Kemudian masukkan
perintah-perintah tersebut di
atas (dalam hal ini sesuaikan
dengan kebutuhan Anda),
kemudian simpan file tersebut
dan jangan lupa, ekstensinya
harus .bat.

Kalau Anda rasa masih
kurang simple, Anda bisa
menggunakan utiliti freeware
Virtual Drive Creator dari J.A.
Associates untuk membuat virtual
drive seperti yang diterangkan di
atas. Teknisnya sama, utiliti ini
juga menggunakan perintah DOS
SUBST.

Langkah-langkah dalam
membuat virtual drive sebagai
berikut :
1. Pilih huruf yang ada di

daftar “Available Virtual
Drive Letters”. Misal “L:”

2. Kemudian masukkan
alamat folder yang akan di
set ke dalam box “Full
path:”, atau bisa juga
dengan memilihnya
menggunakan daftar Drive
dan Folder. Misalkan :
“e:\Libraries”.

3. Klik [Add Virtual Drive]
atau klik kiri dua kali pada
huruf yang tadi dipilih di
daftar “Available Virtual
Drive Letters”. Kotak dialog
“Operation Completed”
akan muncul jika operasi
berhasil.

4. Untuk memastikan buka
Windows Explorer, My
Computer, dan sekarang
sudah muncul drive baru
“L:”.

Untuk menghapus virtual
drive Anda cukup memilih huruf
yang ada di daftar “Virtual
Drive Letters in Use” kemudian
klik “[Remove Virtual Drive]”
atau klik dua kali huruf tersebut
di daftar “Virtual Drive Letters
in Use”.

Utiliti ini bisa di-down-
load di www.j-a-associa-
tes.com, besarnya sekitar
1,871 KB. Terdapat juga versi
Pro-nya. PC+

Memanfaatkan Kapasitas
Terluang pada Harddisk untuk Virtual Drive
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Menikmati
Aquarium di PC

Pantau Perubahan
Registry

Registry Monitor

Aquatica Waterworlds

Desktop nan Rapi
Blackbox

Anda kepingin punya
akuarium di rumah? Jangan
beli, karena sekarang ada
screensaver yang bisa membuat
PC Anda jadi akuarium, lengkap
dengan bunga karang, gelem-
bung udara, dan ikan-ikan yang
berenang. Sangat indah, tak
kalah dengan akuarium asli.
Pun, mengurusnya tidak repot.

Akuarium itu memiliki nama
Aquatica Waterworlds. Kalau
Anda berminat silakan peroleh
evaluation copy versi 3.61c di
www.clubaquatica.com. Anda
akan mendapatkan file setup
bernama aq_scr.exe berukuran
4.731KB.

Ada 5 pilihan menu setting
di program screen saver ini.
Masing-masing adalah sebagai
berikut.

1. General. Di sini Anda bisa
mengenal program ini lebih
baik, bisa juga menampilkan
kalender di akuarium digital
Anda.

2. Message. Anda bisa
tambahkan pesan pribadi di
screen saver ini dengan
mengisi Personal Message.
Warna font-nya bisa diganti-
ganti. Ada juga pilihan System
Message dan Network
Message. Jika komputer Anda
stand alone, maka abaikan
saja pilihan ini.

3. Fish. Di menu ini Anda bisa
memilih ikan-ikan yang akan
ditampilkan di layar monitor.
Anda bisa pilih salah satu,
beberapa, atau bahkan
semua. Tekanlah tombol
[Preview] untuk melihat

perubahan yang terjadi
berdasarkan pilihan Anda.

4. Scenery. Yaitu pilihan
background alias dasar
akuarium. Evaluation copy ini
hanya menyediakan 2 scenes
yang bisa dipilih. Anda bisa
menambahkan scenes dan
jenis ikan di versi
registrasinya.

5. Sound. Di sini ada 2 pilihan
lagi yaitu Play Music atau Play
Sound Effect. Di pilihan Play
Music, Anda bisa setting
musik yang akan dimainkan.
Musik itu bisa berasal dari
audio CD, WAV, atau MP3.
Sedikit catatan, file MP3 yang
digunakan tidak berukuran
lebih dari 1.3 MB. Namun

ternyata,  Aquatica
Waterworld tetap berjalan
dengan baik ketika penulis
mencoba dengan file MP3
sebesar 4.0 MB.
Selamat mencoba.

Anang Firman Arnowo
anang.firman@ukonline.co.uk

Gambar 1

Gambar 2

Dengan mengedit
registry, kita dapat
melakukan modifikasi terhadap
software tertentu atau bahkan
Windows. Kita sering
menjumpai tweaker yang dapat
mengedit registry. Sebenarnya
dari mana mereka mengetahui
registry yang mana yang telah
diubah? Juga, registry yang
mana yang diubah ketika suatu
proses dijalankan? Semua
sebenarnya bisa diketahui
apabila kita menggunakan
software yang dapat memantau
perubahan registry.

Salah satu software yang
dapat Anda coba adalah
Registry Monitor yang sering
disingkat menjadi Regmon.
Software gratisan ini dapat
dicari di www.sysinternals.com.

Software ini akan memantau
semua aktivitas software yang
berkaitan dengan registry. Hasil
pantauannya menampilkan
software apa yang melakukan,
jenis request, lokasi registry yang
diproses, hasil, dan nilainya.

Apa yang bisa kita dapatkan
dengan memantau perubahan
registry? Banyak yang dapat kita
peroleh, contohnya rahasia
Windows, rahasia software
tweaker, dan terkadang rahasia
proteksi shareware.

Cara menggunakannya
mudah. Ada dua shortcut yang
sebaiknya kita hafal, yaitu
[CTRL]+[E] untuk menghentikan
pemantauan, dan [CTRL]+[X]
untuk meng-clear pemantauan.
Hanya itu modal Anda.

Berikut ini adalah Contoh

penggunaan Regmon.
Kita akan memantau apa
yang terjadi pada registry
ketika Windows Explorer
dijalankan.
1. Jalankan Regmon dan

pastikan ia aktif
memantau.

2. Jalankan Windows
Explorer.

3. Kembali ke Regmon
dan tekan [CTRL]+[E]
untuk menghentikan
pemantauan.

4. Carilah jenis pemroses
explorer.exe dan
temukan hal yang
menarik.

Sangat mudah bukan? Bila
Anda mengklik ganda
atau menekan [Enter],
maka Registry Editor akan

terbuka dan langsung menuju
ke key/data yang dipilih.
Software ini hanya

berukuran 188KB dan tentunya
dapat dimuat dalam satu disket,
dan dapat dicoba ke komputer
lain. Software ini dapat

digunakan pada Win 95/98/Me/
NT/2000/XP. Download-lah
sesuai dengan versi Windows
Anda. Selamat mencoba.

Rizki Kurniawan
rizki.kurniawan.132@students.itb.ac.id

Penggemar Linux
mungkin sudah tidak asing
dengan Blackbox yang merupa-
kan salah satu GUI Graphical
User Interface). Keunggulan
Blackbox adalah kemampuan-
nya untuk mendapatkan
desktop background yang rapi
dan bersih dari ikon-ikon.

Blackbox ternyata dibuat
juga untuk Windows. Dengan de-
mikian, interface Windows dapat
diganti dengan interface

Blackbox. Versi Windows ini dapat
diperoleh dari http://
sourceforge.net/projects/
blackboxwm/.  Kalau tak ada aral
melintang, proses download bisa
berjalan cepat karena ukuran file
instalasi Blackbox hanya 165KB.
Jangan lupa untuk men-download
juga style-nya di http://
www.desktopian.org/bb/.
Setelah di-download dan dijalan-
kan, akan terlihat betapa rapinya
desktop. Style untuk Blackbox, agar

dapat digunakan, harus diletakkan
satu folder dengan Blackbox.

Agar Blackbox berjalan
setiap kali Windows dijalankan,
tambahkan shortcut Blackbox
pada startup di Start Menu. Ber-
bagai aplikasi dapat dijalankan
hanya dengan Xoblite yang mun-
cul apabila klik kanan dilakukan
pada desktop.

Program blackbox merupa-
kan program opensource dan
gratis. Dengan demikian, Black-
box dapat dimodifikasi oleh
penggunanya.

Anton Hermawan
gigabit_x@yahoo.com.sg



plusDownload

| 15

V • 27 Januari - 02 Februari 2004
PCplus 160

Mata-mata Pengenal Warna
Pixie

Windows
Explorer Alternatif

Power Desk

Windows Explorer
bawaan Microsoft Windows
sangat minim fungsinya. Perlu
berbagai macam plugin untuk
memaksimalkan Windows
Explorer. Karena alasan itu kita
patut mencoba alternatif lain,
yaitu Power Desk. Sebagai
program yang berfungsi sebagai
penjelajah isi komputer,
software ini memiliki
fungsi tambahan yang
sangat banyak.

Power Desk dapat
menampilkan jendela
explorer dengan dua
panel. Posisinya pada layar
dapat kita atur. Jika kita
nyaman dengan posisi
vertikal, maka aturlah
demikian. Begitu pula bila
kita merasa cocok dengan
posisi horizontal.

Toolbar Power Desk
memiliki ikon-ikon Internet
Explorer, File Finder, MS-
DOS Prompt, Registry
Editor, Windows Update,
dan Notepad. Makanya,
jika kita ingin mengubah
registry, maka kita hanya
perlu mengklik ikon
Registry Editor.

Sering kali saya mengalami kesulitan untuk mencontoh warna yang ada di layar monitor untuk warna di situs Web saya. Setelah saya
berkelana mencari program, akhirnya saya menemukan Pixie, sebuah program yang sangat kecil dan simpel untuk memudahkan saya mencari
warna-warna yang sedang ditampilkan layar monitor.

Pixie yang merupakan freeware gratis, bisa di-download di www.nattyware.com/bin/pixie.zip yang ukuran file-nya hanya 62KB.
Setelah proses download selesai, lakukan langkah instalasi, kemudian jalankan Pixie.

Penggunaannya sangat mudah. Tunjuk  warna apa saja yang ada di monitor dengan menggunakan pointer mouse, Pixie akan
memberitahukan menampilkan angka-angka yang menunjukkan RGB, HEX, HTML, CMYK, dan HSV.

Misalkan, jika saya menunjuk taskbar Windows XP yang, maka yang akan saya dapatkan adalah angka:
HEX : 0xDD6126
HTML: #2661DD
RGB : 38,97,221
CMYK : 72,49,0,14
HSV : 220,83,87

Setelah saya mengetahui angka-angka tersebut, saya meng-copy-nya ke software Web editor. Saya juga menggunakannya pada software-
software pengolah gambar. Dengan demikian, saya mendapatkan warna yang benar-benar saya inginkan.

Anton Hermawan
gigabit_x@yahoo.com.sg

Tidak hanya itu, jika anda
klik [Tools] pada menu bar, maka
kita akan mendapatkan sejumlah
menu yang berguna. Menu-menu
tersebut di antaranya adalah Find
File, Recycle Bin, Compare
Folders, Erase Diskette, Copy Disk,
Label Disk, Format Disk, Create
Rescue/Startup Disk, Add Re-
move/Program, Map Network

Drive, Unmap Network Drive, dan
Open DOS Window.

Kalau kita tidak suka dengan
beberapa ikon yang terdapat
pada toolbar, kita dapat
mengurangi atau mengganti
dengan yang lain.

Untuk itu, klik [Options]
pada menu bar, dan pilih [Cus-
tomize Toolbar]. Kalau kita ingin

menambah shortcut program
favorit, pilih
[Options]>[Customize
Launchbar].

Yang membuat Power Desk
lebih berguna adalah fungsi
tambahannya yang mampu
membuat file ZIP. Klik saja
[Archive]>[Zip] pada menu bar
untuk melakukan kompresi.
Selain itu yang membuat
program ini makin canggih lagi
dengan kemampuannya untuk
mengenkripsi dan mendekripsi
file atau folder.

Power Desk dapat di-
download di www.v-
com.com/pd_ind.html
dengan ukuran 1.652 KB.

Tetapi jika Power Desk
versi gratis tidak dapat
memuaskan, maka versi
pronya bisa di-download.
Hanya saja, tidak gratis.

Kelebihan dari versi
pronya yaitu dapat di-
minimize ke system tray,
mampu mengubah warna
ikon folder, mengubah
format image dari satu
format ke format lain,
memainkan MP3 tanpa
software tambahan,
tombol Print Screen,
menampilkan waktu dari
berbagi zona waktu, CPU
monitor, mengetahui
dengan cepat besar space
dari sebuah folder, dan
Easy FTP.

Fadlan Setiaji
aji-edl@plasa.com
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PDA untuk Kerja,
PDA yang Punya

Unjuk Kerja Oke Punya!

Alois Wisnuhardana
wisnu@e-pcplus.com

S

Barusan, si Ciplus pulang dari rumah Febi dan Senu. Di sana, ia terkagum-kagum melihat
kedua rekannya yang sudah mahir menggunakan Personal Digital Assistant. “Ngomong-ngomong, perangkat
itu pakai sistem operasi apa ya di dalamnya?”, pikir si Ciplus dalam hati. Tolong dong si Ciplus, sebutkan
dua sistem operasi yang umum digunakan pada PDA. Tuliskan jawaban tersebut di sehelai kartu pos
dengan disertai empat buah kupon kuis Ciplus-Acer edisi 160 sampai 163. Cantumkan juga alamat
yang jelas dan jangan menunda-nunda, karena jawaban sudah harus masuk ke meja Redaksi PCplus paling
lambat tanggal 24 Februari 2004. PCplus akan memberikan 1 unit PDA n10 ACER, 2 unit MP3 Player (128
MB)ACER dan  5 buah kaos PCplus pemenang bagi yang menjawab dengan benar dan beruntung!
Buruan!!! Hadiah akan dikirim langsung ke alamat pemenang. Pemenang yang beruntung akan diumumkan di
PCplus edisi 166 (9 Maret 2004).

KUIS Ciplus - AcerKUIS Ciplus - Acer
Pemenang Kuis Edisi 156/III/2002:

HADIAH SOUVENIR PCplus

1. Wahyu Hidayat
Jl. Sukasari 2 No.26 01/02
Bandung 40134

2. Masruri
Jl. Tulip 3/5 Graha Tirto Asri
Pekalongan

3. Ipuk Hendratmaka
Samirono, CT VI/109
Depok, Sleman Yogyakarta 55281

4. Windari Handayani
Jl. Semanan Pintu Air No.17
Rt.008/012 Kel.Duri Kosambi
Cengkareng Jakarta Barat 11750

5. Muslim Yusuf
Jl. 23 Januari No.80 Dulomo - Telaga
Gorontalo 96181

Jawaban Kuis No. 156/III/2002:
FX5900, Ti4600, Ti4200, FX5200, MX440.

PDA tak cuma buat
gaya. Tapi, ternyata

kalau tak cermat
mengenalinya, salah-

salah kita
menggunakannya

sekadar hangat-
hangat tahi ayam.

eperti apa
sebenarnya orang
menggunakan PDA
untuk bekerja? Sejauh

mana ia bermanfaat untuk kita?
Bagaimana kiatnya supaya kita
bisa memanfaatkannya secara
maksimal? Simak yang berikut
ini. Budiono Darsono, Pemimpin
Redaksi Detikcom, mengaku
betul-betul terbantu oleh
PDAnya sewaktu libur panjang
Lebaran lalu. Sembari mengecek
situs berita yang dipimpinnya, ia
masih bisa membaca dan mem-
balas e-mail-e-mail penting se-
segera mungkin. Dan itu semua
dilakukannya ketika berada nun
jauh dari kantornya di Jakarta.
Ia saat itu berada di perjalanan
menyusuri Pantura bersama
keluarganya. PDA bermerek O2
XDA II menemani perjalanan
liburnya, tanpa ia harus
khawatir akan ketinggalan
informasi penting atau bakal
kerepotan mengoordinasikan
pekerjaan-pekerjaan dan
tanggung jawabnya sebagai
penyedia informasi terpercaya.

Beda lagi dengan Andreas
Diantoro, salah satu direktur di
perusahaan multinasional
Hewlett-Packard. Ia sengaja tak
menyatukan PDA-nya dengan
ponsel. “Kadang-kadang, saya
butuh pergi ke mana-mana tan-
pa harus ditemani PDA karena
ingin melepaskan rutinitas pe-
kerjaan, sedangkan ponsel te-
tap harus dibawa ke mana-
mana, juga waktu libur Sabtu
Minggu, karena ponsel ini tetap
penting meskipun libur”ujarnya
suatu ketika. Makanya, ia belum
tertarik untuk menggunakan
PDA yang sudah dilengkapi
dengan fasilitas ponsel. Selama
ini ia masih setia dengan HP
iPAQ 1910-nya, dan dalam

waktu dekat merencanakan
untuk beralih ke HP iPAQ 4150.

Sementara, Ari Kunwidodo,
vice president Microsoft Indone-
sia, lain lagi. Sejak akhir 2002
lalu, ia sudah menggunakan PDA
bermerek O2 XDA. Sempat
mencoba smartphone, kemudian
ia meninggalkannya dan
kemudian beralih ke O2 XDA II
begitu produk ini dirilis. Ia
mengaku sangat terbantu
pekerjaannya dengan
adanya PDA. “Apalagi, voice
command-nya canggih.
Nggak cuma bisa meng-
aktifkan panggilan telepon
ke nomor seseorang tetapi
juga bisa digunakan untuk
mengaktifkan aplikasi, meli-
rik appointment berikutnya,
termasuk juga voice com-
mand untuk mengaktifkan
Windows Media Player,”
ujarnya kepada PCplus. Ia
menjejali PDA-nya dengan
beragam program aplikasi,
tetapi yang paling sering ia
gunakan antara lain adalah
Outlook, koneksi Internet,
atau aplikasi entertainment.
“Saya juga memerlukan fitur
triband di PDA saya karena
kalau lagi berada di US, saya
membutuhkan fasilitas ini,”
tambah Ari.

Ketiga pengguna PDA
ini secara tak langsung me-
ngirim pesan penting kepada kita
semua yang belum tergerak un-
tuk menggunakannya, atau kita
yang sudah menggunakan PDA
tetapi sebatas untuk membuat
janji atau mencatat alamat relasi.
Dua urusan terakhir ini, sebenar-
nya bahkan sudah bisa
dituntaskan bila Anda
memanfaatkan fasilitas yang ada
di dalam ponsel Anda.

KAPAN?
Lalu, kapan kita boleh memu-

tuskan untuk menggunakannya?

Kalau Anda benar-benar orang
yang cukup mobile dan menggu-
nakan waktu dalam perjalanan
Anda untuk melakukan sesuatu
yang produktif atau menghibur.
Tidak sekadar baca buku, koran,
majalah, atau ngobrol ke sana-sini.

Lalu, kapan kita dianggap
cukup mobile sehingga memer-
lukannya? Ketika Anda berpin-
dah dari satu tempat ke tempat
lain sembari menenteng

pekerjaan kantor atau menyele-
saikan urusan-urusan kantor.
Contoh paling kongkret adalah
Budiono tadi.

Lalu, apakah harus menjadi
seperti Budiono, Andreas, atau
Ari terlebih dahulu untuk pantas
menenteng PDA? Tentu tidak!
Bahkan, apabila Anda seorang
mahasiswa pun, Anda sudah
pantas menggunakannya sejauh
Anda benar-benar memanfaat-
kannya secara maksimal dan tahu
persis kebutuhan Anda. Tahu
persis kebutuhan juga akan

menuntun kita untuk memilih
PDA seri dan macam mana yang
cocok untuk kita? (simak juga
artikel hal. 17-18)

Apa maksudnya tahu
kebutuhan? Ya misalnya seperti
Andreas. Ia merasa tak butuh
menyatukan PDA-nya dengan
ponsel karena pertimbangan
tertentu. Sementara menurut Ari
Kunwidodo, teman-temannya di
kantor pun sebagian juga meng-

gunakan dua peranti pon-
sel dan PDA yang terpisah
dengan pertimbangan
yang berbeda-beda. Bisa
macam-macam, umumnya
karena masalah fungsio-
nalitas, tetapi kadangkala
pertimbangannya bisa jadi
sangat personal, seperti
karena orang itu merasa
tidak cukup aman
membawa dua barang
berharga sekaligus.

UNJUK KERJA
Sekarang ini, kemam-

puan dan unjuk kerja PDA
boleh jadi sudah berhim-
pit dengan unjuk kerja
komputer itu sendiri.
Bayangkan, sebuah PDA
digerakkan oleh prosesor
berkecepatan 400MHz,
sementara kita kadang-
kala masih menjumpai

komputer di kantoran yang ber-
kelas Pentium 200 atau 300MHz.
Meski bukan level yang sejenis
untuk dibandingkan, kemam-
puan dan fasilitas yang diperli-
hatkan oleh PDA masa kini sudah
praktis setara dengan apa yang
kita butuhkan untuk menjalan-
kan tugas-tugas keseharian.

Dari sisi kelengkapan misal-
nya, PDA sekarang ini sudah di-
lengkapi dengan slot-slot eks-
pansi seperti SD (secure digital)
atau CF (compact flash), dan lain-
lain, yang memungkinkan kita

untuk menyimpan data lebih
banyak, menggabungkannya
dengan peranti lain seperti
kamera, bluetooth, Wi-Fi, atau
konektivitas yang lainnya. Bah-
kan pada PDA kelas atas, semua
koneksi seperti bluetooth atau
Wi-Fi, atau aksesoris seperti ka-
mera, sudah terpasang secara
built-in, sehingga kita bisa
memanfaatkan slot yang
tersedia untuk keperluan lain
yang lebih urgen.

KONSISTENSI
DAN EKSPLORASI

Yang lebih banyak terjadi,
orang menggunakan PDA ka-
rena mengejar salah satu fungsi
dalam PDA, yang sebenarnya
bukan merupakan fungsi vital
PDA tersebut. Dan repotnya,
dari waktu ke waktu, cuma
fungsi-fungsi itu saja yang dija-
lankannya. Lebih repot lagi, se-
iring dengan berjalannya waktu,
ia pun mulai bosan mengguna-
kannya dan kemudian meman-
faatkannya hanya untuk keper-
luan menghitung, lalu sebentar
kemudian mengonggokkannya
di laci meja kerja atau lemari.

Oleh karenanya, umumnya
sekali orang sudah
menggunakan PDA dan
merasakan betul manfaatnya, ia
akan banyak melakukan
eksperimen, baik dari sisi
kegunaan maupun
penggunaan. Maksudnya,
umumnya para pengguna PDA
akan segera mengganti
barangnya dengan barang yang
lebih baru begitu ia mulai bosan
atau begitu ada produk baru
yang muncul. Mereka ini umum-
nya tidak fanatik pada satu
merek, tetapi fanatik kepada
sistem yang digunakan, apakah
Palm atau Pocket PC, misalnya.
Itupun bukan fanatisme buta
yang tak tergantikan.

Artinya, memulai menggu-
nakan PDA cuma memerlukan
konsistensi dan persistensi
dalam mengeksplorasi fasilitas
yang ditawarkan,
menggunakannya sesering
mungkin, memanfaatkannya
semaksimal mungkin. Begitu
sudah tak mencukupi, segera
jual dan tukarkan dengan
produk baru yang lain! PC+

Menenteng setumpuk pekerjaan dalam satu
peranti tergenggam. Begitu bertenaganya PDA
sekarang ini, sehingga praktis semua
kebutuhan rutin pekerjaan bisa tertangani oleh
perkakas yang satu ini.

A
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Berendam di Dalam
Panci, Pilih Palm
atau Pocket PC?

F.X. Bambang Irawan
fbi@e-pcplus.com

M

Apakah PDA akan
difungsikan sebagai

alat untuk mengelola
jadwal? Untuk

memainkan file multi-
media? Pertanyaan ini

penting untuk
memilih sistem

operasinya.

emilih sistem
operasi
merupakan anak
tangga pertama yang

harus ditapaki seseorang yang
hendak membeli PDA. Sedikit
berbeda dengan yang terjadi di
PC, ketika pilihan pertama
orang awam hampir pasti
adalah Windows, di jagad PDA
terdapat dua sistem operasi
dominan: yaitu Palm dan
Microsoft Pocket PC, yang
menawarkan kelebihan masing-
masing.

PALM
Palm adalah sistem operasi

yang mengawal peranti
genggam ini sejak awal. Maka,
PDA jadul (jaman dulu) identik
dengan Palm. Keandalannya
dalam sistem operasi PDA masih
bertahan hingga kini ketika
sudah mencatat versi 5.0
sebagai versi terbaru. Banyak
pengguna PDA gaek juga masih

setia dengan OS (Operating
System) ini.

Umumnya, orang menyukai
Palm karena simplisitasnya,
kesederhanaannya. Mereka ini
terutama yang memanfaatkan
PDA dalam hal pengelolaan
jadwal dan kontak, data-data
pribadi, dan sedikit tool untuk
pengolahan kata dan data.

“Kalau saya diminta
pendapat oleh pelanggan
tentang PDA yang harus dipilih,
terlebih dulu saya akan bertanya
tentang kebutuhan mereka.
Kemudian saya akan terangkan
tentang kelebihan masing-
masing sistem operasi. Kalau
mereka terutama hanya butuh
PDA untuk Personal Information
Manager (PIM) maka Palm akan
lebih cocok karena step menunya
tidak berbelit-belit. Sedang kalau
mereka suka bermain dengan
multimedia, Pocket PC akan lebih
mereka sukai,” tutur Tjandra
Kisnata, pengelola toko C-Palm di
Ratu Plaza.

Program-program dalam
Palm baik yang dikembangkan

oleh Palm sendiri maupun oleh
pihak ketiga, umumnya dibuat
sederhana dan berukuran kecil
sehingga tidak banyak
menghabiskan resource memori.

Stabilitas sistem adalah hal
lain yang disukai orang dari Palm.
Sistem Palm tidak mudah crash.
Kalau pun terjadi, maka cukup
dengan reset, masalah akan
segera teratasi.

POCKET PC
Melihat prospek cerah dalam

dunia komputasi genggam,
Microsoft tak mau ketinggalan
untuk “menyemarakkannya”.
Kalau bisa, untuk menguasainya.
Tanda-tanda keberhasilan
dominasi itu sudah mulai terlihat
dengan makin banyaknya PDA
mutakhir yang mengadopsi
sistem operasi Microsoft dalam
dagangan mereka. Hewlett-
Packard, O2, dan Sony
merupakan beberapa nama yang
membuat PDA dengan basis
sistem operasi Microsoft, baik
Pocket PC maupun Windows
Mobile.

Debut awal Microsoft
ditandai dengan penggunaan
Windows CE dalam beberapa
peranti PDA di tahun 1996.
Namun, pendekatan
“memindahkan Windows dari PC
ke PDA” ini banyak mengundang
sinisme, seperti “memindahkan
gajah ke kandang jangkrik”.
Windows CE saat itu dianggap
belum mampu menyaingi Palm.

Pendekatan Microsoft untuk
membuat PDA menjadi “PC
genggam” terus berlanjut
dengan pengembangan seri
Microsoft Pocket PC yang
tampaknya cukup diterima
masyarakat pecinta PDA yang
berkemampuan PC. Ketika
teknologi prosesor, memori, dan
layar warna untuk PDA makin
berkembang, OS berbasis grafis
ini seperti menemukan
momentumnya. Apalagi ketika
Compaq (sebelum diakuisisi HP)
mengeluarkan seri iPaq yang
mengusung Microsoft Pocket PC
2002 dan laris di pasaran.

OS keluaran terbaru adalah
Windows Mobile 2003 yang

antara lain dipasang pada PDA
canggih namun laris manis di
pasaran: XDA II dari O2.

FIFTY-FIFTY
Menurut Etty Purwati, Store

Manager Toko Palm Center di
Ratu Plaza, penjualan PDA
berbasis kedua sisop itu sama
besarnya, fifty-fifty. “Pertim-
bangan pelanggan adalah pada
fungsionalitas dan aktualitas
model. Para pelanggan cepat
sekali berganti model. Asal ada
yang baru, mereka langsung
mencicipinya,” jelasnya.

Memang meski ada namun
fanatisme OS di sini kurang
bergaung. Ada yang memiliki
dua jenis PDA sekaligus (sering
disebut secara berkelakar
sebagai “double agent”). Ada
yang pernah menggunakan
kedua-duanya. Ada yang ber-
ganti-ganti OS sesuai dengan
selera. Kebutuhan adalah
pertimbangan utama untuk
keputusan membeli, dan hanya
calon pembeli yang paling tahu.

Sebagai catatan, bukan
hanya Palm dan Microsot yang
bertarung dalam lanskap OS
PDA ini, namun Linux dan Sym-
bian juga sudah menyingsing-
kan lengan baju, ikut meramai-
kannya. Jadi dalam soal pemi-
lihan OS, kondisi saat ini relatif
lebih nyaman daripada di masa
datang ketika harus memilih
dari lebih banyak OS untuk
PDA. PC+
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Coba-coba
Melamar PDA

F.X. Bambang Irawan
fbi@e-pcplus.com

B

Meski masih terasa
relatif mahal, kalau

pintar
memanfaatkannya,

PDA akan sangat
mempermudah hidup.

Terutama jika bisa
menuliskan skenario
yang gamblang dan

tepat akan
penggunaannya, maka

kita laksana
menemukan pasangan

hidup yang setia
membantu kita.

erikut ini
bibit-bobot-
bebet alias
spesifikasi yang bisa

dijadikan pijakan untuk
meminang PDA pujaan yang
tepat dan tidak mengecewakan
kita di kemudian hari.

BATERAI
Jenis baterai yang digunakan

oleh PDA mutakhir umumnya
adalah Lithium Polymer yang
merupakan baterai jenis baru
dengan kapasitas dua kali lipat
Lithium Ion. Kesederhanaan Palm
sangat membantu dalam hal
mengirit daya tahan baterai.
Sebaliknya PocketPC sangat haus
akan catu daya.

Dalam soal baterai ini, PDA
PocketPC terbaru seperti iPAQ
2210 dan XDA II mempunyai
tawaran menarik karena

sekarang baterai yang dipasang
sudah dapat removable, dapat
diganti sendiri oleh pengguna.

KAMERA
Beberapa PDA malah sudah

menawarkan kamera built-in
sebagaimana ditawarkan oleh
berbagai ponsel keluaran
terbaru. Palm Zire 71 dan

beberapa tipe Sony Clie adalah
pelopor PDA berkamera digital
ini. Resolusi kamera yang
ditawarkan Sony Clie NZ90 malah
sudah memasang kamera dengan
resolusi 2,1 megapixel.

LAYAR WARNA
Layar warna sudah jamak

dijumpai pada PDA keluaran
terkini, baik di ranah Palm
maupun PPC. Berbagai jajaran
PDA Palm dari Sony merupakan
perintis layar dengan resolusi
tertinggi saat ini, yaitu 320x420
pixel dan mampu menampilkan
65.536 warna.

Dengan jumlah warna yang
sama, kalangan PocketPC, baik
XDA II maupun iPAQ masih
mengusung resolusi 320x240
pixel. Sedang jajaran Tungsten
dari Palm rata-rata memasang
resolusi 320x320.

PROSESOR
Peminat PocketPC harus

lebih menyimak faktor prosesor
ini karena PDA jenis ini umumnya
akan lebih haus sumberdaya.
Maka tak heran jika PDA
PocketPC terbaru sudah ada yang

dilengkapi dengan prosesor Intel
XScale 400MHz, seperti pada
iPAQ h2210 dan XDA II.

Namun bukan berarti Palm
lalu bermain seadanya dengan
prosesor “lemot”. Pada seri
Tungsten terbarunya, seperti
Tungsten T3 dan Tungsten C,
Palm mengusung prosesor Intel
XScale 400MHz yang sama.

SINKRONISASI
Kapabilitas sinkronisasi

seharusnya sangat penting kalau
kita juga bekerja dengan PC. Kita

bisa menyinkronisasikan data-
data, file dokumen dan sheet,
serta e-mail. Dan karena
umumnya PC berbasis Windows,

maka sinkronisasi PDA dengan
PocketPC patut diduga keras
akan lebih mulus dan lancar.

Untuk kepentingan

sinkronisasi PC berbasis Windows,
pengguna Palm akan sangat
terbantu dengan software dari
pihak ketiga. Yang paling

Saya menggunakan hp iPAQ 2210 dan Palm Vx. Saya
memilih iPAQ 2210 ini karena dual slot yang dimilikinya, jadi
saya bisa menggunakan CF dari digital camera saya tanpa
harus membeli memori tambahan. Dan kalau saya sedang
menggunakan CF Wi-Fi untuk ber-hot-spot-ria, saya masih
mempunyai SD untuk menyimpan file yang saya download.
Ukuran juga menjadi daya tarik dari iPAQ ini, karena saya
bisa masukkan di saku kemeja dan jas tanpa membebani
(menarik) kemeja ke bawah. Bluetooth dari iPAQ ini juga
sangat membantu, karena saya bisa tarik dan kirim SMS
tanpa mengeluarkan ponsel dari saku saya. Dan layarnya,
euy, terang dan jernih!

OS PPC juga merupakan preferensi karena dua faktor:
Pertama, bisa multi tasking, jadi saya bisa mendengarkan
musik sambil bekerja dan cek e-mail. Kedua, mudah disinkronisasi dengan MS Outlook, karena schedule
dan contact saya ada di Outlook. Sementara itu sinkronisasi dengan MS Word dan Excel juga mudah
dilakukan.

Sedang Palm Vx saya pilih karena baterai yang tahan lama, bisa seminggu tidak perlu nge-charge.
Bentuknya yang tipis juga merupakan kesukaan saya. Terkadang kalau lagi malas bawa iPAQ (seperti
lagi liburan) ya saya bawa ini saja. Toh, kalau lagi santai kita tidak perlu buka yang lain, cuma butuh
contact dan schedule saja. PC+

Putra Utama Abbas (25 tahun),
mantan Business Development Manager sebuah perusahaan TI yang sedang merintis

usaha toko gadget:
Palm dan PocketPC Saling Mengisi

Saat ini saya (kebetulan) menggunakan dua buah PDA (yang satu adalah PPC iPAQ h2210 dan
satunya lagi Sony Clie TG-50 berbasis Palm). Buat saya, kedua macam PDA (Pocket PC dan Palm OS)
adalah sama saja. Yang penting, alat tersebut bisa membantu saya dalam bekerja dan beraktivitas
sehari-hari. Tidak ada satu platform PDA yang "pasti" lebih baik dari yang lainnya. Semua ada kelebihan
dan kekurangannya,
tergantung sampai sejauh mana bisa memenuhi kebutuhan kita.
Tetapi kalau mau dirunut lagi dari awal-awal saya menggunakan PDA, memang terasa sekali pengaruh
Palm OS PDA cukup kuat pada diri saya. PDA pertama saya adalah Palm IIIxe, kemudian Palm m505,
Pocket PC Toshiba e310, Palm Tungsten T, iPAQ H2210, dan terakhir saat ini adalah Clie TG-50.
Kalau dilihat di sini, terkesan saya lebih banyak menggunakan Palm OS PDA dibandingkan dengan
Pocket PC. Terus terang "kesederhanaan" platform Palm OS sangat cocok buat saya.

Kadang-kadang PDA membuat hidup kita terasa lebih mudah. Saya biasa mencatat semua jadwal
yang berhubungan dengan pekerjaan saya, antara lain meeting, things to do, dan lain-lain. Selain itu
juga saya biasa menggunakan PDA untuk menerima dan mengirim e-mail, menulis SMS, sesekali
browsing, membaca e-book, dan bahkan sebagai viewer atau editor dokumen MS Office (Excel dan
Word) dan masih banyak fungsi-fungsi yang lain seiring dengan tersedianya program-program aplikasi
yang jumlahnya puluhan ribu tersebut. PC+

Fendie B. Sumantri (29 tahun), Assistant VP System Engineering, PT Telenet:

Riwayatnya Cenderung ke Palm

populer adalah Documents To Go
yang dirancang untuk menyin-
kronisasikan dokumen Office
pada Windows dengan Palm.

SLOT ESKPANSI
Slot ekspansi pada PDA

sangat penting untuk
menyediakan akses ke memori
tambahan dan keperluan input-
output seperti modem dan
jaringan.

Jenis-jenis memori card yang
digunakan oleh  PDA umumnya
sama dengan yang digunakan
juga oleh PC dan ponsel (baca
boks pada artikel Panduan
Belanja Ponsel Tahun 2004 di
halaman 8). Memori internal PDA
paling pol hanya sampai angka
64MB sehingga kehadiran
memori tambahan seperti itu
akan sangat membantu
penyimpanan data dan aplikasi.
Apalagi karena merupakan
media yang universal, memori-
memori tersebut dapat
digunakan untuk pertukaran
data dengan peranti lain seperti
ponsel dan PC.

Slot tersebut juga dapat diisi
dengan kartu untuk koneksi
dengan peranti lain seperti
Bluetooth, GSM/GPRS, atau Wi-Fi.
Ini sangat bermanfaat jika PDA-
nya belum dilengkapi dengan
kapabilitas koneksi tersebut
secara built-in. Saat ini, misalnya,
tersedia SD Wi-Fi atau CF
Bluetooth. PC+

Meskipun mahal, XDA II laris manis di pasaran

Slot ekspansi mendongkrak kinerja PDA. Pilih yang sesuai!
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Memahami Proses
dan Perintah “Kill”

Willy Sudiarto Raharjo
willy@e-jogja.com

H

Suatu ketika, Anda
sedang menjalankan

XMMS untuk
mendengarkan file

MP3 dan juga
OpenOffice.org untuk

menulis. Namun
karena suatu hal,

XMMS tiba-tiba
menjadi hang dan

tidak mengeluarkan
bunyi sama sekali.

Anda mencoba
menutup aplikasi

tersebut, namun tidak
berhasil. Karena panik,

Anda mencoba cara
yang umum digunakan

pada sistem operasi
Windows, yaitu

kombinasi tombol
[Ctrl]+[Alt]+[Del],

tetapi bukan Task
Manager yang Anda
dapatkan, melainkan

komputer Anda
melakukan proses
reboot dan hilang

semua hasil pekerjaan
Anda yang belum

sempat Anda save.
Tragis bukan?

al ini juga
pernah penulis
alami ketika pertama
kali mengenal Linux.

Kita tidak mengerti bagaimana
cara menutup sebuah aplikasi
yang sudah tidak bisa ditutup
dengan cara biasa. Kita harus
melakukannya dengan cara
paksa. Tidak seperti Windows
yang menggunakan Task
Manager, Linux mempunyai
konsep yang berbeda.

CEK ALAMAT TARGET
Sebelum membahas

bagaimana “membunuh” aplikasi

yang hang atau tidak berfungsi,
kita harus memahami dulu apa
itu proses. Semua aplikasi yang
berjalan di Linux dianggap
sebagai sebuah proses. Proses
pertama yang ada pada Linux
adalah init, yang mempunyai PID
(Process ID) 1. Init ini dijalankan
pada saat kita melakukan
booting dan memilih untuk
mengaktifkan sistem operasi
Linux. Setelah init dijalankan,

maka sistem akan menjalankan
proses-proses lain sesuai dengan
urutan yang telah ditentukan.

Untuk melihat semua proses
yang dijalankan oleh Linux, Anda

bisa mengetikkan ps aux pada
konsol dan melihat hasilnya.
Gambar 1 menunjukkan contoh
sebagian tampilan dari perintah
ps pada komputer penulis.

Berikut penjelasan singkat
dari tampilan. Kolom paling
ujung kiri menunjukkan user
yang menjalankan proses, kolom
kedua merupakan PID dari
proses tersebut. Tampak bahwa
init selalu menempati baris
pertama dan PID-nya selalu
bernilai 1.  Kolom ketiga
menunjukkan penggunaan
resource CPU untuk menjalankan

proses (dalam
persen), kolom
keempat
menunjukkan
penggunaan
memori selama
menjalankan
proses (dalam
persen), dan
terakhir kolom
kedelapan
merupakan kolom
yang menjadi
perhatian kita jika
kita berbicara
mengenai proses
dan juga statusnya.
Kolom ini berisi
status dari suatu
proses. Huruf R
menunjukkan
bahwa proses
sedang berjalan

(running), huruf S menunjukkan
bahwa proses sedang sleeping
(idle), huruf Z menunjukkan
sebuah proses yang tidak
berfungsi (zombie). Kolom
terakhir menunjukkan perintah
yang digunakan untuk
menjalankan proses.

Tampak pada gambar bahwa
semakin ke bawah, maka PID dari
setiap proses semakin besar. Hal
ini wajar, mengingat penomoran

PID dilakukan sesuai urutan
pembuatan proses yang relatif
dari proses init. Untuk
membuktikan pernyataan ini,
Anda bisa mengetikkan perintah

pstree untuk melihat daftar
proses anak dari init (Gambar
2). Dari sebuah proses dapat
diturunkan proses anak dengan
penggunaan system call fork().
Kita tidak akan membahas
penggunaan fungsi fork() pada
artikel ini.

Setelah memahami
penggunaan perintah ps untuk
melihat daftar proses, maka
saatnya kita mengenal perintah
kill, yang berguna untuk
menghentikan atau
“membunuh” proses. Kill adalah
sebuah perintah pada Linux yang
berfungsi untuk menghentikan
atau “membunuh” proses
tertentu dengan mengirimkan
sebuah sinyal tertentu. Jika sinyal
tidak disebutkan, maka Linux
secara default akan mengirimkan
sinyal TERM (Terminate) yang
akan menghentikan sebuah
proses. Berikut ini adalah daftar
signal yang ada pada Linux:

PLAN B:
BUNUH SECARA PAKSA

Untuk membunuh sebuah
aplikasi yang “membandel” atau
menghentikan sebuah proses
melalui konsol atau terminal,
Anda bisa memberikan perintah
kill <PID>  melalui konsole atau
terminal, dengan PID adalah
nomor PID yang bisa Anda lihat
dari perintah ps. Sebagai contoh,
untuk membunuh sebuah proses,
misalnya browser Opera, Anda bisa
melihat PID dengan mengetikkan
perintah ps aux | grep -i opera
dan membunuhnya dengan
perintah kill <PID> (Gambar 3).

Gambar 1

Gambar 2

Gambar 3

Beberapa aplikasi tertentu
kadangkala tidak “mempan”
dengan perintah kill biasa,
karena tidak menangkap sinyal
SIGTERM yang dikirimkan.
Untuk mengatasi hal ini, maka
Anda harus mengirimkan sinyal
SIGKILL yang tidak bisa
diabaikan oleh setiap proses.
Untuk mengirimkan sinyal
SIGKILL, maka Anda bisa
mengetikkan kill -9 <PID>.
Dengan perintah ini, maka
proses yang menerima sinyal
SIGKILL akan dihentikan secara
paksa. Gunakan perintah ini
sebagai pilihan terakhir,
terutama jika aplikasi yang
dijalankan berkaitan dengan
data tertentu, misalnya
OpenOffice.org.

KILL ‘EM ALL
Terkadang, sebuah aplikasi

terdiri lebih dari 1 proses, sebagai
contohnya XMMS. Untuk
“membunuhnya”, kita bisa
melakukannya satu demi satu,
ataupun dengan perintah killall,
yang akan membunuh proses
berdasarkan nama, dan bukan
berdasarkan PID seperti pada
perintah kill. Untuk
“membunuh” semua proses yang
bernama XMMS, maka Anda bisa
mengetikkan killall xmms pada
konsole atau terminal, dan dalam
sekejap, aplikasi XMMS Anda
akan menghilang dari desktop
Anda.

Setelah Anda mengerti
bagaimana menghentikan atau
membunuh proses, maka Anda
tidak perlu khawatir jika suatu
saat program Anda macet dan
tidak bisa dihentikan dengan
cara meng-klik tanda X pada title
bar. Cukup gunakan dua perintah
dasar yang ada pada Linux, yaitu
ps dan kill. PC+

SIGNAL VALUE

SIGHUP 1
SIGINT 2
SIGQUIT 3
SIGILL 4
SIGABRT 6
SIGFPE 8
SIGKILL 9
SIGSEGV 11
SIGPIPE 13
SIGALRM 14
SIGTERM 15
SIGUSR1 30, 10, 16
SIGUSR2 31, 12, 17
SIGCHLD 20, 17, 18

SIGCONT 19, 18, 25
SIGSTOP 17, 19, 23
SIGTSTP 18, 20, 24
SIGTTIN 21, 21, 26
SIGTTOU 22, 22, 27
SIGBUS 10, 7, 10
SIGPOLL
SIGPROF 27, 27, 29
SIGSYS 12, -, 12
SIGTRAP 5
SIGURG 16, 23, 21
SIGVTALRM 26, 26, 28
SIGXCPU 24, 24, 30
SIGXFSZ 25, 25, 31
SIGIOT 6
SIGEMT 7, -, 7
SIGSTKFLT -, 16, -
SIGIO 23, 29, 22
SIGCLD -, -, 18
SIGPWR 29, 30, 19
SIGINFO 29, -, -
SIGLOST -, -, -
SIGWINCH 28, 28, 20
SIGUNUSED -, 31, -
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Membuat Seleksi
Cipratan Air

Vincent Bayu Tapa Brata
vincent@e-pcplus.com

C

Air merupakan subjek yang sulit diseleksi karena
sifatnya yang transparan. Apalagi, kalau dalam
bentuk cipratan. Bentuk yang kompleks ini sulit

sekali diseleksi apabila kita menggunakan Magic
Wand Tool, apalagi dengan metode Path. Tapi
dalam latihan kali ini kita akan buktikan bahwa

hal tersebut tidak sulit dilakukan. Tanpa
berpanjang kata, mari segera kita mulai latihan

kita!

ipratan air, secara logika pasti ada benda lain yang juga bergerak
sehingga menyebabkan pergerakan air. Jika benda tersebut statis, harus kita
beri efek gerak dahulu.

1. Buka foto Roda. Klik ganda
pada bar layer Background
agar menjadi layer Normal.
Bila palet Layers belum
tampak, klik menu
[Window]>[Show Layers].
Beri nama layer pada kotak
dialog Layer Properties,
misalnya: Roda.

2. Klik Arrow (anak panah hitam di
bagian kanan atas palet Layers).
Salinlah layer Roda (pilih opsi
Duplicate Layer), lalu beri nama
Rotasi.

3. Seleksi bagian roda dengan Ellips
Tool di palet Toolbox. Jika ingin
membuat seleksi berupa
lingkaran, drag sambil terus
menekan tombol [Shift] di
keyboard. Terapkan Filter Radial
Blur dengan klik menu
[Filters]>[Blur]>[Motion Blur].
Pilih jenis Spin, kemudian atur
intensitas  (amount) filter.

4.  Beri Mask pada layer Rotasi
dengan klik ikon Add Layer Mask
di bagian bawah palet Layers.
Klik [Paintbrush Tool] di
Toolbox, pilih nada gelap di palet
Foreground Color. Sapukan
Paintbrush Tool ke bagian
gambar yang tidak ingin diberi
efek rotasi. Bagian tersebut akan
tersembunyi. Kuat lemahnya
sapuan brush diatur dengan
menggeser slider Tool/Brush
Opacity, sementara diameter
brush diatur dengan menekan
tombol [  atau tombol  ] di
keyboard.

5. Aktifkan layer Roda. Salin lagi
(seperti Langkah 2). Beri nama
Speed.

6. Terapkan filter Motion blur dengan klik menu
[Filters]>[Blur]>[Motion Blur]. Atur arah kecepatan
(angle) dan intensitas filter (distance).

7. Beri mask pada layer Speed (caranya sama dengan
Langkah 4). Sembunyikan pula bagian yang tidak
ingin diberi efek kecepatan agar efek rotasi tidak
tertutup (caranya sama dengan Langkah 4).

8. Simpan dalam format .PSD dengan klik menu
[File]>[Save As] (jangan Save) dan beri nama Roda.

MENAMBAHKAN CIPRATAN AIR

9. Buka foto Ciprat 1. Ubah layer Background menjadi
layer normal. Buka palet Channels. Pilih channel yang
paling kontras. Klik Arrow (Channel Options), salin
channel terpilih tersebut dengan memilih opsi
Duplicate Channel.

10. Edit kontras channel salinan tersebut dengan klik
menu [Image]>[Adjust]>[Levels]. Geser slider
(highlight, midtone, dan shadow) di kotak dialog
Levels.

Klik
Ganda

Beri nama
Layer

Arrow (Options)

Ellips
Selection ToolLayer

aktif

Mask
aktif

Ikon add
layer mask

Paintbrush
Tool

Nada Gelap

Tool/Brush
Opacity

Mask
aktif
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11. Klik ikon Load Channel as Selection di bagian bawah
palet Channels.

12. Buka palet Layers. Klik
menu [Edit]>[Copy].

13. Buka file Roda.PSD
(yang sebelumnya
sudah kita beri efek
gerak). Klik menu
[Edit]>[Paste]. Bila
ukuran layer
Cipratan belum
sesuai keinginan,
ubah dengan klik
Move Tool di
Toolbox, lalu klik
menu [Edit]>
[Transform]>[Scale].
Drag handle point di
pojok sambil terus
menekan tombol
[Shift] agar proporsi
panjang dan lebar
tetap.

14. Beri mask pada layer Cipratan, lalu
sembunyikan bagian yang tidak
perlu, terutama pinggiran foto
cipratan (caranya sama dengan
Langkah 4).

15. Bila perlu, tambahkan cipratan lain.
16. Simpan pekerjaan kita dalam

format .PSD. Klik menu [File]>[Save
As], beri nama file, misalnya: Splash
Final.

Nah, sekarang Anda pasti berkata: “Oooo...., ternyata cuma begitu tooo...?” Pertanyaan dan
permintaan file source latihan ini dapat dikirim ke e-mail penulis. Keep on learning! PC+

Ikon Load
Channel

as
Selection

Mask
aktif

Move Tool
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ePHP Triad: Paket
Trilogi Apache, PHP

dan MySQL

Yahya Kurniawan
yahya@e-pcplus.com

T

Akhir-akhir ini orang
lagi senang membuat
sesuatu yang berbau
trilogi. Di dunia film
misalnya, ada trilogi

The Lords Of The
Ring, trilogi The

Matrix, trilogi Indiana
Jones (yang dalam

waktu dekat bukan
lagi trilogi karena

kabarnya akan ada
film keempat), hingga

yang paling heboh
adalah double trilogi
Star Wars (sekalipun
yang keenam belum

dirilis karena lagi
syuting). Ok, cukup

segitu karena PCplus
bukan tabloid film.

api di
dunia kita
dunia TI ada juga
produk yang

“berbau” trilogi, yaitu PHP
Triad. PHP Triad merupakan
paket yang berisi tiga
perangkat lunak yang
pemakaiannya saling terkait,
yaitu PHP, web server
Apache, dan database
MySQL. Karena dibundel
dalam satu paket, Anda
tidak perlu repot-repot
melakukan berbagai setting
yang rumit dibandingkan jika
ketiga perangkat lunak tersebut
Anda instal secara terpisah.

PHP Triad merupakan
perangkat lunak yang berlisensi
GPL, artinya PHP Triad bersifat
freeware. Namun sayang sekali
beberapa waktu lalu PHP Triad
berganti baju menjadi Sokkit
(www.sokkit.net). Sokkit ini
sama sekali bukan freeware
tetapi bersifat proprietary. Anda
hanya bisa men-download versi
trialnya (30 hari) dan jika suka
Anda harus membeli lisensinya.
Karena alasan itu PCplus
akan mengangkat
pembahasan mengenai
PHP Triad saja daripada
Sokkit. Mudah-mudahan
Anda masih bisa
mendapatkan PHP Triad.

Mengapa PCplus
masih merasa perlu
membahas PHP Triad yang
notabene seharusnya
dibahas paling awal?
Karena masih banyak e-
mail yang masuk
(khususnya ke yahya@e-
pcplus.com) menanyakan cara
instalasi PHP for Windows, atau
web server apa yang bisa
digunakan di Windows ME/
Windows XP Home. PHP
memang bisa dijalankan di web
server IIS, akan tetapi Windows
ME dan Windows XP Home
tidak diperlengkapi dengan IIS.
Jadi PHP Triad akan sangat
berguna bagi Anda yang
menggunakan Windows ME
atau Windows XP Home.
Memang pada dasarnya PHP
Triad lebih terasa berguna
apabila diinstall di sistem
operasi Windows dibandingkan
dengan di Linux. Di Linux

(khususnya Red Hat) jika
pada saat instalasi Anda
memilih untuk menginstall
ketiga paket perangkat
lunak tersebut, maka
otomatis ketiganya
langsung terintegrasi tanpa
perlu melakukan setting-
setting yang rumit.

Versi PHP Triad yang
PCplus miliki adalah PHP
Triad 2.11. Anda dapat
mencari paket instalasinya

di www.sourceforge.net/
projects/phptriad. Paket
perangkat lunak yang dibundel
PHP Triad 2.11 ini adalah sebagai
berikut:

• PHP - 4.0.5
• MySQL - 3.23.32
• Apache - 1.3.14
• PHPMyAdmin - 2.1.0
• Perl - nsPerl 5.005_03

File distribusi PHP Triad 2.11
adalah phptriadsetup2-11.exe
yang besarnya 10.9 MB. Untuk
menginstall PHP Triad, jalankan

file phptriadsetup2-11.exe terse-
but. Anda akan menjumpai kotak
dialog seperti pada Gambar 1.
PHP Triad nantinya akan diinstall
di drive C. Sayangnya kita tidak
bisa mengganti hal ini. Jadi
pilihan yang tersedia
hanyalah klik [Next].

Berikutnya installer
akan menginstall file-file
yang diperlukan ke kom-
puter Anda. Proses insta-
lasinya diperlihatkan pada
Gambar 2. Oh ya, sebagai
informasi, PCplus mencoba
menginstall PHP Triad ini di
Windows XP Home.

Setelah proses instalasi
selesai, di start menu Anda

akan muncul sebuah folder
baru yaitu PHP Triad yang
berisi shortcut-shorcut
berikut:
• Launch Site
• phpMyAdmin
• Start Apache
• Start MySQL
• Shutdown MySQL

Mula-mula jalankan
terlebih dahulu Start
Apache. Shortcut ini akan
menjalankan server Apache

yang baru saja terinstall. Setelah
Apache dijalankan, klik shortcut
Launch Site. Tujuan dari
shortcut ini adalah http://
localhost, jadi tepat sekali
digunakan untuk memeriksa
apakah instalasi Anda berhasil
atau tidak. Jika berhasil, Anda
akan dibawa ke halaman seperti
terlihat pada Gambar 3.

Pada halaman tersebut
terdapat link untuk menuju ke
file phpinfo.php dan
phpMyAdmin. Klik link-link
tersebut untuk memeriksa
apakah PHP dan MySQL telah

dapat berjalan di Windows
Anda.

Sayangnya, setiap kali
Anda ingin menjalankan
Apache, PHP, dan MySQL
tersebut, Anda harus
menjalankannya secara
manual, artinya harus
menjalankan shortcut Start
Apache dan Start MySQL.
Agar Apache dan MySQL
selalu berjalan setiap kali
Windows booting, maka
kedua perangkat tersebut

harus dijalankan sebagai service
atau dijalankan saat start up.
Apache harus dijalankan sebagai
service dan MySQL harus
dijalankan pada saat start up.

Untuk menginstall Apache

Gambar 1

Gambar 2

Gambar 3

Gambar 4

Gambar 5

sebagai service, Anda harus
menjalankan perintah sebagai
berikut:

C:\apache\apache -i -n
“apache”

Opsi -i digunakan untuk
menginstall Apache sebagai
service, sedangkan opsi -n diikuti
dengan sebuah nama akan
menyatakan nama tersebut
sebagai nama service. Agar
mudah mengingatnya maka
nama service juga “apache”.
Opsi selengkapnya dari apache
akan diberikan pada tabel
berikut:

Opsi Keterangan

-D nama Mendefinisikan
nama untuk
digunakan pada
direktif <IfDefine
name>.

-d directory Menentukan
alternatif untuk
ServerRoot.

-f file Menentukan
alternatif untuk
ServerConfigFile.

-C "directive" Memproses
“directive”
sebelum membaca
file konfigurasi.

-c "directive" Memproses
“directive” setelah
membaca file
konfigurasi.

-v Menunjukkan
nomor versi
Apache.

-V Menunjukkan
setting kompilasi
Apache.

-h Menampilkan opsi
yang tersedia.

-l Menampilkan
modul
terkompilasi.

-L Menampilkan
direktif konfigurasi
yang tersedia.

-S Menampilkan
parsed settings
(sementara ini
hanya vhost
settings)

-t Menjalankan
syntax check untuk
file config (dengan
docroot check)

-T Menjalankan
syntax check untuk
file (tanpa docroot
check) name

-n Menentukan
nama service
shutdown

-k Melakukan
shutdown
terhadap Apache.

-k restart Melakukan restart
terhadap Apache.

-k start Menjalankan

apache.
-i Menginstall

Apache sebagai
service.

-u Uninstall Apache
sebagai service.

Sekarang masuklah ke
[Control Panel]> [Administra-
tive Tools]>[Services]. Anda
akan menjumpai Services
Console seperti Gambar 4.
Perhatikan pada gambar
tersebut bahwa nama service
apache sekarang telah terdaftar.
Kemudian lihat pada kolom
Startup Type. Seharusnya di
sana tertulis Automatic,
artinya service apache akan
otomatis diload setiap kali
Windows XP booting.

Sekarang kita bahas cara
untuk menjalankan MySQL
pada saat start up. Yang paling
mudah adalah menggunakan
folder startup pada [Start]>[All
Programs]>[Startup].
Masukkan file
C:\apache\mysql\bin\ winmys
qladmin.exe ke folder
tersebut. WinMySQLAdmin
adalah perangkat lunak
administrasi server MySQL for
Windows.

Nah, sekarang jika Win-
dows XP booting, maka Apache
dan MySQL juga ikut running
dan siap digunakan. Khusus
untuk WinMySQLAdmin, Anda
dapat mengetahui apakah
perangkat tersebut running
atau tidak dari ikon bergambar
seperti lampu lalu lintas yang
terdapat pada taskbar. Jika ikon
tersebut diklik kanan akan
muncul sebuah menu. Pilih
[Show me] dan Anda akan
mendapatkan jendela seperti
pada Gambar 5.

Secara default, root
directory web Anda terletak di

c:/apache/htdocs. Jadi jika
pada direktori tersebut ada file
test.php misalnya, maka file
tersebut dijalankan dengan
menuliskan http://localhost/
test.php pada bagian address
browser. Jika Anda membuat
sub direktori di c:/apache/
htdocs, misalnya pcplus hingga
secara lengkap direktori terse-
but adalah c:/apache/htdocs/
pcplus, maka direktori tersebut
dapat diakses dengan
menuliskan http://localhost/
pcplus.

Untuk mendapatkan
informasi lengkap mengenai
setting Apache for Windows,
Anda dapat mengunjungi http:/
/www.apache.org/docs/
windows.html.

Selamat belajar. Oh ya,
jika Anda membutuhkan
artikel-artikel PHP lama yang
pernah dimuat di PCplus,
silakan download di
www.dm2p.com. PC+
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Bagi pembaca yang tertarik untuk berinteraksi di rubrik ini, silakan mendaftar dengan mengirimkan e-mail  kosong ke mailplus-subscribe@yahoogroups.com.
Agar keanggotaan Anda segera diaktifkan, balas e-mail konfirmasi yang dikirimkan oleh Yahoo ke alamat e-mail Anda. Setelah terdaftar, Anda dapat mengirimkan e-mail pertanyaan ataupun tukar

menukar pengalaman seputar dunia komputer.
Jangan lupa untuk memeriksa account e-mail Anda secara rutin. Jika Anda tertarik untuk berdiskusi langsung secara online, silakan Anda join ke server DALnet pada channel #chatplus di mIRC.

PENTING!!!
Kalau Anda ingin menerima dan membaca e-mail secara digest (satu e-mail berisi beberapa message), kirim e-mail kosong ke mailplus-digest@yahoogroups.com. Sebagai informasi, setiap hari

Jum’at hingga Minggu adalah hari bebas di milis ini.
Setiap anggota dapat mem-posting e-mail diluar seputar masalah komputer asalkan tidak mengandung SARA, pornografi, bajak-membajak software, flamming, dan sebagainya. Jika Anda tidak

ingin menerima e-mail OOT (Out Of Topic), kirim e-mail ke mailplus-nomail@yahoogroups.com, dan silakan Anda aktifkan kembali ke mode normal dengan mengirim e-mail ke mailplus-
normal@yahoogroups.com.

•Redaksi

Komputer Restart
Terus

Salam rekan-rekan milis.
Saya memiliki komputer dengan
spesifikasi sebagai berikut:
• Motherboard ECS K7S5A Pro
• Prosesor AMD Athlon XP

1700+
• Memori DDR Samsung

256MB
• VGA GeForce-4 MX440
• Harddisk Seagate 20GB

Masalah yang saya alami
adalah, ketika saya mulai
memainkan game, tiba-tiba
komputer saya restart sendiri.
Kejadian seperti itu saya alami
terus menerus kalau saya
memainkan game-game berat.
Kira-kira kenapa ya? Apakah
spesifikasi komputer saya
kurang memadai? Sebagai
informasi, untuk BIOS
motherboard tersebut, saya
sudah meng-update-nya
dengan BIOS keluaran terbaru
tetapi tetap saja tidak ada
perubahan.

Satu hal lagi. Komputer
saya ini baru mau berjalan
dengan normal dan tidak
restart terus kalau frekuensi
kecepatan prosesornya saya
turunkan. Dari yang default-
nya 133MHz menjadi 100MHz.
Tetapi kemudian loading-nya
menjadi lama dan game yang
saya mainkan menjadi makin
berat. Tolong bantuannya
dong. Thanks buat respondnya
guys.

Doni Sahputra

Jawab:
Mengenai spesifikasi

komputer, PC yang Anda
gunakan tampaknya tidak ada
masalah. Kalau kondisinya

sering restart seperti itu, coba
Anda turunkan setting memori
ke By SPD dari BIOS. Cara lainnya,
setting CAS/RAS Latency dan lain-
lain dinaikkan angkanya
(misalnya dari 2.5 ke 3). Mudah-
mudahan hal ini bisa membantu.

Adhitya F. Anggoro

Pakai GeForce-4
Tetapi Tidak Bisa Nge-
game

Ada yang bisa tolongin?
Spesifikasi PC-ku:
• Prosesor Pentium-4 2,4C
• Motherboard Gigabyte GA-

8IPE1000 (i865, FSB800)
• DDR 128MB Visipro 2 keping
• PixelView GeForce-4 MX440

64MB AGP8X
• Windows XP Home Edition

Yang jadi masalah adalah,
saya tidak bisa meng-install Need
for Speed (semua versi) dan
Midnight Club 2. Masalah
lainnya, saya bisa menginstal
Formula-1 2001, tetapi saat
main, tulisan di layarnya suka
tiba-tiba Hilang. Ada yang bisa
tolongin aku? Help me please.

fOeAd aLvieRy

Jawab:
Menurut saya, mungkin itu

karena driver VGA-nya. Coba
pakai driver terbaru. Terus, kalau
masalah main game gambar
hilang itu mungkin karena
memori nya tidak cukup
(walaupun sudah 256MB). Coba
pakai program untuk
meningkatkan kinerja memori
seperti RAM Booster. Semoga
dapat membantu.

Alex

Web Server Gratis

Halo teman-teman semua, aku ada pertanyaan nih. Aku kan sudah bikin situs yang di dalamnya ada
program database yang terkoneksi dengan SQL server dan dibuat memakai ASP. Yang ingin saya
tanyakan adalah, ada gak ya server situs web gratisan yang bisa saya pakai untuk mengoneksikan situs
saya agar bisa online? Selama ini situs yang saya buat hanya lokal saja. Kalau misalnya tidak ada situs
gratisan semacam itu, situs yang bayar juga gak papa deh. Thanks ya.

Anggara Paripurna

Jawab:
Coba Anda lihat di www.singcat.com. Di sana bayar sih, tapi lumayan murah kok. Atau coba di

tempatnya Luckyguy nge-host. Apa ya, namanya? Kalau tidak salah a3plusmedia.
Kalau Anda mau, hosting di tempat yang saya pakai saja. Server-nya ada di Indonesia. Kecepatannya

luar biasa. Koneksi jaringan IIX 100MBps port. Top kan?
Selain Singcat, ada lagi penyedia yang menawarkan biaya lebih murah. Coba Anda lihat
http://www.imediabiz.com/id/web_hosting/hosting.htm atau http://fleksi.com/index.php

Paulus Tangke Allo, BN

Help, Masalah CD
Writer

Dear rekan-rekan milis, saya
ada masalah seputar CD writer
nih. Mohon bantuannya ya.
Saya di rumah pakai CD writer
ASUS 5224A (52x24x52). Dulu,
waktu pertama-tama beli saya
pakai bisa untuk membakar ke
CD-R (waktu itu saya pakai CD
blank merek LG) dengan data
700 MB selama sekitar 3 menit-
an (kecepatan bakar 40x). Saya
dulu memakai software bawaan
(bundled) Nero Express
5.5.9.2.

Tetapi karena saya sudah
memiliki software yang lebih
baru, kemudian saya uninstall
software tersebut dan saya
install Nero 6 Ultra Edition.
Masalahnya, setelah saya coba
membakar data yang juga
sebesar sekitar 700MB, dengan

CD merek LG pada kecepatan
bakar 40x, proses pembakaran
baru bisa selesai setelah sekitar 8
menit-an. Saya sudah coba
beberapa kali (dengan CD merek
lain tapi tetap seperti ini (mem-
butuhkan sekitar 8 menit-an).

Saat pembakaran, buffer-nya
nggak stabil (naik-turun).
Padahal seingat saya dulu, buffer
level-nya stabil di 100 %. Trus
saya juga coba pakai software
Alcohol 120% untuk bakar
image, tetap membutuhkan
sekitar 8 menit-an. Sebagai
informasi, saya menggunakan
sistem operasi Windows XP
Professional dengan Service Pack
1, spesifikasi komputer dengan
prosesor AMD Athlon XP 2500+,
motherboard MSI K7N2 Delta-L,
serta memori Visipro 256 MB PC-
2700.

Pada Device Manager saya
sudah memilih transfer mode

“DMA if available
untuk CD
writer”, tapi
tetap current
mode-nya “PIO
mode”.
Sedangkan
transfer mode
untuk DVD ROM
bisa “UDMA
mode 2”. Apa hal
ini berpengaruh?

Teman-
teman tolong
kasih saran dong. Memang
selama ini pembakaran CD-nya
sempurna, tetapi males banget
kan, kalau harus menunggu 8
menit, padahal dulu bisa 3
menit! Terima kasih sebelum-
nya, God bless. All the best.

Y B Dafferianto T

Jawab:
Tampaknya ada gejala

buffer underrun. Saya pernah
mengalami, hal ini disebabkan
transfer data dari harddisk ke

CD-RW terhambat. Kemung-
kinan ini terjadi karena harddisk
Anda terlalu penuh atau jarang
di-defrag. Saran saya:
1. Kabel IDE untuk harddisk

dipisah dari CD-RW, CD-
ROM, dan DVD. Komputer
akan memilih kecepatan
yang paling pelan di antara
komponen yang terkait.

2. Buang file-file yang sudah
tidak diperlukan dalam
harddisk Anda, misalnya file-
file di folder “temporary
internet files”, dan lain-lain.

3. Defrag harddisk. Anda juga
bisa menggunakan Norton
Speed Disk.

4. Kurangi kecepatan bakar.
5. Pakai CD-R blank merk yang

lebih baik. Biasanya sih, ada
harga ada kualitas.

Kalau masih juga seperti
itu, masalahnya adalah pada
media CD-R-nya. Asus biasanya
memang sedikit "selektif"
dalam membakar CD-R. Coba
deh lihat dulu pakai Nero CD-
DVD Speed, kira-kira buatan
siapa dye CD-Rnya, trus Anda
informasikan lagi ke sini.

Untuk alternatif CD blank,
baiknya Anda gunakan Verba-
tim, CD buatan Ritek Co., atau
CD buatan Taiyo Yuden.
Biasanya, karena ketidak kom-
patibelannya dengan media CD-
R, maka terjadi buffer under-
run. Coba Anda pakai firmware
versi 1.37 supaya lebih cocok
dengan media CD-Rnya. Salam.

Adhi W, DimeDeviL
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Gigabyte GV-N57U128D:

FX5700 Ultra dengan Kipas Pintar

Nusantara Eradata
www.gigabyte.com.tw

☎ (021) 6018218
± 300 - 335 dolar AS

plusProduk V • 27 Januari - 02 Februari 2004
PCplus 160

24 |

M935D Series:

Motherboard Murah
Meriah dari PC Chips

PT ECS Indonesia
www.hanshing.com

☎ (021) 6282048
45 dolar AS

SysMark 2002
Rating :276
Internet Content :392
Office Productivity:195

TMPG Encoder: 42 menit
50 detik

3D Mark 2001
1024 x 768  32bit :13630
1600 x 1200  32bit :8688

3D Mark 2003
1024 x 768 :3882
1600 x 1200 :2116

Quake III Arena
1024x768 high quality:307,7fps
1600x1200high quality :173,1fps

Serious Sam Second Encounter
1024 x 768 :56,3fps
1600 x 1200 :46,2fps

Commanche 4
1024 x 768 :56,26fps
1600 x 1200 :48,04fps

Halo
1024 x 768 :34,41fps
1600 x 1200 :15,87fps

Tidak lama
setelah Gigabyte
mengumumkan kesepakatan
terbaru dengan nVidia, mereka
segera merilis produk kartu
grafis yang memanfaatkan chip
dari vendor grafis tersebut.
Tepatnya pada akhir Oktober
lalu, kartu grafis yang
diluncurkan adalah yang
menggunakan chip GeForce
FX5970, FX5700 Ultra, dan
FX5700.

Pada awal 2004, produk-
produk tersebut tentunya mulai
bermunculan di pasaran. Salah
satu yang segera hadir adalah
Gigabyte GV-N57U128D. Dari
kode produksinya, tentu dapat
dikenali bahwa kartu grafis ini
menggunakan chip GeForce
FX5700 Ultra dengan memori
video sebesar 128MB.

Dari segi fisik, penampilan
produk kartu grafis ini cukup
menarik. Yang menjadi pusat
perhatian adalah fasilitas
pendinginan yang cukup
meyakinkan pada sisi depan
dan belakang board. Agar
tampak lebih mewah, fasilitas
tersebut diberi warna
keemasan. Demikian pula pada

I/O panel board.
Pada bagian belakang kartu

grafis, sebuah pelat heat
spreader terpasang dan
menempel dengan kuat untuk
menjalankan fungsinya
mendinginkan chip memori.
Sedangkan untuk
pendinginannya, selain terbuat
dari bahan aluminium padat, fan
pada heat sink kartu grafis ini
menggunakan teknologi yang
dapat mengatur kecepatan
putar kipas secara otomatis. Bila
sistem sedang menjalankan atau
mengolah aplikasi grafis, fan
akan bekerja dengan kecepatan
penuh, sedangkan bila sistem
sedang idle, atau hanya
menjalankan aplikasi 2D ringan,
maka kecepatan putar kipas
secara otomatis dikurangi. Hal
ini sangat bermanfaat terutama
untuk menekan tingkat
kebisingan.

Gigabyte tentunya
menyertakan kelengkapan
tambahan baik hardware
maupun software pada kemasan
penjualan GV-N57U128D ini. Dari
sisi software, selain CD driver
tersedia bundel game Will Rock,
Raven Shield, dan Tomb Rider:

Angel of Darkness serta software
PowerDVD. Dari sisi hardware,
kelengkapan tambahan yang
disertakan antara lain adalah DVI
to VGA adapter, S-video to RCA
adapter dan kabel S-video.

Dalam pengujian, kartu
grafis Gigabyte FX5700Ultra ini
dapat kami naikkan core clock-
nya sedikit demi sedikit hingga
ke angka 500MHz tanpa perlu
menaikkan tegangan ataupun

mengubah setting lainnya.
Pada clock tersebut, kartu

grafis masih dapat bekerja
dengan normal.

Untuk memory clock-nya,
kami mendapatkan angka

default 906MHz. saat kami coba
naikkan, kami dapat
meningkatkan angka tersebut
dengan software PowerStrip
sampai ke angka 1020MHz. Bila
dibandingkan dengan produk
sejenis yang pernah kita bahas
beberapa edisi lalu yang dapat
dinaikkan dengan lancar hingga
ke angka 1045MHz, peningkatan
clock memori hingga kurang
lebih sekitar 11 persen ini cukup

lumayan mengingat
jenis memori yang digunakan
pada Gigabyte FX5700 Ultra ini
adalah DDR 128-bit biasa.

Kami menguji kartu grafis ini
pada motherboard Abit AN7
dengan chipset nVidia nForce-2
Ultra 400 serta prosesor AMD

Athlon XP 3200+ yang
menggunakan FSB 400MHz.
Modul memori yang kami
pasang adalah dua keping
memori Kingston DDR400
masing-masing berkapasitas
512MB dengan mode dual
channel diaktifkan. Untuk
media penyimpanan kami
memakai Seagate Barracuda
7200.7 kapasitas 40GB. Sistem
operasi Windows XP Profes-
sional Service Pack 1 kami
gunakan dengan driver nVidia
ForceWare 52.16. (fmn)
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Nama PC Chips
sebenarnya sudah sangat lama
malang-melintang di bisnis
motherboard. Di era sebelum
Pentium-4, namanya cukup
beken untuk motherboard
kelas value lantaran beragam
serinya yang  murah-meriah. Di
era Pentium-4, hanya beberapa
seri saja yang muncul ke
permukaan. Salah satunya
adalah seri M935D yang
mengusung chipset bikinan SiS.

Dari chipset yang
diusungnya, nampaknya
Hanshing Technologies sebagai
perusahaan pembuatnya tetap
ingin berkutat pada pasar kelas
value. Menggunakan chipset
SiS650GX sebagai northbridge-
nya, sistem yang menggunakan
heatsink sebagai pendingin
chipset utamanya ini
mendukung frekuensi kerja
prosesor hingga 533MHz
dengan tipe memori dari kelas
Double Data Rate PC-2700 alias
PC-333 dengan kapasitas
maksimal hingga 2GB. Sebagai
motherboard  yang mendukung

prosesor Pentium-4, produk ini
juga sudah mendukung teknologi
Hyper-threading untuk eksekusi
yang lebih cepat. Chipset utama
ini juga memungkinkan
dihadirkannya port AGP yang
mendukung hingga mode 4X.

Sementara, dengan
menggunakan chipset
Southbridge-nya yaitu SiS96L,
selain mendukung adanya dua
buah slot PCI, produk yang punya
form factor berukuran microATX
ini mengusung pula sebuah slot
CNR di bagian tepi untuk kartu
yang berbasis slot ini. Seperti
kekhasan produk yang
menggunakan chipset SiS, untuk
sistem harddisk parallel ATA,
M935D ini juga mendukung
teknologi ultra ATA133 untuk
transfer data harddisk yang lebih
tinggi.

Tidak ada yang menonjol
dari MD935D ini selain adanya
fitur VGA onboard yang
merupakan ciri khas
motherboard kelas value. Untuk
fitur yang satu ini, disediakan
kemampuan share memori mulai

dari 8MB hingga 64MB pada BIOS
utamanya.

Untuk perangkat input-
output-nya, selain menyertakan
port PS/2 untuk mouse dan
keyboard, port serial, port
palalel, dan port VGA, disertakan
pula 4 buah port USB 2.0 plus
sebuah port RJ45 untuk
mendukung LAN

onboard yang mendukung
kecepatan 10/100Mbps. Tak lupa
diusung pula sebuah port audio
dengan 3 buah jack-nya untuk
dukungan sistem audio AC’97 .
Untuk BIOS yang ditawarkan,
konfigurasi dan fitur-fiturnya
masih menggunakan  versi
standar khas bikinan AMI.

PCplus menguji produk ini
dengan menggunakan prosesor
Intel Pentium-4 3,06GHz
FSB533MHz, memori Kingston
DDR PC-3200 1GB dua keping
yang bekerja pada frekuensi
333MHz (downclock), harddisk
Barracuda 7200.7 40GB, power
supply Enlight 420W, dan
monitor Samsung SyncMaster
990NF. Driver yang digunakan

adalah versi AGP117, IDE 203,
dan VGA versi 5.10.146.0.

Dari hasil yang didapatkan
dengan menggunakan VGA
onboard yang dimilikinya,
kinerja yang didapatkan
tergolong standar. Ini misalnya
dilihat dari skor SYSmark 2002
yang didapatkan. Begitu pula
pada pengujian dengan
TMPGencoder untuk menguji
beban prosesor pada sistem.
Waktu yang dibutuhkan
menyelesaikan tes relatif rata-
rata. Terasa mencolok adalah
masalah kestabilan yang masih
kurang. PCplus mendapati
sistem yang kurang stabil pada
beberapa pengujian yang
dilakukan.

Untuk calon pembeli yang
memiliki dana terbatas, produk
ini memang bisa jadi pilihan
lantaran cukup murah namun
memiliki fitur-fitur onboard
yang cukup banyak. Sayangnya,
dari sisi kemungkinan upgrade,
produk ini memang cukup
terbatas. (sil)
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Nama Compro
Technologies memang
belum akrab di telinga para
pemerhati TI di Indonesia.
Meski begitu, perusahaan yang
juga membuat produk untuk
OEM untuk beberapa
perusahaan besar ini ternyata
memproduksi cukup banyak
perangkat multimedia,
khususnya untuk PC. Seri
produk anyarnya yang dimulai
sejak tahun 2003 adalah TV
tuner yang salah satunya
adalah seri Video Mate TV
Gold.

Dari namanya, tuner yang
menggunakan chip bikinan
Philips ini memang bisa

berfungsi tidak hanya sebagai TV
tuner semata. Kemampuan lain
yang dimilikinya adalah FM tuner
maupun sebagai video dan image
capture. Tambah lagi, dengan
disertakannya sebuah jack
Composite-in, kartu yang
dilengkapi dengan remote
control sebagai pengendali
wireless ini juga dapat berfungsi
untuk menransfer file video dari
camcoder, DVD, VCD, dan lain
sebagainya.

VideoMate TV Gold yang
berwarna dasar hitam ini
memiliki beberapa buah jack
agar bisa terhubung dengan
perangkat lain. Untuk antena TV,
disediakan sebuah jack TV tuner-

in sementara untuk FM
disediakan jack FM tuner-in.
Untuk urusan suara, Compro
menyertakan dua opsi bagi
penggunanya. Selain dapat
menggunakan koneksi internal,
VideoMate TV Gold ini juga
menyertakan sebuah jack
external audio-out untuk koneksi
secara eksternal. Dan agar fungsi
remote control bisa bekerja
dengan baik, disertakan jack
untuk kabel infrared sebagai
receiver sinyal dari remote
control yang ada.

Paling unik dari produk yang
berbasis PCI ini adalah
kemampuannya untuk merekam
siaran TV yang sudah
dijadwalkan, meski PC dalam
keadaan mati. Hal ini
dimungkinkan lantaran
dihadirkannya 2 pin khusus yang
fungsinya sebagai perantara
untuk menghubungkan tombol
ATX power pada casing dengan
pin power pada motherboard.
Dengan tambahan fitur khusus
pada software bawaannya yaitu

ComproPVR, tuner ini dapat
menyalakan PC untuk merekam
siaran TV sesuai jadwal yang
dibuat sebelumnya. Jika sudah
selesai merekam, sistem juga
dapat dirancang untuk shutdown
secara otomatis atau dalam posisi
standby.  Fitur semacam ini tentu
menarik buat pengguna yang
sibuk dan ingin merekam siaran
TV tetapi tetap hemat listrik
karena tidak harus menyalakan
PC terus-menerus hanya untuk
melakukan perekaman.

Disediakan pula beragam
setting menarik untuk
perekaman video, baik untuk
suara maupun untuk formatnya.
Software utamanya juga
mengusung setting untuk
mengatur bit rate untuk audio
maupun video saat perekaman
dilakukan. Fitur lain yang dimiliki
juga cukup menarik semisal
adanya time shifting yang
membuat pengguna tidak
kehilangan satu momen pun
ketika menonton TV. Untuk
meng-capture gambar,

PT Leapfrog Indonesia
www.comprousa.com

☎ (021) 66604784
89 dolar AS

disediakan pula fasilitas capture
image pada user interface yang
disertakannya.

PCplus menggunakan
produk yang mampu
menangkap 69 saluran siaran TV
Indonesia (PAL B) ini dengan
cukup mudah. Selain
menyertakan fitur auto scan,
disediakan pula fitur fine tuning
untuk mengatur agar gambar
dan suara yang  ditangkap bisa
lebih baik. Secara umum, semua
fungsi yang diberikan sudah
befungsi cukup baik.

VideoMate TV Gold ini
cocok buat pengguna PC yang
ingin mengoptimalkan
sistemnya, termasuk untuk TV,
radio FM, maupun untuk
pengolahan video dari beragam
sumber. (sil)
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Sony DRU 510A:

Nikmatnya Membakar DVD
dalam Berbagai Format

Soca Marketing
www.sonystyle.com

☎ (021) 6347638
270 dolar AS

N2PAP-LITE:

Mobo nForce2 400
dari Jetway

PT Nusantara Eradata
www.jetway.com.tw

☎ (021) 6018218

SysMark 2002
Rating :269
Internet Content :342
Office Productivity:212

3D Mark 2001
640 x 480  16bit :16330
1024 x 768  32bit :13202
1600 x 1200  32bit :8653

3D Mark 2003
640 x 480 :5929
1024 x 768 :3863
1600 x 1200 :2110

Quake III Arena Demo 01
640 x 480  normal :330,8fps
1024x768 high quality:327,3fps
1600x1200high quality :172,8fps

TMPG encoder
37 menit 52 detik
(makin cepat makin baik)

Sebagai salah satu
brand yang cukup lama dikenal,
Jetway yang memiliki pabrik di
Cina ini cukup banyak
mengeluarkan seri
motherboard dari berbagai
kelas. Salah satu yang bisa
didapatkan di pasaran yang
berbasis prosesor AMD adalah
N2PAP-LITE.

Produk ini menggunakan
chipset bikinan nVidia yaitu
nForce2 400 yang secara penuh
telah mendukung penggunaan
prosesor AMD dengan Front
Side Bus 400MHz. Alhasil,
motherboard berbasis soket 462
alias soket A ini sudah
mendukung AMD Athlon dari
kelas Barton hingga 3200+.

Sementara, untuk
dukungan terhadap
memorinya, N2PAP-LITE yang
memiliki dua buah soket DIMM
ini juga sudah mendukung
penggunaan memori Double
Data Rate dengan frekuensi
kerja efektif sebesar 400MHz
alias PC-3200 yang berarti
memori dan prosesor akan

Sony yang
merupakan salah satu
perusahaan elektronik
terkemuka di dunia memang
seringkali menjadi pionir untuk
produk-produk berteknologi
teranyar. Dalam urusan DVD
misalnya, Sony menjadi salah
satu produsen yang ikut serta
menciptakan perangkat DVD
yang mampu membaca semua
format yang berkembang saat
ini.

Salah satu perangkat optik
yang saat ini ada di pasaran
adalah seri Sony DRU 510A. Seri
ini merupakan versi internal
yang memanfaatkan ATAPI/EIDE
sebagai interface data ke sistem
PC.

Datang dengan warna
putih keperak-perakan, DRU
510A memang menjanjikan
kepuasan buat pengguna PC
yang menginginkan
perangkatnya menjadi serba
multifungsi namun
menggunakan perangkat
simpel. Produk yang
dipersenjatai dengan sebuah
tombol pembuka dan penutup,
lampu LED sebagai indikator,
dan lubang emergency pada
bagian depan ini memang
dapat digunakan untuk banyak
kegunaan. Paling canggih
adalah fungsinya sebagai DVD
recorder yang mampu
menyimpan data dalam
beragam format DVD, yaitu
format DVD+RW, DVD-RW,
DVD+R, dan DVD-R. Format

bekerja secara sinkron alias
memakai frekuensi kerja yang
sama. Meski begitu, memori DDR
dengan jenis varian di bawahnya
juga masih didukung oleh produk
dengan warna dasar merah ini.
Sebagai   sistem yang dirancang
untuk kelas performance, N2PAP
ini dipersenjatai dengan sebuah
port AGP dengan mode hingga
8X hingga mampu menransfer
data grafik dengan bandwidth
yang tinggi.

Sementara, untuk dukungan
fitur-fitur penting Jetway
mengusung nVidia nForce 2 MCP
sebagai Southbridge-nya. Dengan
demikian, selain mampu
menampung hingga 5 buah slot
PCI, N2PAP-LITE yang
menggunakan heatsink sebagai
pendingin chipset utamanya ini
juga menyediakan teknologi
ultra ATA 133 untuk transfer data
harddisk paralel yang cepat.
Untuk versi LITE ini, Jetway
menambahkan fitur LAN onboard
yang mendukung transfer data
hingga 10/100Mbps. Tak lupa
juga disertakan sebuah kartu

suara onboard
AC’97 dari
kelas Realtek
yang
mendukung
penggunaan
sistem tata suara
6 kanal.

Fitur input-output yang
diberikan tergolong lumayan.
Selain menyertakan port-port
standar seperti port PS/2, port
serial, dan port paralel,
disertakan 4 buah port USB 2.0
yang bisa diekspansi hingga
mencapai 6 buah. Pada kemasan
jualnya, Jetway menyertakan
pula sebuah buku manual yang
cukup lengkap, CD driver, serta
kabel data standar.

Dari sisi arsitekturnya, posisi
semua fitur yang disertakan
tergolong standar. Hanya ATX
power connector saja yang agak
sedikit mengganggu karena
diletakkan di bagian tengah dan
berpotensi mengganggu aliran
udara pada bagian prosesor.
Untuk pengaturan FSB yang
digunakan, selain dapat melalui

BIOS, disertakan pula sebuah
jumper untuk pengaturannya.

PCplus menguji produk ini
dengan menggunakan Athlon XP
3200+ FSB 400MHz, memori
Kingston PC-3200 1GB dua
keping, harddisk Seagate
Barracuda 7200.7 40GB, VGA
Albatron FX5700 256MB, dan
power supply Enlight 420W.
Driver yang digunakan adalah
versi 3.13 untuk chipset-nya dan
versi 52.16 untuk driver VGA.

Dari skor yang diperoleh,
terlihat kinerja sistem  yang
cukup lumayan meski tidaklah
terlampau tinggi bila dibanding
dengan produk sejenis yang
pernah diuji sebelumnya.
Kestabilan yang diberikan
tergolong memuaskan karena
semua uji dapat dilalui dengan
sangat mulus. (sil)

data yang bisa disimpan pun
boleh dibilang cukup lengkap,
mulai dari file data, musik, video,
gambar, maupun film, dengan
kapasitas maksimal 4,7 Gigabyte.

Menariknya, lantaran masih
sebagai produk baru,
dukungan kecepatan
tulis maupun
baca yang
ditawarkan
untuk format
DVD pun
sudah dari
kelas yang
tercepat.
Untuk
DVD+RW
sebesar 4x, DVD-RW
sebesar 2x, DVD-R sebesar
4x, dan DVD+R sebesar 4x. Tak
hanya itu, untuk penyimpanan
data yang lebih kecil, produk
yang dirancang bekerja pada
sistem operasi Windows ini  juga
mampu membakar maupun
membaca data dalam format CD
biasa seperti layaknya sebuah CD-
RW drive ataupun CD-ROM drive.

PCplus menguji produk yang
memiliki memori penyangga

sebesar 8 Megabyte ini dengan
menggunakan sistem berbasis
Pentium-4 3,2GHz FSB 800MHz
dengan memori sebesar 512MB,
menggunakan keping DVD
merek

Verbatim
berkecepatan
tertinggi untuk
membuktikan klaim pabrik
pembuatnya untuk urusan
kecepatan penulisan dan
pembacaan. Hasilnya, untuk
pembakaran pada DVD-RW,

kecepatan pembakaran mencapai
1,81x dari klaim 2x, DVD+RW
sebesar 2,31x dari klaim 2,4x, dan
untuk DVD+R sebesar 3,60X dari
klaim 4x.

Menariknya, ketika hasil
bakaran diuji kualitasnya dengan

Nero Scan Disk untuk uji
Surface Scan

dan
File Test, hasil

yang diperoleh
cukup

mengagumkan untuk
keempat format CD yang
berbeda. Semua hasil bakaran
100 persen dalam keadaan baik
dan semua file dapat dibaca
dengan baik.

Pada kemasan jualnya,
selain menyertakan beberapa
buku manual yang cukup
lengkap, Sony juga
menyertakan bundel software
Nero Burning  sebagai software
penulisan, serta dilengkapi
juga dengan kabel data.
Disertakan pula baut sebagai
pengunci jika produk ini
dipasang pada casing.

Buat pengguna PC yang
menginginkan penyimpanan
data dengan kapasitas besar,
produk ini memang bisa jadi
salah satu pilihan menarik.
Apalagi kemampuan tulis dan
bacanya juga tergolong baik
dengan tawaran kecepatan
tertinggi saat ini. Dukungan
terhadap  beragam format
pun jadi nilai plus dari produk
ini. Namun, harga yang
ditawarkan juga masih
tergolong tinggi. (sil)
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Hi-Tech Mall Surabaya:
Menatap Parasit
Indonesia Timur

T.J. Setyoadi
dino@e-pcplus.com

B

THR di Surabaya
memiliki tempat

tersendiri dalam hati
masyarakat Surabaya.

Sebagai pusat
hiburan, di tempat ini

dulu Srimulat sering
berpentas. Kini,

setelah keberadaan
mall yang megah, ia
ingin mengukuhkan

diri sebagai pasar
komputer dan TI

terbesar di Indonesia
bagian timur. Seperti

apakah kondisi
sesungguhnya dan

apa tekadnya di
tahun monyet ini?

eberapa
tahun lalu
keadaan pertokoan ini
cukup

memprihatinkan. Jika dikatakan
sebagai pusat perbelanjaan dan
rekreasi, mall ini terbilah cukup
sepi dari pengunjung.
Masyarakat Surabaya mengenal
pertokoan yang berlokasi di
jalan Kusumabangsa sebagai
Surabaya Mall. Banyak pula
yang menyebutnya dengan THR
Mall. Pusat pertokoan yang
terletak di sisi Taman Hiburan
Remaja dahulu memang tak
banyak dikunjungi orang.

Suasana pertokoan ini
sedikit berubah setelah
melakukan reposisi dari pusat
pertokoan biasa menjadi pusat
pasar komputer. Pusat
pertokoan ini berganti nama
menjadi Hi-Tech Mall. Setelah
melakukan reposisi menjadi
pusat penjualan komputer, CD,

Games, handphone,
serta alat-alat
elektronik, mall ini
kembali menggeliat.
Sebagai layaknya
sebuah pertokoan
aktivitas jual-beli
kembali ramai.

Pada awal berdiri
Hi Tech Mall dihuni
oleh 50 toko yang
menjual peralatan
komputer. Tahap
demi tahap jumlah
menyewa lahan toko
pun bertambah. Kini
ada sekitar 400 toko
yang menjual
peralatan komputer
dan aksesorisnya,
serta HP. Di awal
tahun 2004 toko-toko
tersebut diperkirakan mencapai
sekitar 70% dari seluruh penyewa
Hi-Tech Mall.

Selain sebagai pusat pen-
jualan produk-produk IT, eksibisi
dan workshop-workhop berbau
IT banyak digelar di mall ini. yang
berlantai 4 ini. Misalnya saja yang
telah dilaksanakan setiap bulan
bersama Tabloid PCplus.

Setelah tiga tahun
melakukan penjajagan dalam

pasar teknologi informasi, Hi
Tech Mall akhirnya bertekad
memfokuskan diri sebagai pusat
pasar IT.  Repositioning ini
dilakukan oleh PT Sasana Boga
sebagai pengelola Hi Tech Mall
dalam jumpa pers pada 19
Januari lalu di kantor PT Sasana
Boga, Ruddy Sukamto, asisten
General Manager Hi-Tech Mall
menceritakan alasan pergantian
nama dari Surabaya Mall  ke Hi-

Penjualan prosesor Intel lewat jalur tak resmi seperti yang
beredar sekarang ini sebetulnya sudah berlangsung agak

lama, sekitar 2 tahun. Dari segi barang yang dijual, ciri-ciri
fisiknya memang terlihat beda kalau dibandingkan

langsung. Yang palsu kelihatan lebih jelek, dan merek
yang disablon pun kelihatan sekadar asal sablon.

idak semua toko komputer di Surabaya
menjual prosesor ini, dan mereka menjualnya pun ke orang yang tidak
tahu sama sekali mengenai komputer. Tapi prosesor yang dipalsu ini hanya
Pentium I sampai III saja, untuk Pentium-4 tidak ada atau belum beredar di

pasar Surabaya. Para toko yang menjual prosesor palsu ini tidak bisa memperkirakan
apakah prosesor palsu Pentium-4 akan ada di pasaran. Sebab sampai saat ini mereka
masih belum mendapat tawaran dari siapapun tentang prosesor palsu Pentium-4.

Asal prosesor palsu ini sendiri tidak jelas, tapi kemungkinan besar impor dari
Hong Kong. Tidak jelas pula apakah prosesor palsu ini adalah prosesor asli yang
disablon ulang atau mereka betul-betul membuat yang palsu. Tapi tampaknya
bahwa prosesor palsu ini memang dibuat oleh orang lain yang bukan Intel.

Barang yang tersedia cukup banyak, dan mereka bisa mendapatkannya secara
teratur. Hal ini merupakan salah satu indikasi bahwa prosesor palsu ini memang
betul-betul diproduksi oleh pihak lain selain Intel.

Performance-nya dinilai cukup bagus bila digunakan secara normal. Para penjual
menyatakan bahwa sampai saat ini tidak ada komplain mengenai prosesor palsu
tersebut, kecuali bila prosesor tersebut digunakan untuk overclock, pasti hang. Jadi
kinerja prosesor palsu ini jeleknya hanya bila di-overclock saja, tapi bila digunakan
secara normal tidak ada masalah sama sekali.

Dealer Intel di Surabaya yang ditemui PCplus, Willy dari Astrindo Surya,
mengatakan bahwa dia mendengar adanya prosesor palsu ini. Namun dia tidak
merasa bahwa dampak adanya prosesor palsu ini akan mengganggu omsetnya. Dia
juga tidak mengetahui bahwa prosesor palsu tersebut hanya ada pada Pentium III ke
bawah. Namun dia merasa yakin bahwa prosesor palsu ini tidak akan mengganggu
omset penjualannya.

Mungkin Willy ada betulnya, pertama karena yang dia jual saat ini adalah kelas
Pentium-4 saja sedangkan yang dipalsu adalah Pentium III ke bawah. Yang kedua,
bahwa jika prosesor palsu Pentium-4 muncul, pasti langsung bisa diketahui karena
motherboard keluaran terbaru pasti punya fasilitas overclock secara otomatis, jadi
jika performance-nya di bawah standar pasti langsung hang.

Para penjual prosesor palsu ini pun tidak menjual secara terang-terangan, pada
umum mereka menjualnya dengan paket komputer. Ciri yang paling mudah
kelihatan adalah harganya yang murah. Kemudian tentu saja prosesor palsu ini tidak
ada box seperti yang aslinya.

Untuk saat ini mereka masih aman-aman saja dari komplain pelanggan, karena
prosesor ini memang masih cukup stabil bila digunakan secara normal. Dan jika
pelanggan mereka tampak mengetahui cukup banyak tentang komputer, maka
mereka akan memakaikan prosesor yang asli. Jadi untuk orang awam, cukup sulit
untuk mengetahui keberadaan prosesor palsu. PC+

Adakah Prosesor Palsu
Beredar di Surabaya?

T.J. Setyoadi
dino@e-pcplus.com

T

Tech Mall.
Hi-Tech Mall yang

mempunyai luas lahan plus area
parkir 97000 m+ ini berencana
membuka ruang hot spot
(wireless area) Internet di setiap
toko. Di lantai empat akan di
bangun ruang pameran IT seluas
8000m+. Sampai saat ini HI Tech
Mall memiliki 400 tenant.

Selama ini jalur pasar IT
masih memusat di Jakarta.

Membaca peluang ini, Ruddy
berprediksi bahwa pasar di
wilayah Indonesia Timur belum
terjajagi. Diharapkan melalui
Hi-Tech Mall jalur penjualan
komputer ke Indonesia bagian
Timur bisa dipotong, sehingga
akhirnya produk IT yang murah
untuk Indonesia Timur bisa
tersedia. “Target kami dua
tahun ke depan Hi Tech Mall
menjadi pusat market IT
Indonesia Timur,” ujar Ruddy
menjelaskan kepada para
wartawan di kantornya.

Dilihat dari lokasi mall
yang berhadapan dengan
taman makam pahlawan (TMP )
Kusumabangsa, Hi-Tech Mall
relatif mudah dijangkau
dengan kendaraan umum dari
arah manapun di kawasan
Surabaya.

Menarik untuk ditunggu,
apakah Hi-Tech Mall bisa
mengukuhkan diri sebagai
pusat belanja IT, mengingat
pesaing-pesaing baru juga
bermunculan, seperti halnya
Makassar Trade Centre yang
juga tampaknya akan
memosisikan diri sebagai pusat
belanja IT di kawasan timur
Indonesia. PC+

WISNU/PCplus

Salah satu cara untuk mendongkrak popularitas Hi-Tech Mall adalah dengan
menyelenggarakan workshop merakit PC.
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Pramadhi Jatmika
pramadhi@hotmail.com Need For Speed Underground:

Balapan Jalanan
Bergaya Arcade

J

Need For Speed
(NFS) bisa dikatakan

satu-satunya game
balapan yang

mempunyai judul seri
terbanyak saat ini.
Akan tetapi, dari 6

seri yang telah
beredar, hampir

semuanya menawar-
kan tipe permainan
yang sama, balapan

dalam satu sirkuit
disertai dengan aksi

kejar-kejaran dengan
mobil polisi -

contohnya dalam NFS
High Stakes dan NFS
Hot Persuit 2. Sudah
merasa bosan dengan

NFS?

angan, deh!
Pada bulan November
2003 lalu, Electronic Arts
(EA) bersama divisinya,

Black Box, meluncurkan seri ke-7
yang berjudul NFS Underground.

Seri terbaru ini bisa dibilang
sangat berbeda dari seri-seri
sebelumnya.

Sesuai dengan judulnya, NFS
Underground merupakan game
balapan ilegal bergaya arcade
yang berseting di sebuah kota.
Tekan gas dalam-dalam, gunakan
turbo, tambahkan nitro, maka
mobil akan berlari secepat kilat.

Dalam tiap pertandingan ada
3 tingkat kesulitan yang bisa kita
pilih. Sebelum memulai
permainan, kita harus membuat
profil nama pemain terlebih
dahulu.  Untuk memulai karir
sebagai pembalap jalanan, kita
bisa langsung menuju Go
Underground. Hanya dengan
bermodalkan sejumlah uang, kita
bisa mengikuti pertandingan
balapan untuk duduk di peringkat
pertama.

Jenis balapan yang
dipertandingkan dalam Go
Underground cukup bervariasi –
balapan circuit, sprint, drag, drift,
lap knockout, time-trial, dan
tournament. Balapan circuit
berlokasi dalam sebuah sirkuit,
sistem perhitungannya adalah

berdasarkan putaran atau lap.
Sprint hampir mirip dengan circuit,
bedanya sprint hanya
mempertandingkan satu putaran
saja. Drag bisa dibilang sebagai
balapan andalan, yaitu balapan di
sebuah lintasan yang lurus dan
panjang. Dalam drag, perpindahan
perseneling gigi harus dilakukan
secara manual, di sini kita akan
mendapatkan pengalaman baru
yang menegangkan dalam
mengemudi.

Drift merupakan salah satu
jenis balapan baru. Dalam balapan
ini, mobil meliuk-liuk di sebuah
sirkuit yang pendek dalam
beberapa putaran. Balapan lap
knockout mirip dangan circuit,
hanya saja di setiap putaran, mobil
yang berada di urutan paling
belakang akan kalah dan hal ini
akan terus berlanjut sampai jumlah
putarannya habis. Time-trial, dari
namanya saja kita sudah bisa
menebaknya, merupakan jenis
balapan yang dihitung berdasarkan
waktu yang telah ditentukan.
Sedangkan tournament merupakan
sebuah pertandingan besar yang
terdiri dari beberapa jenis balapan
sekaligus.

Hadiah yang bisa dimenangkan
juga bermacam-macam. Selain
uang, bonus juga bisa berupa servis
upgrade mobil, bonus pemasangan
wajah kita di sampul depan sebuah
majalah, atau bonus penawaran
mobil dan sirkuit baru. Sebagai
informasi, bonus dalam game ini
menggunakan sistem “Unlock”,
bonus yang diberikan tergantung
pada jumlah nilai (style points) yang
dikumpulkan dan jumlah
pertandingan yang telah
diselesaikan. Makin banyak jumlah
nilai dan pertandingan, makin
banyak pula bonus yang bisa
diperoleh atau di-unlock.

Di sela pertandingan, kita bisa

melakukan modifikasi mobil
dengan memilih elemen Customize
Ride. Elemen ini merupakan fitur
baru yang tidak mungkin kita
temukan pada seri-seri terdahulu.
Modifikasi yang dilakukan meliputi
2 bagian, visual dan performance.
Bagian visual merupakan bagian

eksterior – mulai dari bodi mobil
(bumper, spoiler, kap mesin, atap
dan lain-lain), roda (beserta velg-
nya), aksesoris (lampu depan/
belakang, lampu neon, knalpot dan
kaca film), serta hiasan lain seperti
decals dan vinyls. Bagian perfor-
mance berkaitan mesin, sistem
bahan bakar, sistem penggerak,
suspensi, sistem pengereman,
penggunaan turbo, serta nitrous
oxide (nos).

Ada lebih dari 20 jenis mobil
sedan yang digunakan dalam NFS
Underground. Mereka adalah
mobil-mobil asli yang berlisensi, di
antaranya adalah Mazda Miata MX-
5, Toyota Celica GT-S, Mitsubishi
Eclipse GSX, Toyota Supra, Nissan
Skyline R34 GTR, Acura Integra
Type-R, dan Volkswagen GOLF GTI.

Pengendalian AI (Artificial
Intelegence) pada mobil lawan
sangat tangguh namun sering
terlihat curang. Ketika balapan,
mobil-mobil lain yang berlalu-lalang
seolah-olah sudah diatur untuk
menjebak kita. Saat menuju sebuah
perempatan, terkadang datang
sebuah mobil yang ingin mencoba
menghalangi padahal acara cegat-
mencegat ini jarang terjadi pada
mobil yang dikemudikan lawan.

Yang dimaksud dengan sangat
tangguh disini adalah mobil lawan
pandai memilih jalan pintas dan
mampu menghindari rintangan
dengan baik.

NFS Underground selain
menyediakan pilihan Go Under-
ground untuk karir single player,
juga menyediakan opsi Quick Race
dan Play Online. Untuk mode karir
sendiri terdapat 111 pertandingan
balapan dengan 20 lintasan yang
berbeda.

KUALITAS GRAFIS
NFS Underground mempunyai

tampilan paling bagus di kelasnya.
Semua fisik mobil mobil di-render
dengan sangat baik. Desain
eksterior mobil dibuat sangat detil
dan berkesan mengkilap dipenuhi
pantulan dari setiap objek di
sekitarnya. Jalan-jalan lintasan juga
berkesan basah sehingga tampak
licin. Tata kota dibuat dengan baik
dan rapi, efek pencahayaan pun
dibuat dinamis. Yang paling
memukau dan mengagumkan
adalah adanya efek motion-blur
yang mengakibatkan gambar
tampak kabur ketika kecepatan
dipacu tinggi oleh bantuan nitro.
Efek lain yang memperindah game

Genre : Racing
Platform : PC, PS2,

Xbox dan
GameCube

Publisher : Electronic
Arts

Developer : Electronic
Arts, Black
Box

Persyaratan Minimal :
• Prosesor Intel Pentium

III atau setara 700 MHz
• RAM 128MB
• Kartu Grafis 32MB

(GeForce2 atau lebih)
• DirectX 9.0
• Soundc card yang

kompatibel dengan
DirectX

• Ruang harddisk 2GB
• CD-ROM 8x
• MS Windows 98/ME/200/

XP

ini adalah adanya efek gerak
lambat pada saat mobil melompat
dan bertabrakan.

KUALITAS SUARA
Bayangkan suara mesin yang

meraung-raung, suara ban yang
selip bergesekan dengan aspal,
dan suara logam yang menyayat
telinga. Semua itu dibuat sangat
solid dalam NFS Underground.
Sedangkan untuk lagu soundtrack-
nya, EA menyediakan beragam
pilihan musik yang berirama cepat
maupun lambat, mulai dari jenis
heavy metal, rock sampai musik
rap. Dengan adanya sertifikasi dari
THX, kualitas total suara yang
dihasilkan menjadi lebih mantap,
terutama apabila kita mempunyai
sistem speaker kelas atas.

NFS Underground memang
game yang bagus, tapi juga masih
memiliki kekurangan, contohnya
mobil bisa dapat rusak, baik itu
secara fisik maupun teknis. Jalur
lintasan yang dipertandingkan
juga tidak ada perubahan, yang
ada hanyalah perpindahan arah
arus perjalanan. Fitur modifikasi
performa telah dikategorikan
dalam bentuk paket, dan modifi-
kasi terbaik hanya bisa didapatkan
pada pertandingan terakhir. Keku-
rangannya lagi, keramaian mobil
yang lalu-lalang sangat sedikit dan
polisi-polisi yang biasanya menjadi
ciri khas NFS seolah-olah
menghilang dari peredaran.

Secara keseluruhan atas
pertimbangan dari segala kelebih-
an dan kekurangan yang dimiliki
NFS Underground, game ini tetap
terbukti menjadi yang terbaik dari
serial NFS yang menjadi pilihan
tepat bagi para penggemar
balapan bergaya arcade murni,
terutama para NFS mania. PC+
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MOTHERBOARD

Asus P4S800, SiS648FX, 5 PCI,
AGP 8X, USB 2.0, HTT 95
Asus P4PE-X, i845PE, AGP4X,
DDR, 6PCI, USB2.0, Hyper-threading 85
Asus P4SDX, SiS655, AGP8X, DDR,
6PCI, USB2.0, Hyper-threading 71
Asus P4C800 Deluxe, Intel 875,
FSB800, ATA100, RAID, AGP Pro 210
Asus P4P800 Deluxe, i865, FSB 800,
ATA100, 4DDR 158
Asus P4T-CM, i850, soket 423,
FSB400, ATA100, 2RDRAM 63
Asus P4P800, i865, FSB800, 4DDR,
RAID, LAN, audio 137
Asus P4C800, i875, FSB800, 4DDR,
RAID, Audio, Gigabit LAN 189
Asus P4P800 +WiFi, i865PE, FSB800,
ATA100_SATA, 4DDR, audio 179
Asus P4S533-MX, SiS651 FSB533,
ATA133, 2DDR+ 2SDR, audio,
VGA onboard 70
Asus P4S8X/L 1394, SiS648, FSB533,
3DDR, AGP8x, audio, Serial ATA, 1394 131
Asus P4S8X-X , SiS648, FSB533,
ATA133, AGP8x, 3DDR, audio,
Gigabit LAN 67
Asus P4P800S, i848P, FSB800, 2DDR,
audio, S/PDIF 111
Asus A7V8X/L 1394, KT400, ATA133,
AGP8x, FSB266, 3DDR, audio,
LAN, 1394 126
Asus A7V600, VIA KT600, 6 PCI,
3DDR, AGP8x 107
Asus A7N8X-X, NForce2, ATA133,
5 PCI, 3DDR, audio dolby, AGP8x 101
Asus A7V8X/L, VIA KT400, 6 PCI,
3DDR, SATA, ATA133 116

APLUS AP984 SATA, i865PE,
FSB 800MHz, 4DDR400, ATX, AC97 91
APLUS AP981,i845GE, FSB 533MHz,
2DDR, ATX, AC’97 74
APLUS AP980, i845PE, ATX,
FSB533,2DDR333 SOUND AC97 68
APLUS AP986 VIA P4X400, ATX,
FSB533, SOUND AC97 6 channel,
3DDR400, AGP8X 52
APLUS AP976E2, VIA P4X266E, FSB
533MHz, 2DDR,M- ATX, AC’97 49
APLUS AP976, VIAP4X266E,
FSB 400MHz, 2DDR, M-ATX, AC’97 48
APLUS AP972A3 VIA P4M266A,
ATX, 533FSB, SOUND AC97, 2DDR 49
APLUS AP982 VIA KT400, ATX,
266FSB, SOUND AC97, 3DDR 62
APLUS AP975 VIA KT333, ATX,
266FSB, SOUND AC97, DDR333 60

MSI 875P Neo FIS2R, i875P, ATX,
FSB800, 2DIMM, ATA100, AGP8X, 6PCI 200
MSI P4MAM-L, VIAP4M266A, ATX,
FSB533, 2DIMM, ATA133, AGP4X, 3PCI 59
MSI 651M-L, SiS 651, m-ATX,
FSB533, 2DIMM, ATA133, AGP4X 66
MSI 648 MAX-V, SiS 648x, ATX,
FSB533, 3DIMM, ATA133, AGP8X, 6PCI 68

MSI 848P Neo-S, i848P, FSB800MHz,
AGP8X, 2GB DDR400, SATA, 5PCI 94
MSI 648F Neo, SiS648FX, FSB800MHz,
AGP8X, 3GB DDR ATA133, SATA,
AGP8X 78
MSI 645GVM, I845GV, Matx, FSB533,
2DIMM, ATA100, AGP4X, 6PCI 72
MSI 845PE Max, I845PE, ATX, FSB533,
2DIMM, ATA100, AGP4X, 6PCI 74
MSI 865PE Neo2, I865pe, ATX, FSB800,
2GBDDR, ATA133, AGP8X, 5PCI 120
MSI K7N2 Delta-L, nForce2, ATX,
FSB400, 3GB DDR, ATA133,
AGP8X, 5PCI 102
MSI K8T Neo-FIS2R, VIA K800T800,
ATX, FSB800, 3DDR, ATA133,
AGP8X, 5 PCI 180
KT4V, Via KT400, ATX, FSB333,
3GBDDR, ATA133, AGP8X, 6PCI 72

Matsonic 9158E+, VIA P4M266,
FSB533, USB2.0, VGA ONBOARD 49
Matsonic 9127C, VIAP4X400, FSB533,
USB2.0, DDR400, AGP8X 55
Matsonic 9327D+, SIS650, FSB533,
USB2.0, 2DDR, VGA ONBOARD 54
Matsonic 9337C, SIS648, FSB533,
USB2.0, 3DDR400, AGP8X 64
Matsonic 9377C, SIS648FX, FSB800,
3DDR400, AGP8X, HTT 69
Matsonic 9367E, SIS 650GX, FSB533,
2DDR, VGA ONBOARD +AGP 55
Matsonic 8137C, VIA KT266A, FSB266,
2DDR, VGA ONBOARD +AGP 49
Matsonic 8157E, VIA KM266, FSB 266,
2DDR, AUDIO, VGA ONBOARD + AGP 58
Matsonic 8167C, VIA KT333, FSB266,
3DDR333, AGP 4X, AUDIO 51
Matsonic 8147C, VIA KT400A, FSB333,
3DDR400, AGP 8X, LAN ONBOARD 59

Gigabyte GA-7VKMP-P, VIA AKM266,
ATX, Soket A, ATA133, LAN 65
Gigabyte GA-7VA, VIA KT400, ATX,
Soket A, ATA133 79
Gigabyte GA-7N400-EL, nForce2 ultra,
ATX, Soket A, ATA133 99
Gigabyte GA-7N400 Pro,
nForce2 ultra, ATX, Soket A 150
Gigabyte GA-7NNXP, nForce2 Ultra,
FSB400, 4DDR, 5 PCI 212
Gigabyte GA-7NNXPV, nForce2,
FSB333, 4DDR, 5PCI 242
Gigabyte GA-S648,  SiS 648, ATX,
FSB533, ATA133, AGP8X, 5PCI 73
Gigabyte GA-S648FX, SiS 648FX,
ATX, FSB800, ATA133, 5PCI 97
Gigabyte GA-SINXP 1392 DDR400,
SiS655, ATX, FSB533, ATA133 167
Gigabyte GA-S648-L, SiS648,ATX,
FSB533, ATA133, 5PCI 75
Gigabyte GA-8IPE1000, i865PE,
ATX, FSB800, 4DDR, 5PCI 127
Gigabyte GA-8PE800Ultra+Raid,
i845PE, ATX, FSB800, ATA133 92
Gigabyte GA-8KNXP+Raid+ SATA,
i875P, ATX, FSB800, ATA133, AGP pro 217
Gigabyte GA-K8N, Nforce3 150,
FSB800, 3DDR, ATA133,
AGP8X, 5PCI 132
Gigabyte GA-K8NNXP, Nforce3 150,
FSB800, 3DDR, SATA, AGP8X, 5PCI 217
Gigabyte GA-K8VT800M, VIAK8T800,
FSB800, 3DDR, SATA, AGP8X, 5PCI 122
Gigabyte GA-K8VNXP, VIAK8T800,
FSB800, 3DDR, SATA, AGP8X, 5PCI 207

DFI LAN Party Pro875, i875P, ATX,
FSB800, AGP8X, 2SATA 190

DFI LAN Party KT400A, VIA KT400A,
ATX, FSB400, AGP8X, 1SATA 130
DFI LAN Party NF II Ultra, nForce 2,
ATX, FSB400, AGP8X, 1SATA 155
DFI PS83-BL, i865PE, ATX, FSB800,
AGP8X, 2SATA 85
DFI 648FX-ALE, i648FX, ATX,
FSB800, AGP8X, DDR 400 67
DFI P4X800-AL, VIA P4X400, ATX,
FSB533, AGP8X, ATA133 52
DFI KT400A Infinity, VIA KT400A,
ATX, FSB333, AGP8X, 1SATA 88

Iwill mP4G2S, i845GL, soket 478,
FSB400, LAN, DDR, 65
Iwill mP4G2, i845GV, soket 478,
FSB533, DDR, 68
Iwill P4G, i865PE, soket 478,
FSB800, LAN, DDR, serial ATA 69
Iwill P4HT2, i845PE, soket 478,
FSB 533, DDR, Audio, 78
Iwill P4SE, i865PE, soket 478,
FSB 800, DDR, Audio, ATA100,
Serial ATA 110
Iwill DX400-SN, ii860, soket 603,
RDRAM, Dual Pro include casing, SCSI 999

Soltek SL-87CW-FL, i875P, AGP8X,
ATX, 4DDR 172
Soltek SL-86MPI-L, i865P, AGP8X,
ATX, 2DDR 98
Soltek SL-85MIR3-L, i845GE,
AGP4X, mATX, 2DDR 74
Soltek SL-85MIV4-L, VIA P4M266A,
2 PCI, mATX, 2DDR 55
Soltek SL-85MIV3-L, VIA P4M266A,
3 PCI, mATX, 3DDR 55
Soltek SL-KT600-RL, VIA KT600,
6PCI, ATX, 3DDR 73
Soltek SL-75MRN-L, nForce2,
5PCI, ATX, 3DDR 91
Soltek SL-KT400A-L, VIA KT400A,
6PCI, ATX, 3DDR 62
Soltek SL-75MIV2-L, VIA KM400,
3PCI, mATX, 2DDR 69

Abit IC7 Max III  i875P, FSB800MHz,
4 DDR, AGP 8X, 5 PCI 325
Abit BE7, i845PE, FSB 533MHz,
3 DDR, AGP 4X, 5 PCI 102
Abit BH7, i845PE, FSB 800MHz,
3 DDR, AGP 4X, 5 PCI 94
Abit IC7 MAX III, i875P, FSB 800MHz,
4 DDR, AGP 8X, 5 PCI 233
Abit IC7, i875P, FSB 800MHz,
4DDR, AGP 8X, 5 PCI 143
Abit AI7, i865PE, FSB 800MHz,
4 DDR, AGP 8X, 5 PCI 144
Abit IC7G i875/ICH5-R, FSB 800MHz,
4 RIMM, AGP 8X, 5 PCI 190
Abit IS7E, i865PE, FSB 800MHz,
4 DDR, AGP 8X, 5 PCI 109
Abit IS7, i865PE, FSB 800MHz,
4 DDR, AGP 8X, 5 PCI 133
Abit VI7, VIA PT800, FSB 800MHz,
2 DDR, AGP 8X,  5 PCI 94
Abit KV7, Via KT600/8235,
FSB 400MHz, 4 DDR, AGP 8x, 6 PCI 93
Abit NF7S, nVidia nForce2,
FSB 333MHz, 3 DDR, AGP 8X, 3 PCI 116
Abit KD7-A, Via KT400,
FSB 333MHz,
4DDR, AGP 8X, 6 PCI 84
Abit NF7, nForce 2,
FSB 333MHz,
3 DDR, AGP 8X, 3 PCI 93
Abit NF7-SL, nForce 2,
FSB 333MHz,
3DDR, AGP 8X, 3 PCI 111

Kingston 128MB DDR PC2100 22.5
Kingston 256MB DDR PC2700 42
Kingston 512MB DDR PC2700 81
Kingston 256MB DDR PC3200 45
Kingston 512MB DDR PC3200 89

MCPRO 512MB DDR PC-3200 86,5
MCPRO 256MB DDR PC-3200 43.5
MCPRO 512MB DDR PC-2700 84,8
MCPRO 256MB DDR PC-2700 40.6
MCPRO 128MB DDR PC-2100 20.7

MULTIMEDIA CARD

MCPRO 64MB 22
MCPRO 128MB 35
MCPRO 256MB 69,5

Twinmos MMC 64MB 27.5
Twinmos MMC 128MB 41

Visipro 64MB 26
Visipro 128MB 43
Visipro 256MB 75

COMPACT FLASH

MCPRO Flash memory 32MB 17
MCPRO Flash memory 64MB 21.5
MCPRO Flash memory
128MB 37.5
MCPRO Flash memory 256MB 54

Visipro Flash Memory 64MB 26
Visipro Flash Memory 128MB 42
Visipro Flash Memory 256MB 65
Visipro Flash Memory 512MB 125

MEMORI

Visipro 128MB (4 IC) PC 133 30
Visipro 128MB (8 IC) PC 133 38
Visipro 256MB (8 IC) PC-133 60
Visipro 256MB (16 IC) PC-133 73
Visipro 512MB PC-133 110
Visipro 128MB (8 IC) PC-2100 26
Visipro 256MB (8 IC) PC2100 45
Visipro 256MB (16 IC) PC2100 Call
Visipro 512MB PC-2100 88
Visipro 128MB (4 IC) PC-2700 26
Visipro 128MB (8 IC) PC-2700 29
Visipro 256MB (8 IC) PC2700 45
Visipro 256MB (16 IC) PC2700 Call
Visipro 512MB PC-2700 89
Visipro 256MB PC3200 (8IC) 50
Visipro 512MB PC3200 102
Visipro 64MB PC800 36
Visipro 128MB PC800 (8IC) 52
Visipro 256MB PC800 (8IC) 105

V-Gen SDRAM PC-133 (8IC) 64MB 17
V-Gen SDRAM PC-133 (4IC) 128MB 28
V-Gen SDRAM PC-133 (8IC) 128MB 36
V-Gen SDRAM PC-133 (8IC) 256MB 57
V-Gen SDRAM PC-133 (16IC) 256MB 75
V-Gen SDRAM PC-133 (16IC)
512MB 109
V-Gen DDR PC-2100  128MB 21
V-Gen DDR PC-2100  256MB 38
V-Gen DDR PC-2700  256MB 40
V-Gen DDR PC-2100  512MB 74
V-Gen DDR PC-2700  512MB 76
V-Gen DDR PC-3200  256MB 40
V-Gen DDR PC-3200  512MB 78
V-Gen RDRAM PC-800 128MB 51
V-Gen RDRAM PC-800 256MB 98
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KURSUS

KURSUS Video Editing (Adobe Premier/Ulead.7)
350rb/250rb Digital Imaging (Photoshop) 195rb
Merakit PC 95rb LAN 95rb Praktis,Certificate IZZAH
Com Jl.Rawamangun muka Timur #78
Ph.47867273 http://izzahcomp.tripod.com

LAIN-LAIN

DISTROLINUX.NET,Menjual CD distro Linux
terbaru seperti:      Mandrake/Redhat/Fedora/
Slackware/Gentoo/SuSE/Knoppix/xBSD/
OpenOffice dll.Harga per CD cuma Rp.10.000.
Hubungi:(021) 7096 0522 HP (SMS): 08121876981
Mail: info@distrolinux.net. Selengkapnya kunjungi
http://www.distrolinux.net

@BISNIS DI RUMAH. Peluang mendapatkan
penghasilan tambahan dengan komputer
anda,mudah,hanya 60mnt/hr, tidak perlu
pengalaman, tersedia pelatihan lengkap
Hub: www.real60minutemoney.net

IKLAN BARIS

Twinmos 64MB 27.5
Twinmos 128MB 36.5
Twinmos 256MB 64
Twinmos 512MB 121

USB FLASH MEMORI/
MP3/PEN DRIVE

Prolink USB Pen Drive, MP3 64MB 85
Prolink USB Pen Drive, MP3 128MB 110
Prolink USB Pen Drive, MP3 256MB 165

MCPRO pen drive 128MB USB 2.0 39,5
MCPRO pen drive 256MB USB 2.0 58,5
MCPRO pen drive 512MB USB 2.0 120.5

Magic Star 64, 64MB, 3 in 1 42
Magic Star 128, 128MB, 3 in 1 78
Magic Star 256, 256MB, 3 in 1 140
Magic Star 64 MP3, 64MB, MP3 74
Magic Star 128 MP3, 128MB, MP3 115
DigiSound II, 128MB, multi MP3,
voice recording, display 130
MagicStar 128 Turbo, USB 2.0, 128MB 70

Umax Flash Drive FD-201 64MB,
USB 2.0 43
Umax Flash Drive FD-201 128MB,
USB 2.0 65
Umax Flash Drive CD-101, 64MB +
SD/MMC card reader, USB1,1 45
Umax Flash Drive MP101 64MB +
MP3 player, USB 1.1 73
Umax Flash Drive MP101 128MB +
MP3 player, USB 1.1 100

Nexus UFD-64, USB Flash Drive
64MB ver 1.1 31.5
Nexus UFD-128, USB Flash Drive
128MB ver 1.1 42
Nexus UFD-256, USB Flash Drive
256MB ver 1.1 70.5
Nexus UFD-512, USB Flash Drive
512MB ver 1.1 141

Samba Flash disk & MP3 player
128MB FSI-128 156
Samba Flash disk & MP3 player
256MB FSI-256 209

HARDDISK

Maxtor 6L020L 20,4GB 7200rpm
ATA133, 2MB Cache, dual processor 53
Maxtor 6E030L 30GB 7200rpm ATA133,
2MB Cache, dual processor 55
Maxtor6E040L/6E040 40GB 7200rpm
ATA133, 2MB Cache, dual processor 59
Maxtor 6Y060L 60GB 7200rpm ATA133,
8MB Cache, dual processor 72
Maxtor 6Y080L 80GB 7200rpm ATA133,
8mb cache, dual processor 75
Maxtor 6Y120L, 120GB, 7200rpm,
8,5ms, uDMA133, 8MB cache 105
Maxtor 6Y160PO, 160GB, 7200rpm,
ATA 133/serial ATA, 8MB cache 165
Maxtor 6Y200PO, 200GB, 7200rpm,
ATA 133/serial ATA, 8MB cache 225

Seagate Ux/Cuda 5400.1 20GB
ATA 100 51.2
Seagate Ux/Cuda 5400.1 40GB
ATA 100 52.3
Seagate Barracuda 7200.7 40GB
ATA100 56
Seagate Barracuda 7200.7 80GB
ATA100 71.9
Seagate Barracuda 7200.7 120GB
ATA V/100 100.4
Seagate Barracuda 7200.7 Plus
160GB ATA V/100 (8MB cache) 134.6
Seagate Barracuda SATA 80GB,
ATA100 103,5
Seagate Barracuda SATA 120GB,
ATA100 126.3

Maxtor 2F020J/L, 20GB 5400rpm,
ATA-133, 2MB cache 50
Maxtor 2F030J/L, 30GB, 5400rpm,
ATA-133, 2MB cache 53
Maxtor 2F040J/L, 40GB, 5400rpm,
ATA-133, 2MB cache 58
Maxtor 4R060J/4D060H, 60GB 5400rpm,
ATA-133, 2MB cache 67
Maxtor 4D080H/4K080H, 80GB,
ATA-100, 2MB cache 80
Maxtor 4G120H, 120GB 5400rpm,
ATA-100, 2MB cache Call
Maxtor 4G160H, 160GB, 5400rpm,
9,0ms, ATA100, 2MB cache,
dual processor 165

Maxtor 6YO80MO, 80GB SATA,
7200RPM, 8MB Cache 103
Maxtor 6Y120MO, 120GB SATA,
7200RPM, 8MB Cache 125
Maxtor 6Y160MO, 160GB SATA,
7200RPM, 8MB Cache 170
Maxtor 6Y200MO, 200GB SATA,
7200RPM, 8MB Cache 235

Western Digital WDC 5400rpm
cache 2MB 20GB 53
Western Digital WDC 5400rpm
cache 2MB 40GB 57
Western Digital WDC 7200rpm
cache 2MB 40GB 67
Western Digital WDC 7200rpm
cache 8MB 40GB 79
Western Digital WDC 7200rpm
cache 8MB 80GB 112
Western Digital WDC 7200rpm
cache 2MB 100GB 135
Western Digital WDC 7200rpm
cache 2MB 120GB 160
Western Digital WDC 7200rpm
cache 8MB 160GB 210

Samsung HDD 20GB 5400rpm 56
Samsung HDD 40GB 5400rpm 70

EXTERNAL DRIVE

Maxtor 5000DV 160GB, USB 2.0,
8MB Cache, 7200rpm 299

Maxtor 7000, 120GB, external,
USB 2.0, 2MB cache, 5400rpm 235
Maxtor 7000, 200GB, external,
USB 2.0, 8MB cache, 7200rpm 360
Maxtor 7000, 250GB, external,
1394/USB2.0, 8MB cache, 7200rpm 405

SCSI HARD-DISK 7200RPM &
10K RPM

Maxtor KU018L/J 18 GB Atlas,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 145
Maxtor 8B036L/J 36 GB Atlas IV,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 185
Maxtor 8B073 73 GB Atlas IV,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 425
IBM IC35LO36UWD, 36GB, 68 pin,
10 Krpm, SCSI160, 8MB cache 200
Quantum XC009J, 18GB, 68/80pin,
7200rpm, SCSI160, 4MB cache 80
IBM IC35L009, 9GB, 68pin,
10Krpm, SCSI160,  8MB cache 115
IBM DPSS 9170W, 9,1GB, 68/80pin,
7200rpm, SCSI160, 4MB cache 95

Seagate Medalist Pro 4,5GB U2W,
M Pro, 9,5ms 54
Seagate Cheetah  U320 36,6GB 163
Seagate Cheetah U320  73GB 398
Seagate Cheetah U320 73.4GB
Fibre channel 510
Seagate Cheetah U320 36,7GB 306

MAGNETIC OPTICAL DRIVE

Fujitsu MCC-3064ATAPI, 640MB,
ATAPI internal, 3,5" 230
Fujitsu MCE-3130AP, 1,3GB,
ATAPI internal, 3,5" 325
Fujitsu MSS-3064S, 640MB,
SCSI internal, 3,5" 250
Fujitsu Dynamo 640/EE,
external firewire 1394 350
Fujitsu Dynamo 1300, 1300MB,
external firewire 450

PROSESOR

Athlon Xp 1800+ (Palomino) 47
Athlon Xp 2000+ (Thoroughbred A) 52
Athlon Xp 2100+ (Thoroughbred A) 55
Athlon XP 2200+ ((Thoroughbred A) 63
AthlonXP 2400+ fan
(Thoroughbred B) 71
AthlonXP 2600+ (FSB333) + fan 90
AthlonXP 2800+ (Barton FSB333) 135
AthlonXP 3000+ (Barton FSB333) 199

AMD ATHLON XP 2000+ (BOX) +
FAN TBRED B FSB 266MHz 69
AMD ATHLON XP 2200+ (BOX) +
FAN TBRED B FSB 266MHz 75
AMD ATHLON XP 2400+ (BOX) +
FAN TBRED B FSB 266MHz 83
AMD ATHLON XP 2600+ (BOX) + FAN
BARTON FSB 333MHz, CACHE 512 105
AMD ATHLON XP 2500+ (BOX) + FAN
BARTON FSB 333MHz CACHE 512 94
AMD ATHLON XP 2800+ (BOX) + FAN
BARTON FSB 333MHz CACHE 512 149
AMD ATHLON XP 3000+ (BOX) + FAN
BARTON FSB 333MHz CACHE 512 229
AMD ATHLON XP 3200+ (BOX) + FAN
BARTON FSB 400MHz CACHE 512 459

Intel Pentium-4 1,8AGHz-478 119
Intel Pentium-4 3,06GHz,
box, 478 281
Intel Pentium-4 1,8AGHz,
512KB cache L2, 478 126
Intel Pentium-4 2,0AGHz,
512KB cache L2, 478 138
Intel Pentium-4 2,4BGHz,
512KB cache L2, FSB 533, 478 180
Intel Pentium-4 2,66GHz, (512)
FSB 533 179
Intel Pentium-4 2,8GHz (512)
FSB 533 210

Tray Pent-4 2,4CGHz, cache 512Kb,
FSB 800 w/o fan 165
Box Pent-4 2,4CGHz, cache 512Kb,
FSB 800 174
Box Pent-4 2,6CGHz, cache512Kb,
FSB800 194
Box Pent-4 2,8CGHz, cache512Kb,
FSB800 234
Box Pent-4 3.0GHz, cahce512Kb,
FSB800 297
Box Pent-4 3,2GHz, cache512Kb,
FSB800 441

Intel Celeron 1,7GHz, c/128 62
Intel Celeron 2.0GHz, c/128 65
Intel Xeon Pentium-4 2,4GHz
512KB cache L2 239
Intel Xeon Pentium-4 2,BGHz,
512KB cache L2, 533 250
Intel Xeon Pentium-4 2,6GHz,
512KB cache L2 278
Intel Xeon Pentium-4 3,06
512KB cache L2, 533MHz 509

HEATSINK FAN

Coolermaster HAC-V81
(X-Dream) 21
Coolermaster HSC-V83 30
Coolermaster HHC-001 28
Coolermaster IHC-L71 32

Zalman CNPS-2005 15
Zalman CNPS-3000 18
Zalman CNPS3100 24
Zalman CNPS3100 G 35
Zalman CNPS5001 AL 19
Zalman CNPS 5001CU 26
Zalman CNPS-5700D-CU 32
Zalman CNPS 7000 CU 42
Zalman CNPS 7000
ALCU 35

PixelView GeForce FX 5900 256MB
DDR II, 2,2ns, GPU 400Mhz 450
PixelView FX5700, AGP8X,
DDRII 256MB, VIVO, DVI 205
PixelView FX5700, AGP8X,
DDR 128MB, VIVO, DVI 180
PixelView FX5600, AGP8X,
128MB DDR, 3,6ns, DVI, VIVO 175
PixelView FX5200ut, AGP8X,
128MB DDR, TV OUT, DVI 85

MSI G4 MX440SET, AGP4X,
64MB SDR, TV OUT 46
MSI G4MX440 T8X, AGP4X,
64MB SDR, TV OUT 50
MSI MX440-TD8X, AGP8X,
64MB DDR, DVI, TV OUT, DUAL CRT 73
MSI Ti4200-TD8X64, AGP8X,
64MB DDR, DVI 150
MSI FX5200-T128, AGP8X,
128MB DDR, DVI, VIDEO IN, TV OUT 89
MSI FX5200-TDR128, 128MB DDR,
DVI, VIDEO IN, TV OUT 120
MSI FX5600-VTDR256, AGP8X,
256MB DDR, DVI, VIDEO IN,
TV OUT 250
MSI FX-5600 VTDR128, FX5600,
AGP8X, DDR128 215
MSI FX-5600 VTDR256, FX5600,
AGP8X, DDR256 250
MSI FX-5600 VTD256 (N-box),
FX5600, AGP8X, DDR 256 255
MSI FX-5900 ultra VTD256 (N-box),
FX5900 ultra, DDR256 570

Gainward GF4MX440, 64MB,
5.0ns DDR, AGP8X, TV OUT 46

Gainward GeForce FX 5200, 128MB,
4.0ns DDR, AGP8X, TV OUT 72
Gainward GeForce FX 5600, 128MB,
ULTRA FAST DDR, AGP 8X, TV OUT 135
Gainward GeForce FX 5600, 256MB,
ULTRA FAST DDR, AGP 8X, TV OUT 165
Gainward GeForce FX5900, 128MB,
ULTRA FAST DDR, AGP 8X,
TV OUT, VIVO 385
Gainward GeForce FX5900, 256MB,
ULTRA FAST DDR, AGP 8X,
TV OUT, VIVO 450

Soltek  SL-5200-XD,
GeForce FX5200
128MB DDR, DVI, TV out 72
Soltek  SL-X600-D6DT, Xabre600,
64MB DDR, DVI, TV out 61

Elsa Quadro FX2000, 128MB DDR II,
AGP 8X VIVO, DVI-I 1797
Elsa Quadro FX1000, 128MB DDR II,
AGP 8X, DVI-I 1073
Elsa Quadro FX500, 128MB DDR,
AGP8X, DVI-I 346
Elsa Gladiac FX930, GeForce FX5800,
128MB, AGP8X, VIVO, DVI-I 388
Elsa Gladiac FX732, GeForce FX5600,
128MB, AGP8X, VO, DVI-I 181
Elsa Gladiac FX534, GeForce FX5200,
64MB, AGP8X, VO, DVI-I 105
Elsa Gladiac 528 (VIVO), GF4 Ti4200,
AGP8X, 128MB DDR, VIVO 156
Elsa Gladiac 518, GF4 MX440,
AGP8X, 64MB DDR, TVO 60
Elsa Gladiac 517SEP, GF4 MX440,
64MB DDR, TVO 51

CASING

Procase ATX PS/2 tipe 477
power supply 350W 23
Procase ATX PS/2 tipe 0207
power supply 350W 24
Procase ATX PS/2 tipe 0208
power supply 350W 26

Enermax ATX CS-5190 AL,
power supply 365W 404
Enermax ATX CS-5190 AL,
power supply 450W 419
Elan Vital S15, big tower, ATX,
power supply 300w 472

VGA CARD

Asus A9600SE/TD/128MB 152
Asus A9200SE/T/ 64MB 64
Asus V9950 Ultra/ DLX,
GeForceFX 5900, AGP 8x, 256MB DDR 470
Asus V9520 Magic/T GeForceFX 5200,
128MB, AGP8X 85
Asus V9520 Home Theater-128MB 189
Asus V9280 /TD, Ti4200-128MB 173
Asus V9950 Ultra/TVD,
GeForce FX5900, 256MB 460
Asus V9180 SE/T 64MB, MX-440-8X 55

Abit Siluro FX5200DT, FX5200,
AGP8X, 128MB DDR 82
Abit Siluro FX5600 Ultra OTES,
FX5600Ultra, AGP8X, 128MB DDRII 207

PixelView GeForce FX 5200 ultra,
128MB DDR 4ns, GPU 250MHz,
RAM Clock 500MHz, TV-out, DVI Port 85
PixelView GeForce FX5600tv,
128MB DDR, 3,6ns, GPU400MHz,
RAM550MHz, TV-out, DVI Port 155
PixelView GeForce FX 5600 Vivo,
128MB DDR, GPU 400MHz,
RAM 550MHz 145
PixelView GeForce 5600 Ultra,
256MB 3,3ns, GPU 325MHz, DVI port 190
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Elsa Falcox 980FX-256,
Radeon 9800, 256MB VO, DVI 456
Elsa Falcox 980FX-128,
Radeon 9800, 128MB VO, DVI 347
Elsa Falcox 960FXPRO-128MB,
Radeon 9600, 128MB, VO DVI 211

Elsa Falcox 960FX-128,
Radeon 9600, 128MB, VO DVI 153
Elsa Falcox 920FX-128,
Radeon 9200, 128MB, VO DVI 98
Elsa Falcox 920SE-64MB,
Radeon 9200, 64MB, VO DVI 63

Sapphire Radeon 9200SE-D64,
64MB DDR, TVI, AGP8X 58
Sapphire Radeon 9200 D64, 64MB
DDR,TVO, AGP8X 69
Sapphire Radeon 9200 D128,
128MB DDR, VIVO, AGP8X 106
Sapphire Radeon 9600 D-128,
128MB, DVI, VIVO, AGP8X 142
Sapphire Radeon 9800Pro D-128,
128MB DDR, DVI, AGP8X 455
Sapphire Radeon 9800Pro D256,
256MB DDRII, DVI, AGP8X 536

DigiColor TNT2/M64 nVIDIA,
32 MB SDR, CRT 24
DigiColor GF2 MX400 nVidia,
64 MB SDR, CRT 34
DigiColor GF4 MX440se
nVidia LMA II,
64 MB 128-bit DDR 350 Mhz,
CRT+TV out 47
DigiColor GeForce FX5200,
nVidia LMA II, 64 MB 128-bit,
CRT, TV out                               73

DigiColor GeForce FX5600
nVidia LMA II, 128 MB 128-bit DDR,
Tv- out 160
DigiColor GeForce FX5600
nVidia LMA II 256MB 128-bit DDR,
TV-out                                     190

Impact mx440 64mb DDR,
AGP8X tv out 47
Impact Ti4200 64mb, tv out,dvi 130
Impact Ti4200 128mb, AGP 8X,
128ddr tv out,dvi,vivo 155
Impact GeForceFX5200 128MB DDR,
tv out,dvi,vivo, AGP8X 80

Gigabyte R9600 Pro, radeon 9700pro,
TV-out S/RCA, DVI port DVI-I,
twin view 137
Gigabyte R9800 Pro , radeon 9500,
TV-out S/RCA, DVI port DVI-I,
twin view 407
Gigabyte R9000 Pro, ATI Radeon
9000Pro, 64MB DDR, TV-out,
S-Video, Twin View, DVI Port 97
Gigabyte R9000, ATI Radeon 9000,
64MB,  DDR, TV-out 67
Gigabyte R9600 Pro, ATI Radeon
9600 Pro, 128MB DDR 192
Gigabyte R-9800 Pro, Radeon
9800Pro, 380MHz/ 680MHz, 256MB 522
Gigabyte R-9200 (VIVO), Radeon 9200,
250MHz/ 400MHz, 128MB 117

Gigacube Radeon 9800 Pro 256MB 550
Gigacube Radeon 9800 Pro 128MB 440
Gigacube Radeon 9700 Pro 128MB 340
Gigacube Radeon 9600 Pro 128MB 185
Gigacube Radeon 9600  128MB 160

Gigacube Radeon 9200  128MB 98
Gigacube Radeon 9100  128MB 85
Gigacube Radeon 9000  64MB 60

CD-RW DRIVE

Samsung CDRW 52X24x52 37.5

Aopen CD-ROM 56X OEM 23
Aopen CD-RW3248 32x12x48 50
Aopen CD-RW4850 48x12x50x 80
Aopen CD_RW 40x12x48 box 60
Aopen external CD-RW
40x12x48 box 135

Gigabyte  CD ROM 52X 26

MSI CD-ROM C-52 20
MSI CR-52M, 52x32x52 48
MSI CRE-52M CD-RW external 120

Mitsumi CD-ROM 54x 22
Mitsumi CD-RW 48x24x48 48

Asus CD-RW external 5224 A-U
(USB) 52x24x52 100
Asus external slim combo
SCB 2408-D 210
Asus CRW 5224A, 52x24x48 50

TDK CDRW 52x24x48black 45
TDK CDRW 52x32x52 white 38
TDK CDRW 48x16x48
USB External 2.0 115
TDK CDRW 52x24x52 int
IDE loose pack 65

Gigabyte CD-RW 52x32x52 54

Plextor CD RW 52x32x52
Internal IDE 155
Plextor CD RW 24x10x40
external USB slim 175
Plextor CD RW 52x32x52
external USB 240
Plextor CD RW 12x10x32
SCSI external 245
Plextor CD RW Combo DVD
8x8x24 ext USB 2.0 255

Whale CD ROM 56x 16
Whale CD-RW 52x24x52 45

DVDRW

Gigabyte GO-W404A DVDRW (+/-) 210

Pioneer DVD (+/-) RW A06 190

Plextor PX 504A DVD (+)RW
INT IDE 2,4 X 4 200
Plextor PX504UF DVD+RW EXT
firewire + USB 345
Plextor PX708A DVD +/- RW
INT 8X4X12/40X24X40 300
Plextor PX708A DVD +/- RW
INT 8X4X12/40X24X40 SC 385
Plextor PX708A DVD +/- RW
INT 8X4X12/40X24X40 FC 400

Aopen DVD-RW Combo ultra slim,
box 290

Asus DVD-R/RW 4X2X12 247

TDK DVD-RW 440 250

MSI DVD combo X-48 78

DVD-ROM

Pioneer 120T 9 (Trayload) 42
Pioneer 120S (slot in) 49

Samsung DVD 16X 30

Sony DVD 16X white 31
Sony DVD 16X Black 32

Asus DVD 16X 41

MSI DVD-ROM 38

TV TUNER

MSI TV Anywhere, conexant
CX23883, remote, video editing 52

Jetway USB, TV tuner, radio,
remote USB 67

PixelView Play TV USB 1.1,
ext USB TV tuner + FM radio, remote 65
PixelView Play TV Pro Ultra,
semi stereo, TV tuner card +
FM radio, remote 45
PixelView Play Pro, TV tuner card +
FM radio 40

Asus TV tuner 75
Winfast TV tuner 2000XP Deluxe 52
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Restituta Ajeng Arjanti
ajeng@e-pcplus.com www.babadbali.com:

Kecintaan Terhadap
Budaya Daerah

K

Peninggalan leluhur
tidak harus

tenggelam terlarut
dalam putaran jaman

dan hiruk-pikuk
teknologi.

utipan kali-
mat tersebut
bisa kita baca di situs
www.babadbali.com,

sebuah situs yang dikelola oleh
Yayasan Bali Galang. Jika kita
melihat keseluruhan isu situs,
dengan mudah kita bisa menebak
tujuan yayasan nirlaba ini –
melestarikan budaya Bali.

APA KABAR BUDAYA
DAERAH?

Anak muda jaman sekarang,
supaya dibilang keren, harus
melek TI. Teknologi sudah
berkembang begitu jauh, masa
gak ngerti sama sekali soal kom-
puter atau segala alat tele-
komunikasi praktis. Bikin malu, ah!

Gak ada salahnya kalau
banyak anak muda yang
beranggapan seperti itu.
Sayangnya, gambaran anak muda
Indonesia (apalagi yang tinggal di
kota besar) yang sering kita lihat,
umumnya lebih mendewakan
teknologi. Mereka gak ingat lagi
dengan budaya daerahnya. Tak
jarang, mereka, bahkan beberapa

dari kita, tertawa saat mendengar
orang lain atau kenalan kita
berbicara dalam bahasa daerahnya.
Aneh, katanya. Buat apa ada bahasa
Indonesia kalau mereka tetap
memakai bahasa daerah?

Bahasa Indonesia memang
dibuat sebagai bahasa pemersatu.
Tapi, itu bukan alasan untuk
melupakan budaya daerah kita.

BUKAN UNTUK ORANG BALI
SAJA

Justru menjadi sebuah hal yang
aneh jika masyarakat Indonesia
menomorsekiankan budaya
daerahnya. Sedangkan ada banyak
para pemerhati budaya, bukan
hanya yang berasal dari dalam
negeri, tapi juga dari luar negeri,
yang tertarik untuk mempelajari
budaya Indonesia.

Babadbali.com bukan cuma
ditujukan untuk orang Bali, tetapi
juga diperuntukkan bagi para pe-
merhati budaya dan pengamat dari
luar. Semua informasi yang terpapar
di dalamnya adalah sebuah bahan
diskusi, seluruh pemerhati bebas

untuk memberikan koreksi dan
komentar yang membangun.

DUA MIMPI
BABADBALI.COM

Situs ini merupakan sebuah

persembahan dari putera-putera
Bali. Salah seorang putera Bali,
namanya Bapak I Made Suatjana,
adalah Sang Arsitek yang
menciptakan komputerisasi aksara
Bali. Tujuannya sederhana, ia ingin

memperkenalkan penulisan dan
pencetakan aksara Bali dalam
komputer – supaya pengetikan
aksara Bali di komputer bisa
dilakukan secara natural.
Mimpinya yang pertama sudah
tercapai, paket font Bali-Simbar B
dan template-nya sudah bisa kita
download dari situs ini. Jadi,
jangan heran kalau suatu saat kita
melihat sebuah dokumen Word
dengan tulisan aksara Bali.

Apa mimpi keduanya? Ia
ingin membuat aksara Bali sebagai
sebuah Unicode. Unicode, hampir
sama seperti ASCII, merupakan
standar yang berlaku di seluruh
dunia dan diikuti oleh semua
developer dan vendor software,
contohnya huruf Latin ‘A’ memiliki
kode Unicode U+0041 dan ‘B’
memiliki kode Unicode U+0042.

Bapak Made Suatjana
merupakan sosok yang sederhana.
Ketika babadbali.com
mengutarakan maksudnya untuk
memajang riwayat hidupnya, Pak
Made hanya berkata, “Silakan
ceritakan apa adanya yang pak
lihat, tiyang akan lebih senang
membaca cerita bapak, daripada
membaca cerita karangan tiyang
sendiri.”

Tertarik untuk mempelajari
aksara Bali? Kita bisa mulai belajar
dari sekarang, sebelumnya kamu
bisa men-download lebih dulu
font-nya di situs babadbali.com.
Jangan lupa kita berdoa supaya
aksara Bali bisa terdaftar dalam
Unicode. PC+

Tampilan layar dokumen Word dengan font Bali-Simbar B. Terlihat
rumit karena kita belum mengerti penggunaannya.

Rancangan keyboard driver aksara Bali, disesuaikan dengan
Microsoft’s Input Method Editor (IME).


